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Lesson-1 Internet 
 

Structure: 
 

1.1 Introduction. 
 

1.2 Brief history and Development of Internet. 
 

1.3 Working of the Internet. 
 

1.4 Control Mechanism of the internet. 
 

1.4.1 Administration Aspect. 
 

1.4.2 Internet operation Aspect. 
 

1.4.3 Internet Security Aspect. 
 

1.5 World Wide Web. 
 

1.5.1 Hyperlinks. 
 

1.5.2 Hypertext. 
 

1.6 Websites. 
 

1.6.1 Static websites. 
 

1.6.2 Dynamic websites. 
 

1.6.3 Text, Media and other Alternative contents 
 

1.6.4 How to open a website. 
 

1.6.5 Steps to publish a website 
 

1.7 Webpages. 
 

1.8 URL 
 

1.9 IP Addressing. 
 

1.9.1 Format of IP Address 
 

1.9.2 IP Address structure & classification 
 

1.10 Domain Naming System 
 

1.10.1 Domain Names. 



Page 2 of 187  

1.10.2 Domain Name Space. 
 

1.10.3 Name Servers. 
 

1.10.4 Working of Domain Name Server 
 

1.11 Summary. 
 

1.12 Glossary. 
 

1.13 Answers to check your progress. 
 

1.14 References. 
 

1.15 Suggested Readings. 
 

1.16 Terminal and Model Question. 
 
 
 

Objectives: 
 

After reading this lesson, you should b able; 
 

• To understand the basics of internet and its working. 
 

• To understand about the websites and their different components. 
 

• To understand the concept of WWW and its associated mechanism. 

1.1 Introduction: 

Now a day, Internet is a part and parcel of our life. It is a repository of vast information. The Internet 

started way back in 1960 and remains in growth even today. Being not a property of any individual 

organization, a number of organizations are helping in its growth and control. Internet helps in the 

creation of World Wide Web along with the other services of internet. World Wide Web is the service of 

internet which is being used 99% of the time. A number of websites are being created daily with the 

help of webpages coded in HTML or XHTML. The hyperlink, hypertext, hypermedia plays a major role in 

creating these webpages 
 

1.2 Brief History And Development of Internet 
 

The Internet started in 1960 as a way for the government researchers to share information. The U.S 

Department of defense (D.D) started a project ARPANET (Advance research Project Agency Network) to 

link the scientists and university professors around the world. ARPANET was a great success but its 

membership was limited to academic and research organizations only. 
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By 1972, ARPANET had grown to approximately 15 nodes. At that time, the various computer 

networks did not have a standard way to communicate with each other. Ultimately a new 

communication project was established Transfer Control Protocol/ Internetwork protocol (TCP/IP). This 

allowed the different kinds of computers in different network to communicate with each other. Since 

ARPANET and other networks finally adapt TCP/IP standard on January 1, 1983, it is considered as the 

official birthday of Internet. All networks could now be connected by a universal language. 
 

Today, Internet is also known as “Network or Networks”. It serves as a global communication system 

that links millions of private, public, academic and business networks via international 

telecommunications backbone. Internet is decentralized by its designs, so no one owns the internet and 

it has no central governing authority. Internet is a vast hardware and software infrastructure that 

enables the computer inter-connectivity. 
 

1.3 Working of the internet: 
 

The internet is a “network or networks” connecting millions of computers belonging to private, public, 

academic and government organizations. The Internet works because “Open Standards” allow every 

network to connect every other computer. Anyone can create contents, offer services, and sell different 

types of products on internet and that too without requiring any permission from a central authority. It 

is the only reason that today different types of application and services are available on internet. The 

characteristics of internet are: 
 

1. Open now 
 

2. Independent 
 

3. Run by non-profit organization 
 

The computers connected in the internet are also called hosts and they are TCP/IP protocol for 

communication. The communication media are telephone lines, Fiber Optics cables (wired media) and 

microwaves, satellites (non-wired media). Almost every line of information is available on the internet in 

the electronic form. 
 

As discussed earlier, no particular organization controls the Internet. A personal computer can be 

connected to the Internet by using phone-line modem, DSL (Digital Subscriber Line) or a cable modem. 

The modem is used to communicate with ISP (Internet Service Provider, like BSNL, Airtel, Idea etc. ). ISP 

is a company that provides the Internet connections to the users. 
 

Similarly a computer in a business or a university is usually connected with LAN (Local Area Network) 

using NIC (Network Interface Card, or LAN Card). The LAN of the university connected to the ISP using 

some high speed medium like Fibre Optic Cable. The local ISP connects to the larger ISPs. The largest 

ISPs maintain the Fibre Optic Links, under-sea cables or satellite links. So in this way every computer is 

connected to every other computer on the Internet. 
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Since ISPs plays a major role in the working of internet, let us discuss something more about different 

kind of ISPs. 
 

1. Local ISPs: A local ISP is an organization that has its own computers connected to the 

internet and it provides the facility to the individual users to connect to the Internet 

through their own computers. Generally it is the telephone company, where the 

telephone line of the use terminates e.g. BSNL, Airtel, Idea etc. The user connects to the 

local ISP through a modem or Network Interface Card (NIC). 
 

2. Regional ISPs: The local ISPs connect to the regional ISPs through specialized devices 

routers. It is a special purpose device consisting of memory, processor and i/o interface, 

used for the purpose of interconnecting various networks. 
 

1.4 Control Mechanism of Internet: 
 

As discussed earlier Internet is not the property of a single organization. But there must be some control 

mechanisms which governs the working of Internet for this a number of governing bodies have been 

formed these governing bodies govern the internet from administration point of view, internet 

operations point of view and Internet security point of view. 
 

1.4.1 Administration Aspect: 
 

Since every computer (node) connected to the internet must have a unique address (IP Address), the 

overall responsibility for managing Internet Protocol Address at upper levels lies with IANA (Internet 
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Assigned Numbers Authority),which divides the actual administration of most functions to other bodies. 

At global regional levels, the various bodies providing allocation and registration service to support the 

operation of Internet are: 
 

1. RIPENCC (Reseaux IP Europeans Network Coordination Centre). 
 

2. ARIN (American Registry for Internet Number). 
 

3. APNIC (Asia Pacific Network Information Centre). 
 

4. LACNIC (Latin American & Carribean IP Address Regional Registry). 
 

5. AfriNIC (African Regional Registry for Internet Numbers Resources) 
 
 
 

1.4.2 Internet Operation Aspects: 
 

Internet operations are coordinated globally through IEPG (Internet Engineering Planning Group). It 

assists various ISPs to interoperate within global Internet. At regional levels different bodies actively 

involved in coordinating the operations are: 

ARIN(American Registry for Internet Numbers). 

APOPs(Asia Pacific Networking Group). 

 
 

1.4.3 Internet Security Aspect: 
 

Internet security is facilitated by a number of Computer Emergency Response Team (CERT). They 

continuously monitor the network for security incidents thus act as respiratory of information about 

such incident. Some other governing bodies of Internet are: 

ISOC (Internet Society): It provides information about Internet and it is also responsible for the 

development for the Internet. 
 

IAB (Internet Architecture Board): It is responsible for the development of architecture of Internet and 

also server as advisory body of ISOC. 
 

IETF (Internet Engineering Task Force): It is a group of network designers, operators, vendors and 

researchers. 
 

IESG (Internet Engineering Steering Group): Its reviews the standards developed by IETF. 

IRTF (Internet Research Task Force): It focuses on research towards the future of Internet. 
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Inter NIC (Internet Network Information Centre): It is responsible for domain name (e.g. www.abc.com) 

registration. 

W3C (World Wide Web connections): It is responsible to develop the technologies for www (World Wide 

Web) 

 
 

1.5 WWW (World Wide Web): 
 

World Wide Web is used by millions of people around the world for so many things like checking of 

weather, reading news, watching movies etc. i.e. it remains around us all the time. First thing you must 

note that “www is not just Internet” even though the words are used interchangeably. 

“Internet is simply the way, computers connects to each other in order to share information. Today 

networks are around us and computers can easily communicate with each other. It has so many 

advantages like accessing email, file transfer etc. but the most common is accessing World Wide Web”. 
 

But what is it exactly? 
 

WWW consists of web servers, a computer which always remain connected to Internet. This computer is 

specially designed to store information and store it. When you make a website, you have to purchase 

space on webserver (on rent). The information that gets stored on these kinds of computers 

(webservers) is in the form of languages like HTML & Java scripts. You access these websites through a 

graphical user interface called web Browser or simply browser (Internet explorer, Netscape, Navigator, 

Safari, Mozilla, Firefox, Chrome, etc.) 
 

WWW is the intercommunication of all these servers where you can communicate and access their 

information in a simple way. No one owns the web. We have to access www through ISP (Inter-pole 

Service Provider). Most of the information on the web is in the form of hyperlinks where one can click to 

get information on another topic. It is an important part of our life because its contents and structure is 

flexible and useful for everyone. 
 

1.5.1 Hyperlinks: 
 

Have you ever notice that when you look at something on internet, sometimes your mouse pointer 

takes the shape of a pointing finger (image). That is known as hyperlink. 

A hyperlink is a command embedded in the webpage which allows you to jump somewhere else on the 

web. Every webpage is filled with so many hyperlinks, each one relating for some webpage, picture or 

file. When you click on the hyperlink, it loads another page/picture/file on your machine. It can even be 

used to launch a movie clip. Hyperlinks are used to facilitate web surfing, giving user the ability to move 

freely from one webpage to another webpage in quick and easy manner. When you click on hyperlink, 

you move to another page, if you want to come back simply press the back button on the back button 
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on the browser. One important point to note that if you hold ctrl key while clicking on a hyperlink, new 

page will open in a new window. 

Types of Hyperlinks: 
 

1. Underlined Text (generally in blue color) 
 

2. Images 
 

3. Drop-down menus 
 

4. Animation 
 

Hyperlinks can even be placed in PDF file, Word document or an Email. World Wide Web is made up of 

these hyper-linked documents, contents and media. The web pages which contain information on a 

topic and contain these hyperlinks (to refer to another topic) are written using a particular hypertext 

mark-up language called HTML. 
 

The HTML code to create a text in the form of hyperlink is 
 

<a href=www.yahoo.com/news.html> click here to open yahoo </a> 
 

To make an image as hyperlink, use the following code of HTML 
 

<a href=www.mysite.com><img src=“gurmeet.jpeg” borders=“0” width=“50” height=“50” ></a> 
 
 

what ever you write in href = “ ”, it acts as the path to open a new file. However this path can be 

absolute or relative. Absolute means the path of the target file is completely as such like 
 

http://www.yahoo.com/news.html/ 
 

Whereas in case of relative pathname only file name is given and it is supposed that, file exist in same 

folder in which already opened webpage is present. E.g. news.html/ 
 

As we discussed that link can be to an image, sound file or video file also known as hypermedia, but 

appropriate program should be available at the computers (on which webpage is being opened) to 

open/play that file like sound/movie player. Even an image can be subdivided into different parts to 

create separate links for separate areas of the image. E.g. an image of India can be created in the form 

of hyperlink to open information about each state when the user click on a particular state 
 

1.5.2 Hypertext: 
 

Hypertext is the text which contains links to other texts. In other words, it is not linear. Hypertext 

contains hyperlinks on which you can click and move to another page or on the different portion of the 

same page. A hypertext page contains multiple hyperlinks. If you want to read a novel, you have to read 

it in a sequential fashion i.e. you cannot move from 3rd page to 7th and then to 15th and so on, whereas 

http://www.yahoo.com/news.html
http://www.mysite.com/
http://www.yahoo.com/news.html/
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in case of hypertext, you can move anywhere (new webpage) by clicking on the hyperlinks present on 

that page. E.g. given below is a hypertext 

“Hello. This page contains information about Albert Einstein. He has done the so many experiments in 

his life and gave different concepts” 
 

In this hypertext, if you are interested in reading about life of Albert Einstein, you can click on his name 

(a hyperlink). In simple words, a hypertext is simple text document that contains hypertext. There is 

another term hypermedia which is used in this context. Hypertext contains only text whereas 

hypermedia contains images, sounds and videos besides text. 
 

Check your progress 1 
 

1. What is the full form of ARPANET? 
 

2. What is the full form of TSP? 
 

3.   agency is related to Internet Security. 
 

4.   tag is used to create a hyperlink in HTML. 
 

5. Hypertext includes whereas hypermedia includes , 

  and . 
 
 
 

1.6 Websites: 
 

As you have already learned, that www was created by Tim-Berners Lee in 1990 and it was free to use 

for everybody. Earlier File Transport Protocol and Gopher protocols were used to access the various file 

from web servers. At that time, documents were used to be plain text kind of files. After the 

introduction of HTML and HTTP(Hyper Text Transfer Protocol), the concept of accessing the websites 

changes. 
 

A websites is simply a collection of webpages. Suppose you want to create a websites about yourself. 

You want to create a homepage, a webpage belonging to your personal education, another webpage 

belonging to your education, another webpage belonging to your hobbies and so on. Thus the collection 

of all these webpages is called a website. A website can be a personal website, government website, a 

college website, a university websites or even a website for online selling purchasing (E-Commerce). Let 

it be any website, all the websites will have the webpages coded using HTML language. HTML language 

makes a normal text file into more presentable form. This language includes so many tags for formatting 

and other kind of jobs. These websites nowadays can be accessed on any kind of devices having Internet 

access like computers, laptops, tablets, cell phones etc. To access a website a (web browser) is required. 
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The websites are hosted/placed on a special machine called server or web server which fulfill 

the request for that website to different clients. A single server can host so many websites. In case if 

windows Platform, IIS (Internet server) is used and on UNIX Platform, Apache web server is used. 
 

There are different types of websites but on the base of contents, we generally divide it into two 

kinds: 
 

1. Static Website. 2. Dynamic Website. 

1.6.1 Static Website: 

A website is considered to be static, if it does not includes any processing on the server side i.e. the 

contents of a website or server will be displayed to the client as such. In these kinds of websites, same 

content is displayed to each user every time until and unless content is modified at the server. These 

kinds of websites do not have any involvement of database. However, these websites do have images, 

animation, audio & video content to make it look more attractive and little bit interactive. Static 

websites can be edited by 
 

1) Editors like Notepad 
 

2) Special Editors having WYSIWYG (what you see is what you get) property like Microsoft 

Frontpage. 
 

3) Other template-based editors. 
 

Some of the static websites includes the use of CSS (case coding style sheets) to present the information 

in a uniform way. 
 

1.6.2 Dynamic Website: 
 

A dynamic websites is the one which produces different contents to different users based in his/her 

choice i.e. dynamic pages are produced “on the fly” by the server. It will be clearer with the help of an 

example. Suppose there is a website which asks you about your choice of subject and then produces the 

table of books belonging to that subject. In this case, there must be a database on server side having 

information about all the subject books. Depending upon the information passed by you, a dynamic 

webpage will be created “on the” by picking information from the database. These kinds of websites are 

called dynamic websites. All the e-commerce based websites are dynamic websites because the 

contents keep on changing. Dynamic websites always perform some processing on server side. To create 

dynamic website, a number of technologies exist like CGI (Common Gateway Interface), ASP (Active 

Server Pages), Java Servlets, PHP, Perl, Python etc. 
 

1.6.3 Text, Multimedia & other Interactive content: 
 

Earlier websites used to have only textual information, whereas now a day websites have multimedia 

contents (audio, video, etc.) and other interactive content. But to play this kind of content on website in 
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your web browser, proper software should be installed in your web browser. Even if it is not installed, 

you can install it from Internet. These softwares are available form of plug-in. 

1.6.4 How to open a website: 
 

To open any website, all you used is a web browser (IE, Netscape, Navigator, Safari, Google Chrome, 

Firefox etc.). Every website has a unique name associated with it, which is also called the domain name 

E.g. www.abc.com . Simply open the browser and type the address, (www.abc.com) in the address bar 

of the browser and press Enter key. The homepage of the website will be opened in front of you, if your 

system is connected to internet. 
 

1.6.5 Steps to publish a website: Suppose you have make a simple static (collection of webpage) and you 

want to publish it (put it on Internet). The steps you need to perform is as under 
 

1. Firstly, you have to register a domain name for your website (E.g. www.mysite.com) you have to 

play a fee for it. 
 

2. After domain name registration, purchase space on any web servers of your choice. You can 

purchase as much space as you require. Upon purchasing, you will be given a unique user id & 

password. 
 

3. Now, you simply need to transfer your webpages on that web server where you have purchased 

the web choice. You can use FTP or any other file transfer software for it. 

 
 

1.7 Webpages: 
 

Webpages are what make up the World Wide Web. These documents are written in HTML and are 

translated by the web browser. Each webpage represents various types of information in an aesthetic 

and readable manner. The information in all these webpages is located on a remote machine called web 

server in form of text, images and script files. The pages can be either static or dynamic. Static pages 

show the same content each time they are viewed whereas dynamic pages show different content each 

time they are accessed. The dynamic pages are written using scripts like PHP, Perl, ASP, JSP, Java 

Servlets etc. The scripts generally run on the server and return the information like date, time and 

database etc. The important point is that the information reviewed by the web browser is always in the 

form of HTML Code. 
 

1.7.1 How do web pages work? 
 

The information on a web page is displayed when you connect to a web server using client software web 

browser. If you look at the website address, it always has http:// at the beginning which shows that the 

information is going to be transferred using hypertext transfer protocol. On some E-commerce sites you 

have noticed https:// https is used for security i.e. information is transferred in encrypted form. The 

webpages contents are usually presented in HTML or XHTML format which allows it to be structured 

http://www.abc.com/
http://www.abc.com/
http://www.mysite.com/
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easily. Some webpages use CSS (Cascading Style Sheets) which provides the precise control over the 

webpage's look and feel concerning layout, elements, color scheme and navigation. 

1.8 URL (Uniform Resource Locator) 
 

It is the unique address for a file that is accessible on the Internet. A simple way to access a Web site is 

to enter the URL of its home page file in your Web browser's address line. However, any file within that 

Web site can also be specified with a URL. Such a file might be any Web (HTML) page other than the 

home page, an image file, or a program such as a CGI Application or Java Servlets. The URL has three 

parts 
 

1. The protocol used (http,https,ftp,gopher,telnet,mailto) 
 

2. Name of the Server where webpage is stored 
 

3. Pathname, a hierarchical description which specifies the location of a file in that computer. 
 

E.g. http://www.abc.com/xyz/tuv.txt specifies the use of a HTTP (Web browser) application, a unique 

computer named www.abc.com, and the location of a text file or page to be accessed on that computer 

whose pathname is /xyz/tuv.txt 

A URL for a particular image on a Web site might look like this: 

http://abc.mysite.com/data/images/image1.gif 

A URL for a file to be downloaded using the File Transfer Protocol (FTP) would require that the "ftp" 

protocol be specified 
 

ftp://ftp.myftpsite.org 

There are two forms of URL 

Absolute URL: It is a complete address of a resource on the web. This completed address comprises of 

protocol used, server name, path name and file name. For example http:// www.abc.com/xyz/index.htm 

Relative URL: It is a partial address of a webpage. Unlike absolute URL, the protocol and server part are 

omitted from relative URL. Relative URLs are used for internal links i.e. to create links to file that are part 

of same website as the Webpages on which you are placing the link. 

For example, to link an image on abc.com/xyz/tuv, we can use the relative URL which can take the form 

like /xyz/tuv/image1.jpg. 
 

Difference between Absolute and Relative URL 
 

Absolute URL Relative URL 

Used to link web pages on different websites Used to link web pages within the same website. 

Difficult to manage. Easy to Manage 

http://www.abc.com/xyz/tuv.txt
http://www.abc.com/
http://abc.mysite.com/data/images/image1.gif
http://www.abc.com/xyz/index.htm
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Changes when the server name or directory name 
changes 

Remains same even if we change the server name 
or directory name. 

Take time to access Comparatively faster to access. 
 
 

Activity 1: 
 

Explain the role of Webpages in making a website and how websites helps in making World Wide Web. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1.9 IP Addressing: 

 

As you already study, Internet is a network of networks i.e. connecting millions of computers with each 

other. The computers in such a case communicate with each other only if they will have the identity of 

each other. The identity in a network is established with IP address. i.e. each computer in a network 

have a unique address called IP address. 
 

1.9.1 Format of IP Address: 
 

IP address or internet protocol address is the address that computer servers and other devices used to 

identify one another online. IP consists of 32 bits (4 bytes). It is also known as IPV4. Since it consists of 

32 bits, theoretically g 32 addresses are possible. The vast majority of IP addresses are arranged into 4 

sets of digits e.g. 12.36.42.28. Every machine which connects to the internet has its own unique IP 

address, may be statically fixed or may be for short time duration only. 
 

1.9.2 IP address structure & classification: 
 

The individual numbers in a 4 set of numbers in IP address are called octets.     e.g.     a.b.c.d where 

a,b,c,d are octets. 12.36.42.28 is the IP addresses for human understanding whereas in binary format it 

would be 

00001100. 0010001. 0010101. 00011100 
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The octets in the IP address have a major role. It divides the IP address into different classes. 
 

 

An IP address actually contains information about network and host both. The network part starts from 

the left and is used to define the network to which machine belongs to. The host part defines the 

machine itself in the network. The following table describes the different classes of IP addresses. 

Class A IP address: Since class A has first 8 bits as the N/W part and among these 8 bits first bit is always 

0 i.e. 0_ _ _ _ _ _ _ _ _ _ 
 

So, the minimum & maximum value is 0 and 127. But 0 & 127 are reserved for special purposes, so 

permissible value is between 1 and 126 both inclusive. 

Class B IP address: The class B IP address has first 16 bits (2 octets) as Network part and other 16 bits (2 

octets) as host part. The first two bits in N/W part is always be 10 i.e. 10 _ _ _ _ _ _ _ _ _ _ _ 
 

So, permissible value is between 128 & 191. 
 

Class C IP address: the class C address has 24 bits a network id and only 8 bits as host Id and first three 

bits in Network part is always 110 i.e. 110_ _ _ _ _ _ _ _ _ _ 
 

So, permissible value for the first octet is between 192 & 223. 
 

Remember that you can directly find out the class of IP address by looking at the value of the first octet 

only. In case of IP address, one another important concept is the subnet mask. Since from a binary string 

of 32 bits, it is not possible to find out what Network Address is and what Host Address is. For this 

purpose, subnet masking is used. Any IP address is masked with the corresponding subnet masked value 



Page 14 of 187  

to find out the Network Address. E.g. 192.168.1.1 is the IP address of C class and the value of subnet 

mask for C class address is 255.255.255.0. 

To calculate N/W address, mask the two numbers 

 
192.168.1.1 = 01100000 10101000 00000001 00000001 

255.255.255.0 = 11111111 11111111 11111111 00000000 

 
After masking the result is, 

 

192.168.1.0 = 01100000 10101000 00000001 00000000 
 

It means while assigning IP address to a machine, subset mask value is also to be assigned. 
 

As we have discussed above that every machine (computer, laptop, tablet, cell phone) which connects 

to the internet must be having a unique IP, but you will be surprise that you had never set it before 

using internet. Actually IP addresses are automatically assigned to our machines dynamically by the ISP. 

wherever we try to connect to ISP, the DHCP(Dynamic Host Configuration Protocol)server at ISP side 

assign the network configuration from its protocol address to our machine for a small period only after 

which it is renewed or released depending upon whether we remain in contact to the internet or 

disconnect. 
 

1.10 Domain Naming System: 
 

Since every computer connected to internet has a unique IP address, similarly different web servers on 

which different websites are hosted must be having unique IPs. But it is not possible for a human to 

remember such IP address for a number of websites. For this purpose domain names are used i.e. each 

website has a unique domain name associated with it and it is easy to remember domain names. E.g. 

www.yahoo.com is easy to remember than 20-30.142-68. Similarly when we enter an email address, we 

always enter a symbolic address such as abc@gmail.com. Since machines communicate by using IP 

address rather than names, Domain Naming System is used which resolves the host names into IP 

address. It uses a hierarchical naming scheme and distributed database of IP addresses and associated 

names. The Domain Names System consists of Domain Names, Domain Namespace and Name Server. 
 

1.10.1 Domain Names: 
 

Suppose you have a machine with the IP address 20.72.1.40 which can also be referred to as 

www.ptu.edu 

The whole string is the host name. The first part (www) is the name of the machine itself, while other 

(ptu.edu) is the domain name. The domain name is the name of the network associated with the 

organization. Similarly www.maruti.com refers to the Web server (www) in maruti.com domain. 

http://www.yahoo.com/
mailto:abc@gmail.com
http://www.ptu.edu/
http://www.maruti.com/


Page 15 of 187  

ftp.ptu.edu refers to the FTP server (named ftp) on ptu.edu domain network. Remember that a machine 

can have several names. In that case other names are called aliases. There are several kinds of domain 

names available. Some of them are generic while others are country level domain names. 
 

Domain Name Meanings 
 

com Commercial 
 

edu Education 
 

gov Government agency 
 

int International 
 

mil Military organization 
 

net networking organization 
 

org non-profit organization 
 

1.10.2 Domain name space: 
 

It refers a hierarchy in the internet naming structure. The hierarchy has multiple levels (0 to 127) with 

root at the top. DNS hierarchy can be easily represented by a tree. 
 

The name of the machine from lower to upper level is called FQDN (Fully Qualified Domain Name) 
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i.e. www.cs.ptu.edu 
 

Root and the top level domain are administered by Internet Central Name Registration Authority. Below 

top level, administration of name space is delegated to the individual organizations. 
 

1.10.3 Name Servers: 
 

It is another form of server comprising of various domain names and their corresponding IP addresses. 

Since, it is not possible for a single server to maintain the entire record; this record information is 

distributed among many servers which are again hierarchical in nature. 
 

1.10.4 Working of Domain Naming System: 
 

1. When we type www.ptu.edu into the browser, it asks the local DNS server for its IP address. There 

local may be DNS maintained by PTU or DNS maintained by ISP. 
 

2. The local DNS does not find the IP address of the given name, it forwards the request to the main root 

DNS server. 
 

3. The root DNS server replies with the IP address of DNS Server of edu domain. 
 

4. Local DNS server asks the same question to edu DNS server. It passes the IP address of ptu DNS 

server. 
 

5. Local DNS server again ask the same question to ptu.edu DNS server which ultimately replies with IP 

address of www machine in ptu.edu domain. 

So DNS & IP addresses have major role in the working of Internet. Otherwise, Existence of Internet 

would not have been possible. The process of finding IP address corresponding to domain name also 

happens in case of email i.e., abc@yahoo.com 
 

Here yahoo.com's IP address is first find out by the same method as discussed earlier. 

Check your progress 2 

State whether true/false 
 

1. There is a difference between website and webpages 
 

2. Domain name registration is not required to publish a site. 
 
 
 

Fill in the blanks 
 

1. Websites can be classified into and . 
 

2. Webpages are coded in   

http://www.cs.ptu.edu/
http://www.ptu.edu/
mailto:abc@yahoo.com
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3. IP address consists of bits. 
 

4. Domain naming system is used to convert into . 
 

5. IP address consists of bits. 
 

6. Domain naming system is used to convert into . 
 

Activity 2: 
 

How IP address is used in making of a network and how Domain Name System helps in the conversion of 

name to IP in case of email address? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1.11 Summary: 
 

The concept of Internet started with the project ARPANET (Advance Research Project Agency Network) 

by the U.S department of defense. However, its tremendous growth was due to the introduction of a 

communication protocol TCP/IP. Different kinds of organization called ISP (Internet Service Provider) 

both local and regional helps in bringing the Internet close to users. Although Internet is free and kind, 

IESG and CERT helps in controlling it. World Wide Web (www) which is different from Internet provides 

major show of service available on internet through different kinds of websites. Website on almost 

every topic is available today. These websites built up from a combination of different webpages which 

are coded in HTML or XHTML and cross kinked with the help of hyperlinks. Those hyperlinks are possible 

in different options like text & images. 

IP address plays a major role in setting up/connecting a machine to a network/Internet. The IP address 

and domain name provides uniqueness to the websites and conversion of Domain Name of IP address 

and vice-versa is possible through DNS Server. 
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1.12 Glossary: 
 

ISP (Internet Service Provider): Organization which provides the internet services to the users on some 

payments. 
 

WWW (World Wide Web ): Consists of so many special machines (web servers) linking millions of 

documents (HTML pages) is hypertext form. 
 

Hyperlinks: A link upon the clicking of which one can move to a different webpage. 
 

Hypertext: Text which contain links to another text. 
 

Websites: A collection of web pages. 
 

Web pages: Text documents in an aesthetic and readable manner pay have hyper links to another 

documents 

IP address: Internet Protocol address consisting of 32 bits assigned to each choice connecting in a 

network. 
 

DNS (Domain Name Server): A machine capable of mapping domain 
 
 
 

1.13 Answers to Check your progress: 
 

Answers to check your progress 1 
 

1. Advance Research Project Agency Network. 
 

2. Internet Service Provider. 
 

3. CERT (Computer Emergency Report Team). 

4. <a> 

5. text , text , images ,videos. 

Answers to check your progress 2 

1. True 
 

2. False 
 

3. Static, Dynamic 
 

4. HTML 

5. 32 
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6. Domain name, IP address 

1.14 References: 
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1.16 Terminal And Model Questions 
 

1. How the Internet evolved? Explain briefly. 
 

2. Explain the role of ISPs in the working of Internet . 
 

3. Specify various agencies involved in the working of internet 
 

4. How www is different from internet? 
 

5. Differentiate between hyperlinks and hypertext 
 

6. Explain the concepts of a website and the steps to publish it. 
 

7. Briefly explain about webpages and its types. 
 

8. Explain the concept of IP address and its significance in case of World Wide Web. 
 

9. Why Domain Naming System is important related to the working of internet? 
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2.0 Objectives 

After reading this chapter, you should be able to 

 Understand working of Browser and its various uses 

 Use FTP, Telnet, Email and its internal working 

 Use various Knowledge sharing tools 

 Understand working of Computer Networks 

 
2.1 Introduction 

To access the vast Information available at the Internet, you need some kind of simple, easy 

to use, and GUI (Graphical User Interface) based Software. The Browser has all the given 

features for this purpose. There are a variety of Browsers available with the varying 

functionality. Before using any one, you must have information about its working, features 

and usage. Many applications like FTP, Telnet are used for uploading/downloading files and 

remote login purposes respectively. To securely use these services, one must be familiar with 

its inner working. Email, which is the main form of communication, provides so many 

features that now it has become an indispensable part of our life. Creating an email account, 

sending/receiving emails and other functions provided by the email are so important that one 

must be fully familiar with it. Now a day, almost all the organizations, is it small or large or 

even at home, Computer Networks exist. 

 
2.2 Browser 

 

It is a software application through which you can view and explore information available on 

the web via HTTP (Hyper Text Transfer protocol). The Browser is capable of displaying 

information available in HTML format. It also includes capabilities to display graphics, play 

audio and video long with displaying text. Browser includes various kinds of buttons and 

menus through which you can perform various functions. The biggest advantage of browser 

is that it delivers the same kind of Interface as of Operating System on which it executes. 

A Web Browser is a software which allows you to review the Web Content, save and 

download the content, copy and print the information you have visited, mark a bookmark to 

save the location of websites you have visited, record a history of websites you have visited 

and security features to prevent unauthorised access. 

There are different kinds of browsers available. Some of earlier web browsers were text 

based while almost all of the browsers available today are Graphical User Interface (GUI) 

based. Theses browsers are available freely on Internet. You simply need to download and 

install it. Otherwise most of the Operating Systems has already browser available. Some 

examples of Browsers are: 

1. Internet Explorer. 

2. Netscape Navigator 

3. Google Chrome 

4. Safari 
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5. Mosaic 

6. Mozilla Firefox 

7. Lynx 
 

Netscape Navigator: It is also GUI based Web browser developed by Netscape 

Communications Corporation. It includes various features like simultaneous image loading 

and continuous document streaming. By using this browser, users can chat and it also 

provides feature of web based browsing. 

Firefox: It is customizable kind of Web Browser having features of both the Internet Explorer 

(IE) and Netscape Navigator. It is a secure and fast browser. 

Mosaic: It is the first graphical web browser and was developed at National Centre for 

Supercomputing Applications. It includes the features of easy navigation for users between 

various hypertext documents. 

Internet Explorer: This browser is a product of Microsoft and is one of the most popular 

browser which is being used now a days. It provides GUI and its current version id 10.0. It is 

supported by Windows, Macintosh and Solaris Operating Systems. 

2.2.1 General Features of Internet Explorer: 
 

1. It is easy to use kind of Web Browser. 

2. It includes options to save time for routine tasks like automatically filling addresses 

and forms. 

3. User can manage the privacy features like cookies and security zones. 

4. It displays web pages in multiple languages. 

5. It provides features to read contents of webpage offline. 

6. Version 10 supports the feature of Spell Checking 

7. Version 10 supports the feature of ―Do not Track‖ option. 
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This option actually helps the browser to prevent certain websites from tracking a 

user‟s behaviour for the purpose of serving targeted ads. But it is applicable only to 

websites that comply with the request. 

Structure of Internet Explorer 
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2.3 FTP 
 

Internet is a vast repository of information and different resources. This information may 

include various software, audio, video and images etc. To use these resources, this 

information has to be downloaded to your machine from a remote machine. For this purpose, 

Internet provides a service called File Transfer Protocol (FTP). 

FTP is a part of TCP/IP suite. Although email can be used for moving files from one 

computer to another, but for larger files, it becomes cumbersome. FTP was created as a way 

to retrieve these files interactively. By using FTP, people can browse the files in different 

directories (folders), select and download these files. FTP provides the way communication 

i.e. you can transfer the files from your own computer to remote computer also. 
 

 

 
 

 

2.3.1 How to Use FTP 
 

FTP works on client server principle. A software program remains at client side called FTP 

client and a software called FTP client and a software, FTP server remains at Server side (at 
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Remote Computer). The client program interacts with the server to access the information 

present on the server computer. The steps to perform FTP are as follows: 

1. FTP client contacts to FTP Server which prompts the user for a valid username and 

password. In some cases, simply give username as anonymous and email as password. 

2. After specifying the username and password, a connection (control connection) is 

established between client and server. 

3. FTP Server displays the files and folders present. A user can select the file/files which 

he/she wishes to transfer to client machine. To transfer the files, another connection 

(data connection) is established which breaks automatically after transfer. 

 

Note that a client can transfer file/files from his/her computer towards server also. But in case 

of anonymous access, this is not possible. Software on the client side can be of different types 

like command based, Browser (IE, Google Chrome etc.) or some special application software 

(Cute FTP). 

2.3.2 Accessing FTP Sites with the help of Browser 
 

Almost every browser has built-in support for FTP. Through Browser, one can easily upload 

or download the files to and from the server. Open the browser and type the following kind of 

URL in the address bar and press ENTER key. 

ftp://ftp.ptu.edu 
 

Note the beginning. It is ftp and not http. 
 

It will display a window asking for the username and password. 
 

Once you input these parameters or chose anonymous login option, the list of files and 

folders will be displayed in front of you. You can select any file and use drag and drop to 

download it. It is a convenient method, but not flexible. 

ftp://ftp.ptu.edu/
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2.3.3 Accessing FTP sites with specialized application like CuteFTP. 
 

 

 
2.3.4 Accessing FTP sites using Command Line 

 

As discussed earlier, almost every operating system has built-in support for FTP client 

software. So there is no need to install it separately. To use it, click on START-- RUN and 

type ―command‖ in the dialog box and click OK. On the command prompt, type 

ftp ftp-site-name 
 

Enter valid username/password or anonymous/emailed for anonymous login. 
 

At ftp prompt, various commands can be given to upload/download the file/files. The various 

commands are as follows: 

2.3.5 Table of FTP Command 

 

? to request help about the FTP commands 

ascii to set the mode of file transfer to ASCII 

binary to set the mode of file transfer to binary 

bye to exit from FTP environment 

cd to change directory on remote machine 

close to close a connection with another computer 

delete to delete a file in a directory at remote machine 

get to copy one file from the remote machine to the local machine 
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 get ABC copies file ABC in the current remote directory 

help to get a list of all available FTP commands 

ls to list the names of the files in the current remote directory 

mkdir to make a new directory within the current remote directory 

mget to get multiple files from the remote machine 

 mget ABC XYZ copies ABC and XYZ file from remote machine. 

mput to copy multiple files from the local machine to the remote machine; 

open to open a connection with another computer 

put to copy one file from the local machine to the remote machine 

pwd to find the present working directory 

quit to exit from the FTP environment 

 
 

2.3.6 Advantages of FTP 
 

1. FTP can be used to transfer a file of almost any size whereas it is not possible in case 

of email. 

2. It is a simple, fast and reliable method of uploading/downloading the files. 

3. It can be used to transfer files from/to different platforms (e.g Windows client to 

LINUX Server) 

4. With the help of FTP, files can be transferred in ASCII or binary mode. 

5. FTP clients are available for almost all types of Operating Systems. 

2.3.7 Disadvantages of FTP 

1. FTP provides little security during file transfer. The username/password is transferred 

in clear text. 

2. It is not user friendly. 

 

 

2.4 Telnet 
 

Internet is a network of thousands of networks connected all over the world. Through 

Internet, you can access resources stored at different computers which are geographically 

placed at distant places with the help of a service called TELNET. With the help of telnet, 

you can access computers available in your labs and offices even while sitting at home. In the 

previous section, you have learnt about FTP. Suppose we want to do some administration on 

the files present at FTP Server. It would not be possible with FTP Service. You have to 

remotely login at FTP Server for this. 

Telnet is a TCP/IP suite protocol used for remotely login. It is a combination of two words 

(Terminal Network). It allows you to sit on your PC and access a remote computer which 

may be even at the opposite end of the world. Like FTP Service, Telnet also require software, 

one on the client side (telnet client) and other on the server side (telnet server). It is based on 
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client server technology. This protocol specifies the standard that how client keystrokes 

would be encoded to send to the server and how the server encodes the output for 

transmission back to the client. 

To access the Telnet Service, you need to know the domain name or IP Address of the telnet 

server. Some telnet servers provides the guest login (username guest) option without 

password like anonymous login in FTP whereas some requires a valid Username/Password 

combination. While using telnet service, your own computer (client) works like a dumb 

terminal (having no processing power) i.e. only monitor and keyboard are used. The 

commands typed by you are simply pass-on to the telnet server and executed there and the 

results generated are displayed on your machine. Telnet is used to access a number of 

resources like FTP, WWW, Gopher, Library Catalogues and other public databases. One 

most important part of telnet is that it can also be used to check the configuration of various 

services like SMTP (Simple Mail Transfer Protocol), POP3 (Post Office Protocol version 3) 

etc. Every operating System has a built-in support to use the Telnet Service. It means that the 

telnet client software is already available in every operating system. If you want to use 

different applications for Telnet client - PUTTY, Absolute Telnet and TeraTerm are some 

other options. 

2.4.1 How to use Telnet 
 

1. Click on Start Menu and then choose Run Option. Type ―command‖ in the box and 

press ―ENTER‖ key. A command prompt will appear in front of you. 

2. On command prompt type the command 

telnet IPAddress/FQDN of Telnet Server 

3. A Connection will be established to the Telnet Server. Input the required username 

and password. 
 

To quit from the Telnet Session, simply type “quit” at the command prompt. 
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2.4.2 Advantages 
 

1. You can access the remote computer without being physically present at that 

computer. 

2. You can connect to Bulletin Boards, Play Games with other users. 

3. You can chat with multiple users. 

4. User can directly login on SMTP/POP3 Servers with the help of Telnet Service and 

can Send/Receive Emails. 

5. One can directly edit the files available at FTP Server. 

2.4.3 Disadvantages 

1. Telnet has a CUI (Command User Interface). Non availability of GUI (Graphical User 

Interface) makes it less interesting. 

2. You can remotely access the machine but cannot download/upload the files from/to 

that machine. 

3. The information between Telnet Client and Telnet Server transmits in unencrypted 

form. So security issues arise in this service. If Security is a major concern for you, 

try to use SSH (Secure Shell) in place of Telnet. SSH is secure version of telnet in 

which all the information transmits in encrypted form between Client and Server. 

Check you Progress 1 
 

1. The browser uses protocol to access the information available on 

Web. 

2. Full form of HTTP is . 

3. FTP uses two connections & . 

4.   command is used to download multiple files from FTP Server. 

5.   command is used to upload a single file on FTP Server. 

6. Secure version of Telnet is . 
 

 
 

Activity 1 
 

Suppose you need to login an FTP Site and download some files. What steps will you 

perform for this. 
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2.5 Email 
 

Electronic Mail also known as email is the way of sending electronic messages from one 

computer to other anywhere in the world. The email may include text, picture, audio or video 

files. This is now a day one of the fastest and cost effective method of communication. It 

takes fraction of seconds to reach the email from one point to another. Most of the people in 

business, government and education prefer using email. It has become part and parcel of our 

life. People even use mobile phones, tablets and PDAs (Personal Digital Assistant) to 

send/receive emails. 

2.5.1 Email Address, its working and associated Protocols 
 

An email address is generally of the form username&domainname . Username can contain 

letters, numbers and some special symbols like underscore and period. However commas, 

parenthesis and spaces are not allowed. Domain name specify the name of the company or 

Online Service Provider. 

The various protocols related to email are SMTP (Simple Mail Transfer Protocol), POP3 

(Post Office Protocol version 3) and IMAP (Internet Message Access Protocol). SMTP is 

used for sending email efficiently and reliably over the Internet. It handles the exchange of 

messages between two email servers (E.g. abc@gail.com sends email to xyz@yahoo.com ). 

This protocol specifies commands which are carried out automatically between two email 

servers. The different commands of SMTP are HELO, MAIL, RCPT and DATA. Similarly 

POP3 is a protocol to move the emails from the mail server to the computers of the users. It 

allows email client to connect to any email server. The various commands associated with 

this protocol are USER <Username>, PASS <Password>, RETR, LIST and DELE. Similarly 

IMAP protocol is used to manipulate email messages on the server without downloading 

them on the local computer. It is like an advanced version of POP3. 

mailto:abc@gail.com
mailto:xyz@yahoo.com
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2.5.2 Steps to create an Email Account 
 

There are so many email programs like yahoo, rediffmail, gmail etc. that offer email free of 

cost. To create an email account in gmail, follow the given below steps: 

Step 1: Connect to the Internet. Open any browser of your choice like Microsoft Internet 

Explorer. Type www.gmail.com in the address bar of browser and press ENTER key. Home 

page  of  www.gmail.com  will  appear  in  front  of  you.  Click  on  the  ―Create  an  account>>‖ 

button. 

http://www.gmail.com/
http://www.gmail.com/
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Step 2: Type the desired information like First Name, Last Name, Birthdate, Gender, Mobile 

Number, USERNAME and password. Make sure the USERNAME you are using is available. 

To check the availability of username, click on ―Check Availability‖ button. Mobile number 

proves to be an important resource because google can send the text in case you lose contact 

to your email. 
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Step 3: Fill out the captcha information. This is a security feature which confirms that a real 

person is creating the account. 
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Step 4: Agree to the private Policy. Take the time to read the entire privacy policy to remain 

aware about what Google can and can't do with your personal information. Check the box to 

agree to Google's terms. 
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Step 5: Click on the Next step and you will move to Google+ profile creation page. All 

Google accounts create a Google+ account when they are created. It is Google's Social 

Network, and many of Google's services are linked to it. 
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A new window will show the confirmation of your email account. 

 

 

2.5.3 Changing View of Email 
 

Gmail supports different views. These views affect the space between each email in your 

inbox. Click the Gear icon in the upper-right corner of the Gmail window and select one of 

the Display Density options (Comfortable, Cozy, and Compact). 
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2.5.4 How to Import Contacts 
 

By using Gmail‟s Import Contacts tool, you can quickly add your contacts from another mail 

program. You have to export your contacts from your old email program, such as Outlook or 

a CSV file. 

http://www.wikihow.com/Export-Contacts-from-Outlook
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2.5.5 Composing and Sending email with or without attachment 
 

This option is used to write and send the email to someone. The various steps for it are as 

follows: 

Step 1: Click on the ―Compose Mail‖ button. A window to write the text will appear. 
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Step 2:  In the  ―To‖ field, specify the  address of  the receiver‟s email. Enter the address of 

other  person‟s  in  ―Cc‖  to  whom  you  want  to  send  the  same  email.  There  is  another  field 

―Bcc‖ (Blind Carbon Copy) to which email address of another recipient can be given. But in 

this case, he will not know that same copy of email is being sent to some another persons. 

Step 3: Enter the subject of email, which specifies the purpose of your message. 

Step 4: Type the contents of the message. 

Step 5: In case you want to attach one or more files, click on ―Attach a File‖ link in the same 

window. A dialog box appears from where you can select the file and click on ―open‖ button. 

Repeat the process, in case more files need to be attached. 
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Step 5: Click on the ―Send‖ button to send the email. 

2.5.6 Other Options in Email 

Gmail provides various other options to reply an email, forward the email, deleting the email 

from Inbox and creating folders (called Labels in Gmail). Folders/Labels help in arranging 

the different kinds of emails. Like all other email programs, gmail also provides the option 

for Signout. 

2.6 Information and Knowledge Sharing using IT tools 
 

Knowledge sharing is a process where the knowledge of an individual is converted or 

transformed into public knowledge in an organization or institution. It refers to "activities of 

transferring or disseminating knowledge from one person, group, or organization to another". 

With the use of Information Technology, this knowledge is developed in the form of new 

computer programs at the same site. The process of KS involves both the creation and the 

transfer of knowledge through different methods. Today knowledge is stored electronically 

and access is usually controlled by password. Information technology (IT) support can be 

classified into the use of proper repository for storing and sharing knowledge and the use of a 

communication medium for communicating and transporting knowledge among individuals. 

Also, it acts as a web-tool and permits easy accessibility to a variety of knowledge databases 

that include written text, as well as interactive multimedia such as music, video films, special 

simulations and virtual tours to museums. 
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2.6.1 Different IT Tools to share Knowledge 
 

E-mail: It acts as the main source of communication mechanisms 

Website: Different contents to share the resources can be placed at the website. 

Mobile Phones: Mobile phones are also one of the main tools for knowledge sharing as one 

can read emails or follow the newsletters; 

Spaces for project management: Different organizations create spaces for sharing the 

materials and evaluating the projects. 

Web-based conference tools and communication: It provides a mechanism to share 

knowledge between different persons with the help of Web Based Conference. 

Newsletters: This includes different information which are passed as letters in electronic 

form. 

 
Some Social media tools also exist to share the knowledge like Facebook, Twitter, LinkedIn, 

GoogleDocs (Collaborative creation of documents), Wikipedia, Weblog, Doodle etc. 

 

2.7 Computer Networks 
 

A Computer Network is an interconnection of two or more computer systems located at 

different places. In a computer network, the computers are linked together with some 

communication media (wired or non-wired) and communication devices to share the data and 

other resources. In a network the concept of client and server is generally used. A server is a 

machine which provides resources to other computers and clients are the machines which 

requests for the resources. The clients are called workstations and nodes. 

2.7.1 Advantages: Computer networking provides a number of advantages. Some of them are 

listed below. 

1. Sharing of 

data: This is the biggest advantage of computer networking. You can share 

documents, reports and almost any type of content between your groups. Suppose you 

and your friend wants to share a document, In the absence of networking, you have to 

manually copy the document on some media (Pen Drive) and give it to your friend. 

With the help of Networking, it is a matter of seconds to share the document. 

2. Internet 

Sharing: A single Internet Connection can be shared among different users with the 

help of a network. Suppose all of your family members want to access Internet at 

same time on their devices. You need not to purchase a separate Internet Connection 

for each. Just connect all the devices in a network and access one Internet Connection 

among each other. 

3. Hardware 

Sharing: This is also a major advantage of Networking. Suppose you need to manage 

a small office in which ten persons need to work on their desktop, laptops or other 

devices. They all need to use the printer. Rather than purchasing a separate printer for 
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everyone, you can share a single printer among all. Moreover with the help of 

Network, no one need to move to the machine to which printer is physically 

connected. Everyone can give the command to take printouts from his/her computer. 

4. Data 

Security and Management: In business environment, employees generally need to 

access the critical data related to business. So the Security of this data is of paramount 

importance. In the absence of networking separate copies need to maintain at different 

computers. Management from the security point of view is very difficult in this case. 

However, with the help of Networking, a separate server (File Server) can be 

maintained upon which critical documents can be placed and accessed by employees. 

Management (Backup and Security) of data in this case is quite easy. 

5. Flexible 

Access: Network allows the users to access their data from any of the available 

computers. Now a days, people belonging to marketing departments (travelling 

people) access the company‟s Servers even during travelling and from hotels, This is 

only possible due to Networking (Internet in this case). It allows different users to 

work on the same project. 

 

 
2.7.2 Disadvantages: Although networks have a number of advantages, it has some 

limitations also. 

1. Hardware, 

Software and Setup Cost: To setup a network, you need some specialized hardware 

along with computers like wires, connecting devices e.g. hubs, switches etc., some 

piece of software. It involves a huge cost. Moreover there is another cost for planning, 

designing and implementing the network called setup cost. 

2. Negative 

Effects of Sharing: Proper Planning is required to share the data among various users. 

Every data should not be available to everyone. Since Network provides easy sharing, 

it also leads to sharing of Viruses and Worms. 

3. Security 

Issues: This is one of the major concern areas for the networks. If network is not 

properly implemented, it puts critical data at risk. There should be no unauthorized 

access to the data. Proper care should be taken to save the data from hackers and other 

malicious users. 

2.7.3 Types of Network 
 

There are many possible ways of classifying the different networks, such as their size, 

scale and the geographical distance. Most network types are known as different types of 

„area‟ networks. This is no longer always the case due to new technology. Some of the 

most common types of network are: 

LAN (Local Area Network) 
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This is one of the original and simplest types of network. LAN networks connect 

computers over relatively small distances, like within a single building or within a group 

of buildings situated nearby. Network in a home is often LAN network, even if there is 

more than one device in the home. They do not contain more than one subnet, and even if 

exists, are usually controlled by a single administrator. 
 

Advantages: 
 

1. High 

Reliability, because failure of one does not affect the functioning of others. 

2. New 

addition of a computer is easy. 

3. Different 

devices like printers and disks can be shared easily. 

4. A high 

rate of data transmission is possible. 

 

 

WAN (Wide Area Network) 
 

This is another category of network, and is more complex in nature. WAN networks 

connect computers together over a large physical distance and allowing them to 

communicate. The Internet is a WAN, and connects computers all around the world. 
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LANs connect to WANs, such as the internet, using special devices called routers to 

transfer data quickly and securely. WANs   being the large network cannot be controlled 

by one administrator. In the case of the Internet, it is publicly owned. 

 

 
MAN (Metropolitan Area Network) 

 

This Network is larger than a LAN but smaller than a WAN. It includes properties of 

both. It generally includes a town or city and is owned by a single person or company. 
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CAN (Campus Area Network) 
 

This network is larger than a LAN, but smaller than an MAN. This exists in areas such as 

a university, large school or small business. It spreads over a number of buildings which 

are local to each other. It may have the option to connect another network from outside 

and the capability to the internet. 
 

2.7.4 Network Topologies 
 

Network Topologies specify the way in which various nodes (computers, printers and 

other devices) of a network are linked together. It can also be referred to as the 

geometrical representation of the relationship of links connecting nodes. While selecting a 

topology for your network, always keep in mind the following factors 

1. Cost 

2. Reliability 

3. Capacity 

(Bandwidth) 

4. Installatio 

n Effort 

5. Troublesh 

ooting 

6. Scalabilit 

y. 
 

The different types of topologies are BUS, RING, STAR, MESH, TREE and HYBRID. 

The detail of each one is as follows: 
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BUS Topology 
 

 

 

 

 

Bus topology uses a common backbone to connect all the devices. A single cable acts as a 

shared communication medium to which devices attach with an interface connector. Devices 

communicate with each other by sending a broadcast message onto the wire which all other 

devices see, but only the actual recipient accepts and processes the message. Bus topologies 

are relatively easy to install. It does not require much cabling. Bus networks work best with a 

limited number of devices. If more computers are added to a network bus, performance 

degrades. Moreover, if the backbone cable fails, the entire network goes down. 

 

 
RING Topology 

 

 

 
 

 

 
 

In ring topology, A ring of the all the computers and connecting devices exist. In this 

configuration, every device has exactly two neighbours for communication purpose. The 

messages travel in the same direction through a ring (either "clockwise" or "counter- 

clockwise"). Any failure in the cable or device breaks the loop thereby breaking down the 

entire network. To implement a ring network, Token Ring technology is used. Ring 

topologies are commonly found in some office buildings or school campuses. 

http://compnetworking.about.com/od/internetaccessbestuses/g/backbone.htm
http://linux.about.com/cs/linux101/g/broadcastmessag.htm
http://compnetworking.about.com/od/networkprotocols/g/token-ring-networks.htm
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STAR Topology 
 

 
 

 

 

Many home networks use the star topology. A star network topology includes a central 

connection point called a "node" that may be a network hub, switch or router and all the 

computers connect in a fashion to form a star. Computers typically connect to the hub with 

Un-shielded Twisted Pair (UTP) Ethernet. As compared to the bus topology, a star network 

generally requires more cable. It is more reliable as a failure in any star network cable will 

break down only one computer's network access. However, if the hub fails, the entire network 

also fails. 

 

 
TREE Topology 

 

 

 

http://compnetworking.about.com/cs/homenetworking/a/homenetguide_2.htm
http://compnetworking.about.com/cs/internetworking/g/bldef_hub.htm
http://compnetworking.about.com/od/hardwarenetworkgear/g/bldef_switch.htm
http://compnetworking.about.com/cs/routers/g/bldef_router.htm
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A tree topology joins various star topologies together onto a bus. In the simplest form, hub 

devices connect directly to the tree bus, and each hub functions as the root of a tree of 

devices. This bus/star hybrid approach supports future expansion of the network. 

 

 
MESH Topology 

 

 

 

 

 
 

Mesh topology includes various paths. Messages sent on a mesh network can take any of 

several possible paths from source to destination. Internet, which is a network of networks 

has mesh topology. In mesh network, where every device connects to every other is called a 

full mesh. Partial mesh networks also exist in which some devices connect only indirectly to 

others. 

 

 
2.7.5 Transmission Media 

 

 

To transmit data in a computer network, some kind of transmission media is required. 

Various physical media can be classified as guided (e.g. cables) and unguided (wireless). 

Each one has its own characteristics like bandwidth, delay, cost, ease of installation and 

maintenance. 

http://compnetworking.about.com/od/networkdesign/f/what-is-mesh-networking.htm
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Bandwidth: It specifies the rate at which data can be transmitted. If all other factors remains 

constant, greater bandwidth leads to higher data rate. 

 

Transmission Loss: As the signal travels, it gets weak. Try to limit the distance in this case. 

 

Interference: Signal can interfere with each other thereby leading to distortion or complete 

wipe out. Interference is of particular concern for unguided media but is also a little bit 

problematic with guided media. Proper shielding of a guided medium can minimize this 

problem. 

 

The various guided and unguided media are as follows. 

Communication Media 

Guided UnGuided 

Twisted Pair Radio Wave 

Coaxial Cable Microwave 

Optical Fibre InfraRed 

 

These are the technical names, whereas if you go to market to purchase the cables, the 

commercial name is CAT5 and CAT6 

 

Check your Progress 2 

1. Email uses , & protocols. 

2. Bcc stands for in Email. 

3. In a Network client machines are also called . 

4. WAN stands for . 

5. Ring Topology uses technology. 
 

 

Activity 2 

You need to design a Network for your home in which maximum five computers (including 

laptops and desktops) and two printers (coloured, black & white) will be used. What factors 

will you keep in mind while designing it? 
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2.8 Summary 
 

The Internet provides a large number of features. Almost all the features are accessible, now- 

a-days with the help of Browsers. The browsers are available by a number of Companies like 

Microsoft, Google, Netscape Communcation etc. The features provided by the various 

browsers  are  more  or  less  similar.  Internet  Explorer  Browser  provides  the  ―Do  not  Track‖ 

Option which is really helpful. It also provides the option of Spell Checker in its latest 

versions. Different applications are available on www. FTP is used to upload and download 

the files of almost any size. However it suffers from a security issue which is easily resolved 

by a secure version of FTP called SSH (secure Shell). Telnet provides the feature to remotely 

login a machine/server. His proves to be really helpful to persons who need to access the 

company network from outside the company premises. Email which is the major application 

of www provides a number of features. One can send/receive text messages, audio, video or 

any kind of data. Some email providers provide the option to create folders so that you 

manage your emails from different persons in a more manageable way. All the facilities are 

possible because of the Network. Networks can be created in different sizes, topologies by 

the use of different kinds of communication media. 

 

2.9 Glossary 
 

HTTP (Hyper Text Transfer Protocol): A protocol used to access the web. 

Web Browser: A software which is used to view the information presented in HTML form. 

GUI (Graphical User Interface): An Interface to which you can interact with a mouse. 

CUI (Command user Interface): An interface to which commands need to type to use. 

FTP: File Transfer Protocol use to upload/download the files. 

Telnet: A protocol used for remote login. 

SMTP (Simple Mail Transfer Protocol): A protocol used to transfer email from one server to 

another. 

POP3 (Post Office Protocol version 3): A protocol used to download emails on client 

machines. 

 

 
2.10 Answers to Check your Progress 

 

Check your progress 1 

1. HTTP 

2. Hyper Text Transfer Protocol 

3. Control Connection & Data Connection 

4. mget 

5. put 

6. SSH 

http://www/
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Check your progress 2 

1. SMTP, POP3, IMAP 

2. Blind Carbon Copy 

3. Workstations 

4. Wide Area Network 

5. Token Ring 

2.11 References 

Roderick W. Smith, Linux: Networking for your Office, SAMS Publications 

Kamlesh K. Bajaj, Debjani Nag, E-Commerce: The Cutting Edge of Business, TMH 

Publications 

Anurag Gupta, Vikram Sharma, Anshuman Sharma, Fundamentals of Internet Applications, 

Lakhanpal Publications 

 
2.12 Suggested Readings 

Internet Complete, BPB Publications 

https://www.techopedia.com/definition/25597/computer-network 

https://www.coursera.org/course/comnetworks 

Charanjit Singh, Pardeep Bhandari, Gurmeet Singh, ―Computer Networks‖, Kalyani 

Publications 

 

2.13 Terminal and Model Questions 
 

1. How Email is useful to everyone now a days 

2. List various FTP Commands along with examples 

3. Explain the working of Telnet 

4. Explain various features of any Browser of your choice. 

5. Explain the steps to send an Email with attachment to multiple users. 

6. What are the various possible topologies to create a Network 

7. What is meant by a Network and how many types of Networks can be created? 

8. Explain the inner working of FTP. 

https://www.techopedia.com/definition/25597/computer-network
https://www.coursera.org/course/comnetworks
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Lesson 3 E-Commerce 
 

Structure: 
 

3.0 Objectives 
 

3.1 Introduction 
 

3.1.1 Scope of Internet and Web Portal 
 

3.1.2 World Wide Web to reach Customers 
 

3.2 Comparison between Traditional Commerce and E-Commerce 
 

3.2.1 Traditional Commerce 
 

3.2.2 Online Commerce 
 

3.2.3 Difference between Traditional Commerce and E-Commerce 
 

3.3 Advantages and Disadvantages of E-Commerce 

3.3.1 Advantages to the Customers 

3.3.2 Advantages to the Business Houses 

3.3.3 Advantages to the Society 

3.3.4 Disadvantages 
 

3.4 Buying and Selling on Internet 
 

3.5 Issues in implementing E-Commerce 
 

3.6 E-Commerce Models 
 

3.7 Summary 
 

3.8 Glossary 
 

3.9 Answers to check your progress 
 

3.10 References 
 

3.11 Suggested Readings 
 

3.12 Terminal and Model Questions 
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3.1 Introduction 
 

E-commerce is a buzzword these days. It is a revolution in the world of Commerce and 

Management. It opens millions of new doors for the people living in different corners of the 

world. This word changed the way to do business. In simple words, E-Commerce means to 

buy and sell the products online. The product may be a good or service or information, Under 

the E-Commerce, seller use the digital power to know the preferences and requirements of 

customer and then try to deliver the same as quickly as possible. These automated and quick 

services increase the revenue of the producers or the supplier. With the help of E-Commerce 

we can buy the product/services from any part of the world. So, in these days E-Commerce 

change the feature of shopping, retailing etc. E-Commerce also refers to the paperless 

exchange of business transactions. Information is transferred from one place to another 

through computers and network. The boosts in the Internet Services also boost the E- 

Commerce. 

E-Commerce is an emerging field. To get the benefits from it companies are doing their best. 

Although it is generating profits at the higher level but implementation of E-Commerce on 

the traditional business or the transit of traditional business into E-Commerce business is a 

complex task. Companies are reengineering the business processes to maximize the benefit 

from the E-commerce. With the advancement in the E-Commerce, new vendors emerged in 

the market to provide their services for the support of E-Commerce. Different 

websites/portals are offering wide range of products and services to the consumers and 

worked as virtual shopping malls, where one customer may buy any of the products/services 

by a simple click on the Desktop/Laptop/Mobile. Dear Students, in this lesson we will learn 

about the different types of product and services which are available, different parties 

involved in E-Commerce and then the comparative analysis of both the world i.e. Traditional 

Commerce and E-Commerce. 

3.1.1 Scope of Internet and Web portal 
 

To sell the goods/services online, along with the hardware and software, there is one 

prerequisite i.e. Internet and Websites. With the advancement of technology, new milestones 

have been created in the Commerce and Management. For the electronic interchange high 

Internet services are required. EDI(Electronic Data Interchange) can be used to transmit 

documents i.e. purchase orders, invoices, receiving invoices and other business 

correspondence between the parties. EDI also support to transfer financial information and 

payments in Electronic form. 

For all these services, the requirement is internet and web portals. The internet is helpful to 

allow millions of computers to be linked together, which offers global network that connects 

Universities, Government agencies etc. During the inception of Internet, it was mainly used 

for research and academic activities. At present, it seems that Internet Services have been 

hijacked by the business player for commercial use. During 2010, United Kingdom had 

biggest E-Commerce market in the world according to amount spent per capita. China‟s share 

is also increasing with 384 million Internet Users. China‟s online sales were $36.6 billion in 
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2009. E-Commerce transaction between China and other Countries increased to 2.3 trillion 

yuan in year 2012. In 2013 Alibaba had a market share of 80% in E-Commerce in China. 

3.1.2 World Wide Web to reach customers 
 

WWW, a platform/market place/shopping mall where vendor from all spheres of life can 

offer goods, services and information. www provides a link between the buyer and seller. 

Now it is a virtual place whereby buyer and seller meet. To be successful in E-business rules 

are the same. Customers and their satisfaction is on the priority list of vendors. In E-business 

there are different types of challenges and problems to retain the old customer and to create 

new one. In online Business, consumers have different alternatives which are just a click 

away. So for online consumer, a good experience to buy the product/service is a key or most 

significant factor. A good experience include number of issues i.e. easy to use, user friendly 

sites, speed, dependability and less quantitative data etc. 

3.2 Comparison between Traditional Commerce and E-Commerce 
 

Traditional Commerce or marketing is location based, personalized touch is there and it 

depends upon the individual skills. E-Commerce is done on the virtual space known as www. 

There is absence of personal touch and human intervention, 

With the increased popularity of E-Commerce, many traditional small businesses wants a 

convergence in the E-commerce to boosts their sales. When we look at the features of E- 

Commerce and Traditional Commerce, a number of differences exist. While deciding about 

the shift from traditional to E-Commerce, one must give weightage to all the points so that 

right decision could be taken about shifting. The internet proves to be disappointment for 

many retailers and manufacturers. Companies must evaluate their ROI (Return on 

Investment) before investing huge amount in the technologies. 

3.2.1 Traditional Commerce 
 

It consists of marketing to reach the customers, getting together with them at a place of 

business. Marketing Techniques which are used include mailings, advertisements and phone 

calls. Buyer and Seller are the two main parties in the traditional Commerce. Normally, the 

following methods were used for buying and selling: 

1. In first case, customers took the initiative and went to place of seller and buy the 

commodities. 

2. In the second case, salesman went to the place of buyer to sell the product or make the 

calls on the phone to sell the product. 

3. In the third case both the parties took the action. Seller send the catalogue to the buyer 

to buy the product and the buyer buy the goods after making selection from the 

catalogue. 

All these methods are applicable on B2B or B2C . 

3.2.2 Online Commerce 

http://www/
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In this market, all the steps involved are online. Mainly there are two forms of E- 

Marketing/E-Commerce. One is Push Marketing and other is Pull Marketing. 

Push marketing is sending emails, posting online ads on various websites. It is so called 

because it pushes the information to the people and insists them to buy. 

Pull marketing is a case whereby the company have its websites to sell the products. Social 

marketing is also used in pull marketing. 

Both these methods include the use of online media to buy the goods, the metaphor of 

browsing a store along with shopping cart/bag. This facility allows the customer to put the 

selected items in a bag to hold until the shopping is finally done. 

3.2.3 Difference between Traditional Commerce and E-Commerce 
 

1. Direct Interaction: Traditional Commerce is based upon direct interaction between 

buyer and seller. The buyer has the chance to look and feel the product. He has the 

opportunity to interact with the salesman to know the features of the product. At the 

same time, this facility also proves to be helpful to the vendor. Salesman gets a 

chance of up-selling and induce-selling. Salesman will admire the buyer to buy more 

product or the related items to enhance the profit of the organisation. 

If we talk about E-commerce, then above cited advantages will not be there unless 

websites have been customize to do the same, like showing related products or live 

chat. 

2. Reduction in Cost: Maintenance of physical store is quite expensive as compared to 

having an online store. The costs which are available in traditional commerce like rent 

of commercial space are absent in E-Commerce. An online store can be opened with a 

minimum price of operational cost i.e. cost to run the website. It can be really suitable 

for the small retailor. 

3. Difference in Reach: Online Business has global reach whereas under the traditional 

commerce, shop is available only for those who are willing to pay a visit to the shop. 

An online store has global reach and no capability limit. 

4. Return Policy: In case of online exchange of goods, rate of return is high. On the other 

hand, in case of traditional shopping, as the buyer buys the goods after careful 

examination, return rate will be quite low. In case of online sale, physical examination 

is not possible, so return rate will be quite high. 

5. Online Shopping and Frauds: Traditional Commerce is not free but to some extent 

quite trustworthy because buyer and seller are personally attached with each other and 

no one wants to break the trust. Whereas in case of E-Commerce, a large number of 

cases of frauds exists. 

a) Frauds related with products: In a number of cases, it has been informed that 

products are not delivered properly. Instead of product, useless material has been 

delivered to the buyer. These type of frauds may be not at the sellers end but it 

ruins the image of the company thereby affecting the business. 
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b) Debit/Credit Card Frauds: E-Commerce is not totally secure. There are numerous 

security issues. Everyday a number of frauds related to credit and debit cards are 

reported. 

6. Economic Goods: As online stores has a wide access and sale volume is quite large, 

so they are providing goods at economical rates as compare to traditional market. 

7. Anytime shopping: Traditional market is time based market and accessible only in 

operational hours. On the other hand online market is 24 by 7 markets. One may buy 

the product according to his/her convenient time and requirements. 

 

 
3.3 Advantages and Disadvantages of E-Commerce 

 

With the enormous growth of Internet, companies have the option to expand their 

business opportunities. There would be only few companies that do not use E-Commerce 

as the E-Commerce has a number of advantages. 

3.3.1 Advantages to the Customers 
 

The biggest advantage of E-Commerce is to the customers. Some of the advantages from 

an unending list are as follows: 

a) Reduction in Prices: In E-Commerce, there is a direct interaction between buyer and 

seller, thereby reducing the intermediaries. Reduction in Intermediaries leads to 

passing the savings to the customers and thus buyers get the goods at reduced prices. 

b) 24*7 Access: E-Commerce does not have the time and distance barrier. One can 

access the E-Commerce site at any point of time and buy/sell on the click of the 

mouse. 

c) Large Choices: E-Commerce sites provide larger options to customers. One can easily 

and quickly compare items of different brands. 

d) Quick Delivery: Almost all the E-Commerce sites provide the quick delivery of items 

purchased. Some of the sites provide delivery ―On Next Very Day‖, may be at some 

price. 

e) Global Market: It is like a global marketplace where customers can buy anything from 

anywhere. 

f) Information about Goods: One can obtain detail information about products in 

seconds. 

3.3.2 Advantages to the Business Houses 
 

The beauty of E-Commerce is that it provides various benefits to Business Houses also 

along with the customers. The Business Houses can gain a lot by adapting E-Commerce. 

Some of the advantages to Business Houses are as follows. 

a) Advertising Cost: Advertising on Internet costs very low as compared to costs on 

Electronic (Televisions) Media and Print Media (Newspapers) 
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b) Lesser Start-up Cost: Since less amount of capital is required to start an E-Commerce 

site, any person can start a company. 

c) Increased Market Share: E-commerce sites do not have physical barriers. So Business 

houses can have access to even International markets. 

d) Other Benefits: Various kinds of operating costs decrease in case of E-Commerce as 

compared to traditional method of doing business. Traditional Business can reduce 

delivery time labour cost, data entry, documentation preparation etc. costs by shifting 

to E-Commerce enabled Business. 

e) Improved Customer Relationship 

 
 

3.3.3 Advantages to the Society 
 

1. People from the developing countries can have the products and services from the 

developed countries with the help of E-Commerce. 

2. People can shop at E-Commerce sites  at the choice of their time, even at  home 

enjoying the comfort thereby reducing the traffic and pollution on the roads. 

3. A number of services offered by the government can be accessed online. 

3.3.4 Disadvantages 

Although E-Commerce offers a long list of advantages, yet it has some demerits which 

are listed below: 

1. Unreliable Network: Although the structure of Internet overcomes single point of 

failure, yet there is large number of network failures in history. In such a case, it 

affects the credibility of site leading to loss of customer base. The failure of a network 

may be due to some technical reason or other natural calamity like floods etc. 

2. Security Issues: Lack of adequate security for online transactions leads to non- 

acceptance of E-Commerce. Customers are generally worries about security related to 

credit/debit cards. A number of cases of online stealing related to debit/credit cards 

have been occurred in the past. 

3. Hidden Costs: Online purchases often have high shipping cost, lack of warranty and 

unacceptable delivery time. These indirect hidden costs discomfort the buyers. 

4. Privacy Issue: Since E-commerce site store different kind of personal information 

about buyers like their purchasing habits, demographic data, credit/debit card 

information. This information can go in wrong hands. This privacy issues keeps the 

customer away from buying online. 

5. Service Issues: A number of complaints by the buyers have occurred about the after 

sale service provided by the E-Commerce sites. 

Check your progress 1 
 

1. E-Commerce means to & the products online. 

2.   & play a major role in the growth of Internet. 
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3. There is absence of in E-Commerce 

4. ROI stands for    

5. E-Commerce involves marketing & marketing 

True/False 

6 E-Commerce has no direct/indirect advantage to society. 

7 E-Commerce improves the customer relationship 

 

 

Activity 1 
 

Explain the role of World Wide Web (WWW) in the context of E-Commerce 

 

 

 

 

 

 
3.4 Buying and Selling on Internet 

 

To sell on Internet, there are some requirements which a business house has to fulfil. These 

technical requirements have a major impact on the success/failure of any E-commerce 

Business. Three main requirements for online sale transactions are 

1. Shopping Cart 

 
2. Secure Server 

 
3. Payment Processing 

 
1. Shopping Carts : It is a software which keeps track of user‟s selection of items from the 

website  before  the  final  ―checkout‖.  An  online  shopping  cart  contains  Product  Catalogue, 

Shopping List and Checkout System. An online shopping cart has product catalogue, 

shopping lists and checkout systems 

 
a) The product catalogue presents the product information to the customer and it also includes 

any other detail required to complete a transaction online. Information about the product 

generally includes the price, unique identification number of the product, image of the 

product or any other information of interest to user. 

 
b) A shopping list (i.e. list of selected products) allows users to keep track of the items which 

you want to purchase. A shopping cart image is used to show what items the shopper has 

selected for purchasing. Remember, to function properly the user‟s computer must enable 

―cookies‖ in their browser setting. Cookies are small pieces of information that gets store on 
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users‟ computers. It is used to keep track of people who arrive at the website and how they 

use the website. If your website uses „cookies‟, you must inform the users that, how and why 

this information is being used. 

 
c) The checkout system allows the customers to select different products by clicking on 

―Add/Insert items to cart‖ button. It enables them to pay for the products. 

 
2. Secure Server : Secure Socket Layer (SSL) is the technology for secure online transactions. 

SSL encrypts the data between the company‟s server and the buyer‟s computer. This makes it 

almost impossible for someone to access any information like credit card numbers exchanged 

between buyer and seller. In this way the secure server provide protection against the loss or 

modification of personal information. 

 

3 Payment Processing System: Shopping carts do not deal with the entire transaction. They 

pass information to a payment gateway. There are three payment options. 

a) Third party processing software. 

b) Internet Merchant Account 

c) Offline Payment Processing 

While choosing any of the payment options, following things must be kept in mind. 

 Cost (transaction fee, setup fee, monthly fee etc.) associated with the payment 

option. 

 Privacy of the transaction data 

 Fraud Protection 

 Credibility of the Service Provider. 

 

 
a) Third party Processing Software: These services offer an alternative to Internet 

Merchant Account. In this method, it is possible to start selling online more quickly 

and easily. There are registration, transaction and monthly fee associated with it. In 

this case, money from the transaction is deposited in a special account controlled 

by the service provider. The merchant initiate the transfer to obtain the money. 

b) Internet merchant Account: This account is used by the financial institute that 

enables the business to accept credit card payments online. For each type of credit 

cards (Visa, MasterCard), a separate Internet Merchant Account needs to be 

maintained. 

c) Offline Payment Processing: If an E-Commerce company has a limited number of 

online orders, they can take orders online but can process the credit card offline. In 

this option, Credit Card Information is obtained through a secure server and 

transaction can be processed manually. 
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For online selling, you need a Digital Certificate for SSL technology to work. A Digital 

Certificate is a kind of electronic ID that show the credibility of a website. Before buying 

anything from Internet, check whether website is on a secure server or not. Just look at the 

URL address of the website. It must starts with https:// and not http://. Another method is 

to have a have a look at the browser. Many browsers use a symbol (e.g. lock icon) to show 

Security. 

Security and Privacy Issues 

One must remain aware of security and privacy issues associated with e-commerce. Some 

common threats are fraudulent use of credit cards, viruses, spam e-mail messages, and theft 

of computers or information. Phishing is another security threat that involves an e-mail 

message that looks coming from an official source but message go to a fake website where 

you may disclose your personal information. Common threats to privacy include theft of 

personal information, and inadequate protection of private information. The following things 

must be kept in mind for minimizing security and privacy risks. 

Review the security features provided by the web hosting service, ISP, web designing 

company. 

Pay attention to security alerts and install security patches. 

Regularly update software and perform scanning for spyware and viruses. 

Regularly backup systems and information 

Design of an e-commerce website should minimize security threats. 

Always obtain a digital certificate for your website. 

 
3.5 Issues in Implementing E-Commerce 

 

There are certain implementation issues which companies must consider before the 

development and deployment of E-Commerce. 

1. Cost Issue: It is a major issue. To implement the E-commerce, companies need high 

end technologies in the form of hardware, software etc. At the same time, there will 

be cost to train the staff regarding new technologies. Then there is requirement of 

support staff, comprehensive solutions with greater ease of use to help cost effective 

deployment. 

2. Cost-Benefit Analysis: Before the implementation of E-commerce, it is essential for 

the business concern to know that their investment in Electronic Commerce system 

will produce a return. Moreover companies might be interested to know that either the 

benefit will be greater than cost or not. It is not only the monetary value, the goals and 

objectives must also be satisfied after the implementation of E-Commerce. Such 

systems must be flexible enough so that the required changes can be made as and 

when essential. 
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3. Security Issues: Because of the universal approach, Internet provides access to 

everyone. In such a scenario, there are certain points which companies must keep in 

mind while implementing the E-Commerce. 

a. Protection of Assets of Companies: Companies need to protect their assets 

from misuse from both internal and external. 

b. Information Security: In today‟s competitive world Information is power and 

security of information is required. Certain Security requirements must be 

fulfilled to secure the information 

c. Customers Information: Proper care must be taken to secure the information of 

customers. Privacy systems should be strong enough to safeguard the 

information critical to building sites that is essential for costumer as well as 

for business. 

4. Accelerate the existing System: Companies which are already in existence and using 

the Information Technology for certain operations like marketing, billing, ordering, 

distribution etc. must integrate their systems in such a way that it should generate 

maximum profits. 

5. Relationship Building: Companies should work in such a way during the transitional 

phase that it established strong relationship between all the stakeholders of the 

business. It is hard to run the business in a vacuum. Companies need to have a strong 

bonding for the efficient running of the business and the E-Commerce must help to 

enhance the cordial relationship among all. 

6. Other Issues: While implementing the E-Commerce, companies have to face many 

issues like resistance from the present employee. Human Labour is quite expensive 

and high end technologies supplement the job of human beings and in some cases 

simply eliminates the role of human beings. So their fear insists the employee to raise 

voice against the implementation of automation. 

 

 
 

3.6 E-Commerce Models 
 

E-Commerce is the transaction of the business with the use of Internet and World Wide Web. 

There are many different models of E-Commerce. 

1. Business to Consumer (B2C) : It is clear from the name that this model involves 

Business and Consumers and is one of the most popular model among all. It was 

having a small share in the market, but as the technology advances, its growth was 

exponential. In this model, online retailers and marketers sell their products to the 

online consumers by the visible data which is made available to them through various 

online marketing tools. E.g Amazon.com sale different kinds of products to 

customers. In this model, the E-commerce activities are focussed on Consumers rather 

than on business. Another example could be online banking. Transactions can take 

place between business houses and consumers. Individuals are involved in the online 

business transactions. 
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2. Business to Business (B2B): This model is one of the largest business model 

involving millions of dollars. In this model both the buyers and sellers are business 

entities and they do not involve individual customers. This is just equivalent to 

manufacturer supplying goods to retailers or wholesalers. E.g a particular Company 

just assemble the product (they do not manufacture them) and sale those products 

online. The company must be purchasing the items from different manufacturing 

groups. This model involves E-Commerce activities between businesses only. The 

transactions are carried out by the help of Electronic Data Interchange (EDI). It 

increases transparency among business houses involved and therefore business run 

efficiently. The security requirements in this model are higher as compared to B2C 

model. This model is helpful to improve the efficiency of several common business 

functions like supply management, inventory management and payment management. 

The business in this model is carried out in the same way as a manufacturer supplies 

the goods to wholesalers. 

3. Consumer to Consumer (C2C): In involves online transaction of goods or services 

between people. Although it seems that there is no third party involved, but it is not 

possible to carry out the transaction without third party. The third party‟s job is to 

provide the platform for online transaction just like e-bay. It is a person to person type 

of transaction that excludes business from the equation. Customers are themselves 

part of the business and they can interact directly with each other. 

4. Customer to business (C2B): This model involves activities where the customer 

determines the price of the product or the service. The focus shifts from selling to 

buying. In this type of E-Commerce, consumers get a wide choice of products or 

services along with the opportunity to specify prices which he/she is willing to pay or 

afford to pay. It reduces bargaining time, enhance the flexibility and creates ease for 

both the consumer and merchant. 

 
Check your progress 2 

1. EDI stands for    

2. E-Commerce uses technology to secure the transaction 

between buyer and seller. 

3. SSL uses to provide Security 

4. To maintain   information about users, E-Commerce sites generally uses 

 

5. For SSL technology to work, you need a    

6. E-Commerce site name must start with    
 

Activity 2 

Explain the Payment Processing System which is followed in the E-Commerce. 
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3.7 Summary 
 

E-Commerce brought out a revolution in the field of Commerce. The habits of buying 

are changing at a very rapid pace. People now prefer to buy and even sale on the 

Internet due to its numerous advantages. Due to it, traditional methods of buying as 

selling are also changing. In E-Commerce, seller uses the power of digital technology 

to know the preferences and requirements of the customers. It is providing numerous 

advantages to sellers, buyers and even to society also in a direct or indirect manner. In 

other words it is proving to be beneficial for all. There are different models of E- 

Commerce like B2B (Business to Business), B2C (Business to Consumer), C2B 

(Consumer to Business) and C2C(Consumer to Consumer). 

In spite all this boom and advantages, there are some issues that need to solve so that 

E-Commerce grow to its full potential. Among various issues, Security issue is of 

utmost importance. Due to some privacy and data theft issues (especially related 

credit/debit    card) in the history, people are somewhat reluctant. No doubt these 

issues are resolving these days but still this issue needs a proper importance. The E- 

Commerce requires Internet to work, some developing or under-developed countries 

do not have proper infrastructure form its implementation. Another issue regarding 

service of the product after its sale (i.e. warranty and after-sale-service) has some 

serious flaws. E-Commerce Business Houses must take care of this. 

 
3.8 Glossary 

E-Commerce: Buying and selling the products online 
 

EDI(Electronic Data Interchange): A method to transmit documents electronically. E.g. 

purchase orders, invoices etc. 

Push marketing: Sending emails, posting online ads on various websites for the purpose 

of marketing the products 

Pull marketing: Have own websites to display the products information for the purpose of 

marketing and selling. 

Secure Socket Layer (SSL): Technology which uses encryption to conduct secure online 

transactions. 

 

 
3.9 Answers to check your progress 

 

Check you Progress 1 

1. buy , sell 

2. Internet, www 

3. Personal touch 

4. Return on Investment 
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5. Push, pull 

6. False 

7. True 

 
Check your Progress 2 

1. Electronic Data Interchange 

2. SSL 

3. Encryption 

4. Cookies 

5. Digital Certificates 

6. https 
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3.12 Terminal and Model Questions 

 

1. Explain various E-Commerce models 

2. How E-commerce has changed the concept of selling/buying. 

3. Explain the difference between traditional commerce and E-Commerce 

4. Explain various advantages and disadvantages of E-Commerce 

5. What technical factors must be kept in mind while buying/selling on Internet. 

6. Explain various types of Security Issues involved in E-Commerce 

http://www.networkworld.com/article/.../how-to-protect-online-transactions.ht
http://www.uky.edu/~dsianita/390/390wk4.html
http://www.msen.com/~chad/ecomm_sec.html
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4 Information Technology in Management 

Structure 

 

4.1 Objectives 

 

4.2 Introduction 

 

4.3 Role of Technology in Operations 

 

4.3.1 How Technology Affects Operations 

 

4.3.2 Technology in Manufacturing 

 

4.4 Information Technology and Human Resource Management 

 

4.5 Information Technology in Marketing 

 

4.5.1 Use of Technology in Marketing 

 

4.6 Information Technology in Finance 

 

4.7 Information Technology in Materials Management 

 

4.8 Summary 

 

4.9 Glossary 

 

4.10 Answer to check your progress 

 

4.11 Model Question Paper 
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4.1 Objectives 

 
After reading this chapter, the students will be able to understand following points. 

 To understand about various applications of information technology in business. 

 To understand that how technology impacts important areas of management 

 Students will learn how technology has conquered areas like Production, Human 

Resource, Marketing, Finance and Materials Management. 

4.2 Introduction 

The computers have made great influence on the humans. Over the past few decades it makes 

this world as global village. The technological growth gives new dimensions to the business 

community by offering solutions which were earlier impossible to think with the traditional 

techniques from statistic to operations research. Today, the Information Technology plays a vital 

role in the processing and management of business data. Use of Information Technology is now 

an investment and plays a expanding role in business. 

To improve the efficiency and effectiveness of the business processes the managers use 

Information Technology for their decision making, and workgroup collaboration. It will 

definitely help the managers to strengthen the positions of their company in a fast changing 

environment. IT has become a required constituent for Managers to succeed in today's dynamic 

global environment. 

Chaffey and Wood described Information Technology as ‗‗technology resources used for 

business information management‘‘. The resources include software, hardware and 

telecommunication networks used for managing information". 

According to Benemati et al., IT is changing rapidly and considering the increasing 

strategic impact of IT on business operations, its successful management is of utmost 

importance. 

Irani and Love suggested that for IT management to be successful, it must be perceived 

as an iterative business process capable of providing organizational learning throughout the 

lifecycle of the technology . 

However, even when IT is managed successfully, the question arises, as to what role IT 

plays in the achievement of organizational strategic goals and objectives. In response to this 

question, Venkatraman et al and Franz and Klepper postulated that the proper role of IT in an 

organization is usually epitomized as a fit or alignment with the strategic goals of the 



Page 67 of 187  

organization. Therefore, IT can only be appropriately aligned when infrastructure put in place to 

implement the IT strategy is adequate; the strategy supports the organization‘s strategy and 

business processes. 

4.3 The Role of Technology in Operations 

Businesses are affected greatly by the advances in technology and so operations management is 

no exception. From robotics and automation in the manufacturing units to information 

technology in the form of enterprise resource planning (ERP) systems, the information 

technology is considerably changing the way how the both manufacturing and service operations 

are being designed and managed. 

One should keep in mind the technology is only a tool. It should not be installed at your 

site if it doesn‘t properly satisfy the requirements of the firm. Managers also need to realize that 

the technology will provide the necessary means to meet their customers' requirements in today‘s 

highly competitive atmosphere. It is also very important that managers must make out the need 

for these new technology-driven infrastructures to be compatible with all of the organization‘s 

functional elements. If so then the information can be rapidly and efficiently transmitted and 

shared without any errors. The Operation managers need to understand about the technology to 

properly integrate technology into their organizations. In addition to that the managers must 

recognize the need of proper training at all levels so that the technology can be used effectively 

and efficiently. Here one thing that need to be keep in mind that the training should be a 

continuous process rather than a one shot deal. 

4.3.1 How Technology Affects Operations 

Operations strategy means the different ways by which a enterprise competes in the marketplace. 

These strategies include 

(a) low cost 

(b) quality 

(c) speed of delivery 

(d) customization 

Earlier the managers had to decide out of these strategies which were most suitable to the 

particular market segment they were serving. Sometimes there were trade-offs involved as there 

may not be both low cost and a high degree of customization, or there was a choice to be made 

between providing fast product delivery and providing a highly customized product. These 
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traditional trade-offs are no longer applicable for most businesses because technology has set the 

higher performance bar by allowing enterprises to compete on several of these dimensions 

simultaneously. 

For example, firms using technology, such as Dell Computer, can now produce and quickly 

deliver individually customized products, and at a very competitive price. 

 
4.3.2 Technology in Manufacturing 

The use of information technology in manufacturing operations can be divided into four major 

groups of software systems: 

(a) Enterprise Resource Planning (ERP) 

(b) Supply Chain Management (SCM) 

(c) New Product Development (NPD), 

These software packages have significant overlap with each other in terms of their capabilities 

and what they provide. 

Enterprise Resource Planning (ERP) 

Before the introduction of ERP systems in the organizations , each functional area within an 

organization had its own software and database. These software packages were most of the time 

incompatible with each other the transactions cannot be take place directly between systems. AS 

there were more than one database, so generally there were multiple records for the same data, 

which results in the unnecessary errors throughout the firm. For example, an employee might be 

listed as Amit Kumar in the Human Resources database, Amit Kumar Gupta in the Accounting 

Department, and Dr. Amit Kumar Gupta in the Engineering Department. From the systems‘ 

point of view, these would be viewed as three different people. In such an atmosphere, 

transactions between functions were done manually most of the time which may result in 

additional errors. As a result each of the functional areas within an organization was viewed as 

an independent operation.(see Fig. 1) 

To address this issue of incompatibility and multiple databases, ERP systems were designed and 

developed to provide a framework with a common information technology platform that would 

link all of the functional areas with a single database, and also fulfills their individual needs (see 

Fig. 2) 
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Fig.1 Fig.2 

Benefits of ERP Systems 

An ERP system when properly installed and functioning correctly can provide a significant 

competitive advantage to an organization. The benefits of using an ERP system includes: 

(a) reduction in the number of errors through the use of a common database 

(b) faster customer response times 

(c) faster order fulfillment times 

(d) better overall communication within the organization. 

Supply Chain Management (SCM) 

A supply chain is the collection of interdependent steps when followed accomplished a certain 

objective such as meeting customer requirements. With customers increasingly calling the shots, 

manufacturers are scrambling to meet customer demands for options/styles/features, quick order 

fulfillment and fast delivery. Meeting customer specific demands for product delivery has 

emerged as an opportunity for competitive advantage. Clearly the hypothesis is that the firms 

that manage their supply chains will be more successful in the global marketplace. 

Supply Chain Management is a general term that includes the coordination of order generation, 

order taking, and order fulfillment/distribution of product, services or information. 

Interdependencies in the supply chain create an "extended enterprise" that reaches far beyond the 

manufacturing facility. Material suppliers, channel supply partners (wholesalers/distributors and 

retailers) and customer themselves are all key players in supply chain management. 

Goals of SCM 

 To cut cost 
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 Increase Profits 

 Improve performance in relationships with customers and suppliers 

 Helps to develop value added services that provide a competitive edge to the 

organization.. 

Functions of SCM 

Main functions of Supply Chain Management include: 

 Inventory Management 

 Distribution Management 

 Channel Management 

 Payment Management 

 Financial Management 

 Supplier Management 

 Transportation Management 

Benefits of SCM 

 Get the right product at the right place at the least cost 

 By keeping inventory as minimum as possible and still coming up with superior 

customer service 

 Reduce Cycle time (supply chain management means to simplify and accelerate 

operations that deal with how customers order and processed through the system and 

eventually filled and also how raw materials are required and delivered for 

manufacturing process. 

 
4.4 Information Technology and Human Resource Management 

The resources available to the organization generally fall into three categories: physical, 

organizational and human. Today in the era of global economy, the management of human 

resources' is most critical as it is the biggest asset for organization. The organization can gain 

competitive advantage, if it gets timely and accurate information about its present employees and 

potential employees. The Information Technology makes it possible by creating Human 

Resource Information System (HRIS). 

A human resource information software system or HRIS system is use to manage everything 

easily and become even more productive. If the organization have such system then it could aid 
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the human resource team to become more organised and practice being practical in the 

workplace. It is a database application used to track information pertaining to the employees and 

applicants. 

 
Definition of Human Resource Information Systems (HRIS) 

HRIS is a process that uses the information technology for the effective management of human 

resource functions and applications. It is a computerized system includes a data base or inters 

related data bases that track employees and their employment specific information (Gill and 

Johnson, 2010). It can be briefly defined as integrated systems used to gather, store and analyze 

information regarding an organizations human resources (Hendrickson 2003). 

Tannenbaum (1990) defines HRIS as a technology-based system used to acquire, store, 

manipulate, analyze, retrieve, and distribute pertinent information regarding an organization‘s 

human resources. 

Kovach et al., (1999) defined HRIS as a systematic procedure for collecting, storing, 

maintaining, retrieving, and validating data needed by organization about its human resources, 

personnel activities, and organization unit characteristics. 

HRIS – Why it is needed? 

HRIS helps HR professionals. HRIS offer HR professionals with opportunities to increase their 

contribution to the strategic direction of the firm, It not only automate and devolve many routine 

human resource task but also provides HR professionals to make attention towards more critical 

and strategic level tasks of business, such as leadership development and talent management. 

Other incentives for HRIS implementation are mentioned as following. 

 To formulate the policies and programs associated to human resource. 

 provides decision making in areas like promotion, transfer, nomination, to set 

employees provident funds, retirement, gratuity, leave travel concession and earned 

leave compensation. 

 To Supply data and to submit the returns to government and other constitutional 

agencies. 

 To Collect suitable data and converting them to information and then to knowledge 

for timeless decision making. 
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 To Produce a more number of varieties of accurate and real time human resource 

related reports. 

 Increase competitiveness by Reengineering human resource processes and functions. 

 Improving employee satisfaction by delivering human resource services more quickly 

and accurately. 

 Provides a comprehensive information picture as a single, integrated data base 

Functions of HRIS 

HRIS functions interactively with HRM systems such as human resource planning, staffing, 

training, career development, performance management and compensation management .The 

functions can also be categorized as following. 

1. Create and maintain employee record: The data which is entered create an employee 

record and this record is maintained throughout employment. Generally the HRIS 

administrator is responsible for creating and maintaining these records in an organization. 

2. Ensure legal compliance: Once the data is entered into the HRIS then it can be used to 

help the organization to comply with government regulations in an accurate and timely 

fashion. It is the responsibility of HR professional to ensure the data integrity and 

accuracy. 

3. Human resource planning and forecasting: The information obtained from various 

subsystems like recruitment, training and development, and administrative subsystems 

about the number of positions, types of positions, employee skills and competencies, job 

rates, retirement eligibility helps the managers to develop long range staffing plans and 

also provides precious information to the HR professionals. 

4. Talent management/Knowledge management: The data such as skills, competencies, 

jobs held, training and employee development interests entered into the system can help 

the managers to provide development opportunities for their employees. It ensures that 

the employees are offered positions that will enhance their skills, provide the suitable 

training for employees so that they can make improvements in the organization. This 

information will help HR professionals to provide more targeted advice and counsel to 

managers to create a development plan that meets organizational and employee needs. 
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5. Strategic alignment: The organizations can be benefitted from the information obtained 

from the system to align human resource activities more effectively with their strategic 

plan. 

6. Enhanced decision making: The relevant, useful, timely and accurate information 

obtained from the system improve the quality of management decision. 

 
Users of HRIS applications 

HRIS meet the needs of a number of persons associated with the organization. Generally , the 

people in the firm who interact with the HRIS are grouped into three categories: 

(1) HR professionals 

(2)Managers 

(3) Employees 

HR professionals depend upon the HRIS in fulfilling job functions regarding regulatory reporting 

and compliance, payroll, pension, skill inventory, compensation analysis, profit sharing 

administration, benefits administration etc.). 

Managers of different functional units expect that HRIS must provide the things which help to 

meet the unit‘s goals and objectives. Rather a manager depends on the HRIS‘s capabilities to 

provide better data collection and analysis particularly for performance appraisal and 

performance management. It also includes résumé processing, skill testing, assessment and 

development, recruitment and retention etc. 

Finally, the individual employees become end users of many HRIS applications. 

HRIS Benefits 

Benefits for management include: 

 Increase the efficiency as far as overall decision making is concerned. 

 Cost reduction and budget control. 

 It provides business transparency and makes the vision clear. 

 Makes transparency in the process of hiring and firing employees. 

Benefits for human resource department include: 

 Centralized database of all employees in the organization with all required information 

and opportunities of different reports. 
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Technology came into existence as boon for marketing industry. We can‘t even imagine 

marketing without use of technology. The most important aspect of marketing is communication. 

Communication helps businesses grow and prosper, creates relationships, strengthens the 

effectiveness of organizations and allows people to learn about one another. Technologies such 

as the Internet, mobile phones, social media, and customer relationship management systems 

greatly   affect   the   way   companies   communicate   with   prospective   customers. 

Technology has provided various tools for marketing such as internet advertising, e-mails, and 

text messaging. Newer technologies, including GPS, social media and smart phone applications, 

are becoming increasingly important. 

Two major tools being used today are customer relationship management systems (CRMs) and 

social media marketing. 

 Reduces the paper work to great extent which is much slower and have higher chances of 

errors. 

 The ability to bring up to date in data bases as soon as change happens, which is very 

important to regionally diversified organizations. 

 Reduces the errors which are caused by human factor. 

 Improved management system in accordance with the legislation. 

 Eliminate the duplicate records in the system. 

 Business processes are standardized. 

Benefits for employees: 

 Saves time 

 The independent access to data can be given. 

 24×7 data availability. 

 Boost staff morale. 

 Business obligations and events are automatically tracked and reminders are generated. 

 Employees can make decisions on the basis of information obtained in the HRIS system. 

 

4.5 INFORMATION TECHNOLOGY IN MARKETING 
 

https://www.boundless.com/marketing/definition/communication
https://www.boundless.com/marketing/definition/social-media
https://www.boundless.com/marketing/definition/customer-relationship-management
https://www.boundless.com/marketing/definition/advertising
https://www.boundless.com/marketing/definition/customer-relationship-management
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CRM 
 

Customer relationship management systems use technology to organize, synchronize, and 

automate business practices. CRM systems for marketing help the enterprise identify and target 

potential clients and generate leads for the sales team. In CRM all the data related to customer is 

collected and companies keep gathering certain amount of marketing information all the time to 

target potential customer as and when required. 

 

Social Media Marketing 

Social media marketing refers to the process of gaining website traffic or attention through social 

media sites. Social media marketing aims to develop brand name by addressing large number of 

customers. In other words, programs usually center on efforts to create content that attracts 

attention and encourages readers to share it with their social networks. Hence, this form of 

marketing is driven by word-of-mouth. Examples of famous social networking sites which helps 

in marketing are facebook, Twitter, LinkedIn etc. 

 
4.5.1 The use of technology in marketing: 

 
 

1) Helps companies gain competitive advantage: With help of technology a company can 

deliver its products to clients before anyone in market. when a company uses 

technology to speed up its services or production, it wins the customers trust hence 

getting ahead of competition. 

2) Strengthen brand name: Establishing a Brand name is very important for marketing. 

Technology makes it easier to make a brand popular and spread its name world wide. 

3) Online Surveys: Online surveys have proved to be beneficial for business growth. By 

directly interacting with clients and understanding their needs companies can alter their 

work as demanded by clients. 

4) Use of social networking sites: Social networking sites can be used as platform for 

advertisement and product promotion. 

 
4.6 INFORMATION TECHNOLOGY IN FINANCE 

https://www.boundless.com/marketing/definition/social-network
http://www.useoftechnology.com/technology-today-tomorrow/
http://www.useoftechnology.com/technology-today-tomorrow/
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World is shrinking day by day with advancement of technology. Technology has significant role 

in materials management as well.Computerization can be of great help to meet the followings 

objectives of materials management. 

1. Accurate and speedy remittance of information to customers and suppliers, bills, statements, 

reminders, etc. 

Finance is the segment of management that requires accuracy and reliability. Information 

Technology provides both along with fast transactions. Information technology focuses on the 

development of electronic networks that exchange information. Because all financial transactions 

involve the exchange of information, the increasing popularity of online finance coincided with 

advances in information technology. Information Technology has many uses in finance like 

trading financial instruments, keeping records of personal budgets and reporting the earnings of a 

business. It allows rapid transfers of funds and calculation of financial statistics. 

 
Following are important segments of finance industry where information Technology is used: 

 
 

 Trading: Information technology provides instant information for stock traders to make 

decisions, and allows them to enter orders that are immediately executed. Financial 

trading is enhanced with help of Information technology. A computer can be 

programmed to buy and sell orders when price of stock reaches certain level. 

 Financial Reports: Companies prepare their financial reports with help of IT tools with 

which they can better understand and organize their statistics. 

 Convenience: Personal finance is simplified using information technology. Debit cards 

and credit cards have made transactions so easy and portable. Information technology 

allows transactions during weekends and holidays, when there is no staff working at the 

bank. 

 Bookkeeping: Information Technology helps companies with their budgets considering 

financial transactions. Computer systems calculate and display the interest and principal 

of a loan, and estimate the returns on investment when the company borrows money to 

expand its operations. Companies can securely transfer data online, and the computer 

system records all transfers, which simplifies bookkeeping. 

 

4.7 INFORMATION TECHNOLOGY IN MATERIALS MANAGEMENT 
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4.9 Glossary 

 Asset: Something that is expected to generate future benefit and is owned or controlled by 

the company. 

 Customer relationship management (CRM): It is a term that refers to practices, strategies 

and technologies that companies use to manage and analyze customer interactions and data, 

with the goal of improving business relationships with customers, assisting in customer 

retention and driving sales growth 

 Enterprise resource planning (ERP): ERP is business process management software that 

allows an organization to use a system of integrated applications to manage the business and 

automate many back office functions related to technology, services and human resources. 

 Financial reports: A financial statement (or financial report)   is   a   formal   record   of 

the financial activities and position of a business, person, or other entity. 

 Information technology (IT): IT is the application of computers and telecommunications 

equipment to store, retrieve, transmit and manipulate data, often in the context of a business 

or other enterprise. 

2. Information for management for control purposes e.g. stock levels, inventory position, 

customer‘s acceptance etc. 

3. Improvement of customer relations, vendor and employee relations, by timely accurate and 

relevant information and through vendor analysis etc. 

4. Reduction of inventories to free the working capital. 

5. To increase profits at the same time giving better service by optimum scheduling, 

forecasting and optimizing utilization of traffic facilities, warehouses, machines, etc. 

6. To increase the productivity of materials and facilities. 

4.8 Summary 

Information Technology has significant importance in business management‘s functional areas. 

In today‘s competitive world it‘s impossible to compete without help of technology. We have 

studied how technology plays vital role in almost all the segments of management including 

production, human resource management, finance and material management. The outcomes of 

using technology in these functional areas are commendable. 
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 Social media: It refers to computer-mediated tools that allow people to create, share or 

exchange information, career interests, ideas, and pictures/videos in virtual communities and 

networks. 

 Transaction: A transaction symbolizes a unit of work performed within a database 

management system against a database and treated in a coherent and reliable way 

independent of other transactions. A transaction generally represents any change in database. 

4.10 Answer to check your progress 

1. Which system connects a company‘s ERP system to those of its customers? 

a. Application Platform b. Customer Relationship Management (CRM) 

c. Enterprise Solution d. Product Lifecycle Management (PLM) 

Answer: b 

2. Which functional area is responsible for taking customer orders? 

a. Marketing and sales b. Production and materials management 

c. Accounting and finance d. Human Resource 

Answer: a 

3. Information systems that allows data to be shared throughout the organization are 

called   

a. Integrated b. Unintegrated 

c. Bounded d. Unrestricted 

 

Answer: a 

 
4. The following is concerned with developing a pool of candidates in line with the human 

resources plan 

a. Development b. Training 

c. Recruitment d. All of the above 

Answer: c 

 
5. The company's HR team is responsible for 

a. training of supervisors b. monitor the appraisal system affectivity 

c. training the employees d. All of the above 

Answer: d 

6. The purpose of supply chain management is 

a. Provide customer satisfaction b. Improve quality of a product 

c. Integrating supply and demand management d. Increase production 
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Answer: c 

 
7. Information Technology means 

a. Hardware that manages information b. Hardware and software that manages 

information 

c. Software that manages information d. Paper-pencil method that manages 

information 

Answer: b 

 
8. A person who ensures that systems are developed on time within budget and with acceptable 

quality is a 

a. System designer b. Project manager 

c. System owner d. External system user 

 
Answer: b 

 
2.11 Terminals and Model Question 

 

Q1. How can technology help to increase the sales in an organisation? 

Q2. What is HRIS and what are its benefits? 

Q3. Explain the role of information technology in marketing. 
 

Q4. How internet has affected customer relationship with companies? 

Q5. List various functions of Human Resource Information Systems. 
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5.1 Objectives 

After reading this chapter, the students will be able to understand following points. 

 To understand Business-to-Business E-commerce 

 Advantages and Key Technologies of B2B E-commerce 

 To understand the concept of e-procurement and coordination between the supply chain 

 To understand how to conduct the online market research 

 To understand the online retailing 

 
 

5.2 BUSINESS-TO-BUSINESS E-COMMERCE(B2B) 

Business-to-Business(B2B) E-commerce provides electronic transactions between business 

operations and their partners in marketing, sales, development, manufacturing and support. It is 

now the biggest portion of the Internet market place and growing very fast. 

The websites which follows B2B business model sells its goods to an transitional buyer 

who in turn sells the goods to the final customer. For example, a merchant places an order from a 

enterprises's website and after receiving the shipment sells the end product to final customer who 

comes to buy the product at merchant's retail outlet. B2B here means the buyer and seller are the 

business groups. 
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Wal-Mart Stores is an example for B2B e-commerce. The major suppliers of Wal-Mart like 

Proctor & Gamble, Johnson and Johnson etc. sell to Wal-Mart Stores electronically. These 

suppliers checks the inventory status in each store online and stock up the required goods in 

time. 

B2B e-commerce reduces inventory and prices that makes it possible for the business 

partners to share significant, accurate, and timely information. This results into the improved 

supply-chain management among business partners. 

5.2.1 Advantages of B2B E-commerce 

1. Instant Purchases - When our business is online, obviously the quick purchases can be done. 

Earlier the business managers fix meetings and appointments for different purchases but now 

everything can be done online. It allows the organization to make frequent purchases with a click 

of mouse. 

 

2. Increased Revenue - When we perform B2B transaction online, it will increase the 

organization's revenue as online ordering is available 24/7. The clients may belong to different 

time zone and their working hours may be different but it will not affect your business because 

now the ordering can be placed anytime. 

3. Expands Company's Presence - When your organization become online it will increase your 

brands awareness. The search engine optimization of organization's site can be improved by 

creating pages that can be indexed by search engine crawlers which increased your presence on 

the internet. 

4. Closer business relationship - When the business is done online, it will create closer 

relationship with your client due to increased number of transactions. When more business 

transactions are done frequently then it build a stronger connection between you and your clients 

without even going face to face interaction. 

5.2.2 Key Technologies 

The key technologies used in B2B e-commerce are as follows: 

 Electronic Data Interchange (EDI) - EDI is the way in which business documents are 

exchanged in a structured and machine processable format between organizations 

 Internet - Internet represents the World Wide Web or we can say that it is a network of 

networks connecting computers across the world. 
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 Intranet - Intranet represents a committed network of computers within a organization. 

 Extranet - It represents a network where the business partners from outside, suppliers, or 

customers can have a access to a portion of enterprise intranet/network in a limited 

format. 

 Back-End Information System Integration – Back-end information systems are database 

management systems particularly used to manage the business data. 

5.2.3 Architectural Models 

The architectural models in B2B e-commerce are as follows: 

 Supplier-oriented Marketplace - This model represents a common marketplace 

provided by a supplier for the use of both the individual customers as well as the business 

users. A supplier offers an e-store for sales promotion. 

 Buyer-oriented marketplace - This model represents a marketplace where the buyer has 

his/her own market place or e-market. He/she invites suppliers to bid on the product's 

catalog. A buyer company opens a bidding site. 

 Intermediary-oriented marketplace - This model represents a marketplace in which an 

intermediary company runs a marketplace and business buyers and sellers can transact 

with each other there.. 

5.3 e-procurement: 

The process of using electronic information and communication technology(ICT) to procure the 

goods and services between business organization is called e-procurement. It is the key 

component of e-commerce and also e-business. 

The concept of e-Procurement came in the beginning of 1980s with the development of 

electronic data interchange (EDI). This allowed customers and suppliers to send and receive 

orders and invoices through secure store and call forward networks. Such EDI systems permits 

businesses to exchange and synchronize data files on products, prices, specifications and 

information about each other‘s locations and trading practices. 

Another development in e-Procurement that arose at a analogous time was the concept of 

e-marketplaces. e-marketplaces, also known as B2B exchanges. These electronic hubs bring 

together suppliers and purchasers in common virtual environments. e-marketplaces are either 

―many-to-many,‖  or "one-to-many". 
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"Many-to-Many e-marketplaces means where many buyers and sellers bring together in a 

particular vertical market. 

"One-to-many" e-marketplace means the place where one major supplier or consumer will 

magnetize many of its trading partners to its e-marketplace. In the past the "one-to-many" e- 

marketplaces are very successful. 

5.4 Supply Chain Coordination: 

Supply Chain: It is defined as the movement of materials to flow from their source to the end 

customer. Supply chain generally includes three functions: 

 Supply of material to a manufacturer 

 manufacturing process 

 Distributor and retailers distribute the finished products to the final customers 

Supply Chain Coordination: It means all the supply chain stages take actions together which 

results greatly in increase of total supply chain profits. Supply Chain coordination requires that 

each stage take into account the impact of its actions on the other stages. 

A lack of coordination happens either due to confliction of objectives of different stages 

of the supply chain or due to the delay and distortion of the information moving between stages. 

Different stages of a supply chain may have conflicting objectives if each stage has a different 

owner. So, each stage tries to maximize its own profits, resulting in actions that often reduce the 

total supply chain profits. 

5.4.1 Bullwhip Effect: 

The bullwhip effect is the ambiguity or uncertainty arises due to distorted information flowing up 

and down the supply chain. Due to this distorted demand information within the supply chain, 

each stage having a different estimate of what demand looks like. The result is a loss of supply 

chain coordination. 

Causes for the bullwhip effect 

Forecasting updating – When the each entity updates a multiple forecast in the chain that leads 

to significant distortions. Every member of the chain updates forecast as per the orders received 

at his/her end and those are not based on the demand raised by the end customer. 

Order batching – Every member of the chain has his own way of thinking in production and 

transportation which  results in planning practices that lead to order batching. 
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Price fluctuations – When there are discounts or price promotions than it results in forward 

buying, causing much distortion. Also if there are regular changes in the price it affect the 

ordering pattern of the buyer. 

Long lead time – If there are long lead times then it increase the planning horizon of other 

partners in the chain. Also due to this, each partner is forced to keep large amounts of safety 

stock. 

Shortage gaming – When there are shortages of goods then the suppliers usually resort to 

rationing, which in turn provides incentives to buyers to inflate orders. 

5.4.2 Effects on Performance due to Lack of Coordination 

Supply chain coordination fails if each stage try to achieve only its local objectives, without 

considering the impact on the complete supply chain. The profits will be less than what could be 

achieved through coordination. The lack of coordination affects the following: 

Manufacturing Cost – It will increases manufacturing cost. Due to Bullwhip effect, the 

manufacturer must satisfy a stream of orders that may be variable than the customer demand. 

Manufacturer can satisfy the increased variability by either making the goods in excess capacity 

or holding excess inventory that increases the manufacturing cost. 

Transportation Cost – It will increase transportation cost. Transportation requirements vary 

significantly over time. To handle the high demand periods surplus transportation capacity needs 

to be maintained. 

Replenishment Lead Time – It increases replenishment lead times. Due to the increase in 

variability, it will be more difficult for the manufacturer to schedule and the available capacity 

and inventory cannot supply the orders coming in. 

Inventory Cost – It increases inventory cost. To manage the increased demand variability, 

manufacturer has to maintain the higher level of inventory. 

Relationships across the Supply Chain – It will make a negative effect on performance at 

every stage and results in the bad relationships between different stages of the supply chain. 

Level of product availability – It will result in low product availability more stock outs will 

happen in the supply chain. Large variations in orders make it worse for the manufacturer to 

supply all distributor and retailer orders in time. 
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Labor cost for shipping and receiving – It increases labor costs. The labor requirements varies 

with orders. So the manufacturers will either make arrangements for the varying labor or carry 

excess labor, both of which increases total labor cost. 

5.4.3 OBSTACLES TO COORDINATION IN A SUPPLY CHAIN 

 Incentive Obstacles 

 Information Processing Obstacles 

 Operational Obstacles 

 Pricing Obstacles 

 Behavioral Obstacles 

Incentive Obstacles 

 When incentives are offered to different stages or participants in a supply chain it will 

lead to increase in variability and lower total supply chain. 

 There are local optimization approach within functions or stages of a supply chain and 

ignorance of overall objectives of an organization. 

 In many organizations, sales force incentives means the amount the sales sells during an 

evaluation period of a month. But the sales generally are measured by a manufacturer by 

the quantity sold to distributors or retailers (sell-in), not the quantity sold to final 

customers (sell-through). 

Information Processing Obstacles 

 When the distortion information of demand moves between different stages of the supply 

chain, it leads to increased variability in orders. 

 When the forecasting is based on orders and not on customer demand then it will 

magnifies demand fluctuations moving up the supply chain from retailer to manufacturer 

 When there is lack of information sharing between stages of the supply chain, it will 

magnifies the bullwhip effect. 

Operational Obstacles 

 Ordering in Large Lots – When a firm places orders much larger than the demand arises, 

there will be variability of orders magnified up in the supply chain. Firms may order in 

large quantity because of significant fixed cost associated with placing, receiving or 

transporting an order and supplier offers discounts based on quantity. 

 Large replenishment lead times 
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 Rationing and shortage gaming - when a high demand product is in short supply then the 

rationing schemes that allocate limited production in proportion to the orders placed by 

retailers lead to a magnification of the bullwhip effect. 

Pricing Obstacles 

 Lot-size based quantity decisions- When discount is based on quantity it will increase the 

the quantity of orders placed within the supply chain and thus magnify the bullwhip 

effect. 

 Price fluctuations - The wholesaler or retailers purchases in large quantity during the 

trade promotions and other short- term discounts offered by a manufacturer to cover 

demand during future periods that results in forward buying. Large orders during the 

promotion period followed by very small orders increases the bullwhip effect. 

Behavioral Obstacles 

 When all the stage of the supply chain views its actions locally without thinking the 

impact of that on other stages. 

 When the different stages react to the present local situation instead of trying to identify 

the root causes. 

 After the local analysis, different stages blame each other for the variations which 

increases gap in the coordination. 

 No stage want to learns from its actions over a period of time because the most 

significant consequences of the actions of any one stage occur elsewhere, result in a 

vicious cycle of actions and blame. 

 When there is lack of trust it will results in opportunism, duplication of effort, and lack 

of information sharing. 

5.4.4 MANAGERIAL LEVERS TO ACHIEVE COORDINATION 

 Aligning Goals and Incentives 

 Improving Information Accuracy 

 Improving Operational Performance 

 Designing Pricing Strategies to Stabilize Orders 

 Building Strategic Partnerships and Trust 

Aligning Goals and Incentives 
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 There should be some alignment in the incentives for all the participant to do the things 

that will maximize total supply chain profits. 

 Align incentives across functions : To ensure that the objective of all the stages must be 

aligned with the firm‘s overall objective. All facility, transportation and inventory 

decisions should be evaluated based on their effect on profitability. 

 Pricing for coordination : A manufacturer can use quantity based discounts to achieve 

coordination for commodity products if the manufacturer has large fixed costs associated 

with that. Manufacturers can give buy-back, revenue sharing facility to retailers to 

maximize supply chain profits. 

 Alter sales force incentives from sell-in (to the retailer) to sell-through(by the retailer): 

Managers should associate the incentives for the sales force to sell the units to the end 

customer (sell through) and not to the retailer (sell in). 

Improving Information Accuracy 

 Sharing point of sale data: Each stage of the supply chain generally uses orders to 

forecast future demand. If retailers share POS data with other supply chain stages then 

all stages can forecast future demand based on customer demand. 

 Collaborative forecasting and planning: After sharing the point-of-sale data, the different 

stages of the supply chain must forecast and plan jointly to achieve the complete 

coordination. 

 Single stage control of replenishment: Need to design a supply chain in which a single 

stage controls replenishment decisions for the entire supply chain should be taken to 

diminish the bullwhip effect.. 

Improving Operational Performance 

 Reducing replenishment lead time: By reducing the replenishment lead time, the 

uncertainty of demand during the lead time can be decreased. Especially it will be 

beneficial for seasonal items because it allows multiple orders to be placed in the season 

with a significant increase in the accuracy of the forecast. 

 Reducing lot sizes: A reduction in the sizes of lot can decreases the amount of 

fluctuation and it decrease the bullwhip effect. 



Page 89 of 187  

 Rationing based on past sales and sharing information to limit gaming: Managers can 

design rationing schemes that discourage retailers from artificially inflating their orders 

in the case of a shortage. 

Designing Pricing Strategies to Stabilize Orders 

 By encouraging retailers to order in smaller quantities and it will reduce forward buying 

 Moving from lot size-based to volume-based quantity discounts: The incentives or 

discounts should be given on the purchases that are made during the specified time and 

not for the orders given in lots. 

 Stabilizing pricing: Managers can eliminate the bullwhip effect by removing promotions 

This will eliminate the forward buying by retailers and results in orders that match 

customer demand. 

Building Strategic Partnerships and Trust: When the accurate information will be shared and 

that is trusted by every stage results in a better matching of supply and demand throughout a 

supply chain and reduces the cost. 

 
5.5 Online Market Research 

The businesses may be conducting online market research for the betterment of business—but 

they may not know it. There are most common tools which are easy to use. Web searches, online 

questionnaires, customer feedback forms can help you gather information about your market, 

your customers, and your future business prospects. 

The arrival of the Internet has given small businesses with a wealth of additional 

resources which they can use either   to conduct free or low-cost market research. The following 

is the list of different types of tools to conduct online market research. 

5.5.1 Online Market Research Tools 

The following techniques can be used to collect market information with the click of mouse. 

 Keyword Search. We all know how to do a simple search on the Web using search 

engines such as Google or any other search engine. Just move a step farther by searching 

for "keywords" that generally people would use to find your type of products or services 

online. Keyword searches can remind you of some other aspects of product that you 

might not have considered earlier. Secondly, these services will also give you a rough 

estimate of how many existing sites already use that phrase.
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 Competitor Links. A traditional search engine can also help you check out your 

competitors, their cost, and their offerings if any. There may be possibility that your 

competitor is promoting a product or service similar to you and you may get publicity 

because you have a new or better product.

 Read Blogs. Generally the blogs are updated much more regularly than traditional 

websites and, therefore, they can be another way to know the public opinion about any 

specific product or services. By search blogs by using blog-specific search engines acn 

really help.

 Conduct Online Surveys. Another way to know public opinion is by conducting online 

surveys. Online surveys are a low-cost idea to conduct the market research about whether 

an idea or a product will be appealing to consumers or not.

 
5.5.2 Research Tools and Techniques 

There are a range of types of market research tools both offline and online which are used by 

many large businesses and can be available everyone. 

The major categories are as follows: 

1. Audience Research. Audience research is focussed at discovering who is listening, 

watching, or reading radio, TV, and print media respectively. Such kind of studies are 

performed to profile the audience and to determine the popularity of the medium. 

2. Product Research. Product tests are directly related to use of the product. For example the 

tasting tests used to pick the most popular flavors and consumer tests of vehicle or device 

prototypes to uncover problematical features or designs. 

3. Brand Analysis. Brand research aims at identifying the reasons for brand loyalty who are 

using this brand. 

4. Psychological Profiling. Psychological profiling aims at preparing profiles of customers by 

temperament, lifestyle, income, and other factors which can affect sales. 

5. Scanner Research. Scanner research uses checkout counter scans of transactions to develop 

patterns for all manner of end users to help users track the success of coupons and to 

establish linkages between products. 
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6. Database Research. This is form of research that try to exploit all kinds of data on 

customers. For example the purchase records   can reveal the buying habits of different 

income groups. 

7. Post-sale or Consumer Satisfaction Research. We all are familiar with the Post-consumer 

surveys as many consumers are called from telephone after having a car serviced. Such 

surveys are planned to determine if the customer was satisfied and also to show that the 

additional attention is given to the customer to build good will. 

8. Writing Online Questionnaires. When the Web-based surveys are conducted, small 

businesses should keep in mind a few simple but important rules: 

 The Shorter the Better. Don't put long questionnaires and limit yourself to 25 questions 

so that it takes five to seven minutes to finish. If surveys are much longer, people will not 

fill accurate information and the next time you send them a survey they won't even open 

it. Try to make the first page simple, present answer options in multiple columns or a 

drop-down box, and put a status bar at the top of each question page so respondents know 

how close they are to being finished.

 Avoid Open-Ended Questions. It is wise not to include a lot of open-ended questions as 

generally people do not like to type out the answers. Close-ended questions they can click 

on a button. Companies can design the close-ended questions in such a way that in-depth 

analysis can be extracted as in open-ended questions by providing rankings scales.

 Be Persistent. You must take permission to conduct the survey before sending the 

survey.

 Be Patient. When the businesses decide and conduct a survey then get impatient when 

they can't get the results right away. So patience is required.

5.6 Online Retailing 

Due to increase in the impact of internet. improvement in the security measures, convenience and 

number of choices attracted more and more consumers to shop online. In fact, the past trends and 

surveys shows that online shopping is gaining more popularity due to these factors. Online 

shopping is an easy way for comparison of different products on the basis of their features and 

specifications without going from shop to shop 

The two important models of e-retailing marketplace are 

 Online retailing 
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 Online Auctions 

5.7 Summary 

These are the trends in the e-commerce which were earlier not possible. It not only changes how 

to do business but also adds new trends of doing business. B2B commerce is revolution in the e- 

commerce and provides a platform to the businesses where this world become a global village. 

Internet has changed the way of retailing and marketing the products. 

5.8 Answer to check your progress 

1. The supply chain concept originated in what discipline? 

a) marketing 

b) operations 

c) logistics 

d) production 

2. Which of the following are not key attributes of supply chain management? 

a) inventory control 

b) leveraging technology 

c) customer power 

d) all are key attributes 

3. Which of the following are advantages normally associated with B2B e-commerce? 

a) shorter cycle times 

b) reduction in costs 

c) reaches wider audiences 

d) all of the above 

Which form of e-commerce currently accounts for about 97% of all e-commerce 

revenues? 

a) B2B 

b) B2C 

c) C2B 

D) C2C 
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5.10 Model Question Paper 

1. Explain the B2B model of E-commerce. 

2. Discuss the advantages and key technologies of E-commerce. 

3. Explain the concept of e-procurement. 

4. What do you mean by Supply chain Coordination. Explain 

5. What is Bullwhip effect. Explain its causes. 

6. What are the effects of lack of coordination in the supply chain on the performance of the 

company. 

7. Discuss the online Marker Research in detail. 
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6.1 Objectives 

 
After studying this chapter the students will be aware about the most revolutionary handheld 

technology-m commerce. The objective of this chapter is to familiarize the students with the 

meaning and concept of mobile commerce. The advantages and applications of technology and 

the future scope will also be discussed. 

. 

6.2 Introduction 

Evolution of computer was considered the great technical achievement where a machine was 

made to work with tremendous speed, accuracy and memory. But this was not end rather it was 

beginning of miraculous technological inventions. Internet greatly enhanced the services 

computer can provide. The bulky computer system were replaced with the easy to carry compact 

laptops then came the device which completely turned the way we can use internet is the mobile 

phones. 

Mobile phones are portable, easy to carry cellular system which can be used without physical 

connection with the network. Mobile commerce or m-commerce is the technology that allows us 

to use our mobile phones for various commercial purposes like buying and selling of goods and 

services. It also eliminates the need of finding plug-ins to activate internet. 

The phrase mobile commerce was originally coined in 1997 by Kevin Duffey at the launch of the 

Global Mobile Commerce Forum, to mean "the delivery of electronic commerce capabilities 

directly into the consumer‘s hand, anywhere, via wireless technology. 

DEFINITION 

 
"Mobile Commerce is the use of information technologies and communication technologies for 

the purpose of mobile integration of different value chains an business processes, and for the 

purpose of management of business relationships.” 

- Webagency, 2001 

 
Mobile Commerce Development has become a crucial element for success today. Mobile 

websites and m-commerce apps provide customers with the ability to shop anytime, and 

anywhere. It‘s so easy to use that most people prefer to use m-commerce instead of e-commerce. 
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Customers enjoy the convenience of doing shopping, business transactions etc in handy way on 

their mobiles whereas it brings equal advantage to entrepreneur‘s to enhance their business. 

Mobile commerce apps are not mere presence of business online, but opportunities for business 

expansion that includes tapping the huge mobile user base and getting an edge over the 

competition. 

Mobile commerce includes usage of mobile phones and other personal digital assistants (PDAs) 

which use the technology based on the Wireless Application Protocol (WAP). 

 
6.3 APPLICATIONS OF MOBILE COMMERCE 

Following are important areas of application of m-commerce: 

 
Mobile ticketing 

Mobile ticketing is blessing for users provided by m-commerce. Now booking a ticket is just a 

click away. Users can book their air tickets, train tickets and movie tickets etc by using either 

simple applications or by accessing WAP portals of various Travel agents or direct service 

providers. Users are then able to use these tickets by showing their phones at the venue. This 

saves lots of time as user is not required to visit booking station and then wait in long queue. 

Apart from convenient booking it provides advantage of knowing the status of tickets and easy 

cancellation as well. 

 
Mobile vouchers, coupons and loyalty cards 

Mobile ticketing technology can also be used for the distribution of vouchers, coupons and 

loyalty cards. The voucher, coupon, or loyalty card is represented by a virtual token that is sent 

to the mobile phone. These can be redeemed for shopping thus provides good gifting option and 

also helps companies to promote their sales and develop bonding with their customers. 

 
Content purchase and delivery 

Currently, mobile content purchase and delivery mainly consists of the sale of ring-tones, 

wallpapers, and games for mobile phones. The convergence of mobile phones, mp3 players and 

video players into a single device will result in an increase in the purchase and delivery of full- 

length music tracks and video. Download speeds, if increased to 4G levels, will make it possible 

to buy a movie on a mobile device in a couple of seconds, while on the go. 

http://searchmobilecomputing.techtarget.com/definition/WAP
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Location-based services 

Mobile commerce proved to be quite useful in providing location based services. Using the 

current location of user it provides services like local maps, offers, weather etc. It‘s very useful 

for people who keep travelling to new places. It acts as local guide providing reliable information 

about the place. 

 

 
Information services 

A wide variety of information services can be delivered to mobile phone users in much the same 

way as it is delivered to PCs. These services include: 

 

 news services 

 stock data 

 sports results 

 financial records 

 traffic data and information 

 
Mobile Banking 

 
Banks and other financial institutions are exploring the use of mobile commerce to allow their 

customers to not only access account information, but also make transactions, e.g. purchasing 

stocks, remitting money, via mobile phones and other mobile equipment. This service is often 

referred to as Mobile Banking or M-Banking. M-Banking is one of the biggest advantages of m- 

commerce for customers; they can use banking services anytime, anywhere even when the banks 

are closed. 

 
Mobile brokerage 

Stock market services offered via mobile devices have also become more popular and are known 

as Mobile Brokerage. Irrespective of their physical locations people can now act timely as per 

current market scenario which is available on their phones. 

 

Purchasing 
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Mobile purchase allows customers to shop online at any time in any location. Customers can 

browse and order products while using a cheap, secure payment method. Instead of using paper 

catalogues, retailers can send customers a list of products that the customer would be interested 

in, directly to their mobile device or consumers can visit a mobile version of a retailer‘s 

ecommerce site. Additionally, retailers will also be able to track customers at all times and notify 

them of discounts at local stores that the customer would be interested in. 

 
Mobile marketing and advertising 

Mobile marketing is an emerging concept, but the speed with which it's growing its roots is 

remarkable. Mobile marketing is highly responsive sort of marketing campaign. And almost all 

brands are getting higher campaign response rates. Corporations are now using m-commerce to 

expand everything from services to marketing and advertisement. Although there are currently 

very few regulations on the use and abuses of mobile commerce, this will change in the next few 

years. With the increased use of m-commerce comes increased security. Cell phone companies 

are now spending more money to protect their customers and their information from online 

intrusions and hackers. 

 

 
6.4 MOBILE COMMERCE ADVANTAGES AND DISADVANTAGES 

 

Following are advantages of m-commerce: 

 

1. Instant Contact: M-commerce provides features like live chat, one click call, toll free calling 

etc which makes it easier for customers to contact vendor with ease. Now the trend of mailing 

and then waiting for response is not the scenario. 

2. Consumer deals: The competition among various businessmen gives advantage to 

consumers. As more users use m-commerce, there are lots of companies use m-commerce site to 

reach them by giving different and better deals in comparison of their competitor. 

3. Savings: As companies reach the consumers directly through m-commerce so the goods reach 

the consumers at cheaper prices. Moreover as consumers are not required to visit stores 

physically so it saves both time and money. 

4. Convenience: The small size and ease of use of mobile receivers, coupled with freedom from 

problems caused by infrastructure, makes for a higher degree of user convenience. M-commerce 

allows consumers to shop while travelling, waiting for someone. 
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5. E Wallet: Analysts believe that use of easy many is one of the reasons for success of m- 

commerce. Mobile phones work as electronic wallets for easy payments. 

6. Diversity: With m-commerce consumer is not limited to local stores to choose product from 

instead mobile commerce has made international products available in hand of consumers. 

7. Ease of use: Mobile commerce is very use to use. Consumer don‘t need any skill to use m- 

commerce not even need to use any browsers as it is in case of e-commerce thus making it 

possible for everyone to use. 

8. Customization: Retailers can use it as per their convenience. The application for m- 

commerce can be developed as per need keeping in mind the target users. So retailers can get 

application developed the way it will benefit their business. 

 
Disadvantages of mobile commerce 

Every coin has two sides so do m-commerce. M-commerce is a young service which is still 

growing rapidly. Though not much but m-commerce do have few disadvantages too which are 

listed below: 

1. Small Display: Mobile phones have small screens as compared to laptops and personal 

computers therefore the counter provided by m commerce for shopping is not as clear as 

provided by e-commerce. Presently, mobile commerce applications have particular restrictions 

associated to graphics & functionalities because it is a new technology. 

 
2. Internet Speed: The speed of internet is one of the driving forces for this new technology. If 

users don‘t have access to reasonable speed of internet then whole process can turn out to be 

wastage of time. 

3. Hacking: This is one of the major areas of concern using m-commerce. Information 

transferred through wireless networks have high risk of getting hacked and misused. 

4. Cost of setup: Developing the m-commerce software can be expensive so not all retails opt 

for this. 
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Mobile commerce Applications 

 
Purchasing Stocks Banking Marketing Advertisement Auctions Travel 

Online Publishing 

6.5 MOBILE COMMERCE FRAMEWORK 
 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

Infrastructure 

I II III IV V 

Common Business Messaging and Multimedia Network Interfacing 

Services Information Content and Infrastructure Infrastructure 

Infrastructure Distribution Network (Telecom, Cable (To: Databases, 

(security smart Infrastructure (HTML, JAVA, TV, Internet, Customers and 

cards/authentication, ( EDI, e-mail, WWW) Intranet, Applications) 

e payment, catalog) HTTP)  Extranet.  

   Wireless )  

 

Management 

People Public Policy Technical 

Standards 
Organizations 

Buyers, Sellers, Taxes, Legal and For documents, Competitors, Partners, 

Intermediaries, Privacy Issues Security and Network Associations, 

Management  protocols, Payments Government Services 
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6.6 INTERNET ADVERTISING 

 

The Internet is a global network connecting millions of computers. More than 100 countries are 

linked into exchanges of data, news and opinions. Internet is the place where we can target 

millions of users easily. It provides the best platform for advertisement. Internet advertising is a 

form of marketing and advertising which uses the Internet to deliver promotional marketing 

messages to consumers. It includes email marketing, search engine marketing (SEM), social 

media marketing, many types of display advertising (including web banner advertising), and 

mobile advertising. Internet advertising is one of the most effective ways for businesses of all 

sizes to expand their reach, find new customers, and diversify their revenue streams. 

 

A major advantage of online advertising is the quick promotion of product information without 

geographical boundary limits. A major challenge is the evolving field of interactive advertising, 

which poses new challenges for online advertisers. 

 
Online advertisements are purchased through one of the following common vehicles: 

 
 Cost per Thousand (CPM): Advertisers pay when their messages are exposed to specific 

audiences. 

 Cost per Click (CPC): Advertisers pay every time a user clicks on their ads. 

 Cost per Action (CPA): Advertisers only pay when a specific action (generally a 

purchase) is performed. 

 

Examples of online advertising include banner ads, search engine results pages, social 

networking ads, email spam, online classified ads, pop-ups, contextual ads and spyware. 

 
6.6 SUMMARY 

 
As m-commerce applications and wireless devices are evolving rapidly, one will take forward 

the other one towards empowering innovation, versatility and power in them. There are number 

of business opportunities and grand challenges provided by wireless technology for realizing the 

strength of m-commerce in this internet era. Present usage of m-commerce is considered to be 

the tip of iceberg. This technology is growing rapidly providing convenience to users. Users 

welcome services and accept the changes whole heartedly giving scope to mobile commerce to 

grow. It is expected that future of mobile commerce is bright in coming time. 

https://en.wikipedia.org/wiki/Promotion_%28marketing%29
https://en.wikipedia.org/wiki/Search_engine_marketing
https://en.wikipedia.org/wiki/Display_advertising
https://en.wikipedia.org/wiki/Web_banner
https://en.wikipedia.org/wiki/Mobile_advertising
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6.7 Glossary 

 

 E-commerce (electronic commerce or EC) is the buying and selling of goods and 

services, or the transmitting of funds or data, over an electronic network, primarily the 

Internet.

 Cost Per Click (CPC) is the amount paid by an advertiser to a search engine or other 

Internet publishers for every time an advertisement viewer makes a click on a link in an 

advertisement. This click transfers the viewer to the advertiser‘s web site.

 E-commerce (electronic commerce or EC) is the buying and selling of goods and 

services, or the transmitting of funds or data, over an electronic network, primarily the 

Internet.

 M-commerce (mobile commerce) is the buying and selling of goods and services 

through wireless handheld devices such as cellular telephone and personal digital 

assistants (PDAs).

 Mobile Marketing any marketing activity conducted through a ubiquitous network to 

which consumers are constantly connected using a personal mobile device".

 Wireless Application Protocol (WAP) is a technical standard for accessing information 

over a mobile wireless network. A WAP browser is a web browser for mobile devices 

such as mobile phones that uses the protocol.




6.8 Answer to check your progress 

 
1. In B2B mobile commerce, the business is conducted between 

a. two companies over the internet b. two persons over internet 

c. business to government over internet d. none of the above 

Answer: a 

2. Mobile commerce refers to the use of internet and the web to transact 

a. sales b. business 

c. purchase d. documents 

Answer: b 
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3. Emerging technologies will continue to influence consumer behavior in future by enabling 

a. Newspapers b. Measurement 

c. Consumer centricity d. Relevance filtering 

Answer: c 

4. Which of the following is not a standard in online advertising? 

a. Dynamic banners b. Signal 

c. Banners d. Referrals links 

Answer: b 

5. Which of the following are online advertising methods through which advertisers attempt to 

drive traffic to internet sites? 

a. CPM b. CPC 

c. SEM d. SEO 

Answer: d 

6. Paid advertising based on per click model is called 

a. Sponsored search engine advertising b. Source advertising 

c. Feedback d. Search engine optimizing 

Answer: a 

7. Internet advertising has weaknesses because 

a. It is not easy to track b. It does not deliver good targeted reach 

c. It is not emotive d. It can be intrusive 

Answer: c 
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6.9 References / Suggested Readings 
 

https://en.wikipedia.org/wiki/Mobile_commerce 
 

. 
 

6.10 Terminals and Model Question 
 

Q1. Discuss various applications of mobile commerce. 
 

Q2. What is difference between e-commerce and m-commerce? 

Q3. What are unique features of m-commerce? Discuss 

Q4. What are key dimensions of mobile commerce security? 
 

Q5. List various advantages and disadvantages of mobile commerce. 

https://en.wikipedia.org/wiki/Mobile_commerce
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7. Word Processing with Microsoft Word 
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7.0 Objectives 

After reading this chapter, the student will be able to understand 
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 How to create documents using the word.

 How to do editing / formatting the document files

 How to use advanced features of MS Word

7.1 Introduction to MSWord 

Microsoft Word is a feature packedword processor and was previously considered as the 

main program in Microsoft office. Its proprietary DOC format is considered as a standard, 

although new MS Word can also use a new XML-based optimized format called .DOCX. It is 

used to create and print text documents that might otherwise be prepared on a typewriter. The 

key advantage of a word processor is its ability to make changes easily, such as correcting 

spelling, adding, deleting, formatting and relocating text. Once created, the document can be 

printed quickly and accurately saved for later modifications. In fact, the document that you 

are reading now was created using only a small amount of the many features available in 

Microsoft Word. Most Microsoft programs allow a minimum of 3 different ways to 

accomplish any single task. It isn‗t necessary for you to learn all three. Simply pick the 

method, which best fits you. 

7.2 Opening Microsoft Word 

Before you get started with Microsoft Word (commonly referred to as MS Word), you will 

need to locate and open it on the computer. It may be on your desktop having its icon as 

shortcut. There are following steps to start MS-word. 

a) Click on Start button of Windows operating system 

b) Go to ‗All Programs‗ 

c) You will see the folder named ‗Microsoft Office‗ 

d) Click on the folder and then click on Microsoft Word 

http://en.wikipedia.org/wiki/Word_processor
http://en.wikipedia.org/wiki/DOC_(computing)
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7.3 Creating a New Document File 

In this activity you create a document file and save it by assigning a name of your choice. If 

you want to create a new document then the steps are as follows: 

 Start Microsoft word application from the Programs folder

 The application by default opens with a blank sheet.

 The user can type the content on the blank page.

The user can open a new Microsoft word file using Ctrl+N command. He can also open the 

file using the following steps: 

 Click on MSOffice Button located on the top left of the program

 Click on ‗New‗ document link

 The new window opens with various options. Click on ‗Create‗ and the new blank 

document opens.
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The usage of MS Word is not limited to typing documents only. It is also used for preparing 

agendas, business cards, brochures etc with predefined templates. The user can also design 

his or her own templates for repeated jobs. 

7.3.1 Saving the document 

Once the document is created, it needs to be stored for future reference or editing or use. To 

save the document, click on MS Office button located on the top left of the program and click 

‗Save‗ or ‗Save As‗. The new window asks for naming the file to be saved. The file can be 

saved in various formats as shown in the figures below: 
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Once the document is saved and edited later, the user should click ‗Save‗ option to save the 

document after its editing. The user should avoid the use of ‗Save As‗option otherwise the 

program will create a new file every time the option is clicked. The program saves the file 
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with .docx file extension. But the user can change it by choosing the required extension from 

the drop down list of file extensions. 

7.3.2 Editing the document 

Once the document is written and saved, it can be edited. The following are some of the 

editing functions available in the MS Word application. 

 

 

 
Cut / Copy & Paste: This ‗Cut‗ function is used to move the text from one place to another 

place within the file or from one file to another file. The ‗Copy‗ function is used to create the 

copy of the text and put it in another place. This avoids the time of re-typing the text and the 

settings and formatting of the text also remains unchanged. The function is used as under: 

 

 Select the text which is to be cut or copied.

 Once the text is selected, the icons of ‗Cut‗ and ‗Copy‗ will get activate/enable. Click 

on the relevant icon and move to the place where text is to be pasted.

 Left click the place for placing the cursor where text is to be pasted.

 Now click on ‗Paste‗ icon of the MS Word and you will see the text gets pasted on the 

new place.

 
However, shortcut keys can also be used for these functions. Ctrl+X is shortcut key for 

cut function, Ctrl+C is the copy function and Ctrl +P is the paste function. 

 

  Make  your selection, press the right mouse button and select  ―Copy‖, position  your 

cursor to where you want your copy to appear, and then press the right mouse button 

and select ―Paste‖.
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In more than one place, replace the words Your Name with your full name. 

Undo, Redo and Repeat: Whenever you make a mistake, such as accidentally deleting or 

overwriting something, you can easily reverse it with Word's Undo feature. Sometimes, the 

text is placed at wrong place or required formatting is possibly not done. So using ‗Undo‗ 

function (shortcut key Ctrl+Z) unedit your document which you have done and will move the 

function backwards and ‗Redo‗ function (shortcut key Ctrl+Y) will move the recent step the 

user has done in the program. MS Word allows to undo the last 99 edits done to your 

document. Redo, allows you to redo up to 99 undos. But once the document is saved and 

closed, these edits will not be available next time the file is opened. Undos and Redos start 

from 1 every time the document is opened. 

 

The Repeat feature enables you to repeat an operation such as typing, formatting, inserting, 

and so on. The Repeat button looks like a U-turn arrow, and appears in place of the Redo 

button on the toolbar, when available 

 

Delete the Text: If you want to delete portions of your document, you can simply highlight 

the portion you would like to delete and press the delete key; unless you‗ve changed Word 

options, Word will automatically correct the spacing at the point of the deletion. To delete 

individual elements of your document, you have two options: The delete key will delete 

objects to the right of the cursor / insertion point, while the backspace key will delete objects 

to the left of the cursor / insertion point. 

Activity A 
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7.3.3 Formatting the document 

Formatting is one of the most important steps in making the document presentable. Various 

formatting functions are available in MS Word program. 

Page Setup and Margin Formatting: The screenshot below displays the menu path to 

change the margins in a paper. All margins, by default, are set at 1 inch. 

1. From the menu tab at the top of Word, select Page Layout. 

2. In the Page Layout menu, the margins button will allow you to change the margins to the 

correct format. 

3. Select Normal to set all margins to one inch or use ‗Custom Margins‗ to customize your 

margins according to the requirements. 
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Formatting Font 

The screenshot below displays the menu path to change the font. Use a traditional font such 

as 

Times New Roman or Courier in 12-point size or any other size. 

1. Select the Home tab. 

2. From the Font menu, you may adjust the font, style, and size to the correct format. 
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Formatting Spacing 

The standard spacing format for a paper is double-spacing. Double-space the entire 

document, including the reference page. The screenshot below displays the menu path to 

change the spacing format to double. 

1. Select the Home tab. 

2. From the Paragraph menu, you may adjust the line spacing from the Line Spacing 

dropdown menu. 
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Centering or Justifying Text 

The screenshot below is an example of text that is centered and that is not centered. In order 

to 

center text highlight the text that requires centering and select the icon in the formatting 

toolbar 

as shown. 

1. Select the Home tab. 

2. Highlight the text to be centered. 

3. Click the button to center the text on the Paragraph toolbar. 
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The Justify command is used to justify the text at the both margins. The rows of the text will 

be even at the right margin as the word program automatically adjusts the space in between 

the words. 

Page Headers/Footers and Page Numbers 

Page headers/footers are used to mark each page with topic name or file name. Identify each 

page with the first two or three words of the title and with the page number placed on the 

upper right hand corner of the page. Use five spaces between the title and the page number. 

Do not use your name to identify each page. Footers are used to name title on each page at 

the bottom of the page. Be sure the font type and size are the same as that used in the 

document. 

 

1. Click on the Insert tab. 

2. Click on the Header tab. 
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3. Click on the Blankheader tab from the drop-down menu. This will put the cursor inside 

the header. 

4. Click on the Page Numbertab. 

5. Place the cursor on the drop-down menu over Top of Page to bring up another drop-down 

menu. 

6. Click on Plain Number 3 on the drop-down menu (the third choice). This will place a page 

number inside the header at the right margin. 

7. Type the portion of the title to go in the header and add five spaces. Your header is 

complete. 

8. Click on Close Header and Footer on the far right. 

 
 

Format Painter: Once you get formata section of text to look the way you want it to, you can 

copy all of its attributes to another section of text using the ―Format Painter‖ tool. This tool 

looks like a paint brush and is located under the Clipboard option of Home Tab. It reduces the 

repeating document formatting and saves time and energy. 

 

 
Styles: Like the ―Format Painter‖, ―Styles‖ allow you to pass the attributes of one section of 

text  to  another.  Unique  to  ―Styles‖,  you  can  create  format  templates  such  as  ―normal‖  or 

―headline‖ to apply to the appropriate sections  of  your document.  Should  you  change  your 

mind about what a ―headline‖ looks like, simply modify the settings for that ―style‖ and all of 

the sections of text  which were formatted as  ―headline‖ will automatically take on the new 

settings. 
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7.4 Review the Document 
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Turn on or off the red lines that appear under misspelled words 

 
1. On the top-left corner, click the Microsoft Office Button.  

2. At the bottom of the menu, click Word Options. 

3. In the Word Options dialog box that appears, click Proofing. 

4. In the Exceptions for list, click the currently-open document name. 

5. Select or clear the hide spelling errors in this document only and hide grammar errors 

in this document only check boxes. (To turn on or off automatic spelling and grammar 

checking for all documents, select All New Documents in the Exceptions for list). 

6. Click OK. 

7. Return to your document. When lines appear under words, right-click the word, and 

then make selections from the corrections menu. 

Check spelling and grammar 

 
1. Open a Word document that needs to be checked. 

2. On the review tab, in the proofing group, click Spelling & Grammar. 

3. In the Spelling and Grammar dialog box appears, and the first suggested correction is 

highlighted. 

4. Use the following buttons to check your spelling and grammar: 
 

 

Ignore Once:Ignore this word once, but check it again. 
Ignore All : Ignore this word throughout 

the document. 

Ignore Rule: Ignore this rule throughout the 

document. 

 

Next Sentence: Check the next sentence. 

Add to Dictionary: Include this word in the program's 

dictionary. 

Change: Use the suggested word in the 

Suggestions pane. 

 

Explain: See an explanation for the suggested change. 
Change All: Use the suggested word to 

change all instances of this word. 

Change All: Use the suggested word to change all 

instances of this word. 

AutoCorrect: Use the first suggested 

word each time you click Auto Correct. 

Check grammar: Select to correct the grammar in this 

document. 

Undo: Undo the change. Continue clicking 

for previous corrections. 
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Options: The Options dialog box appears. Select how 

the program corrects spelling and grammar for all 

documents. 

 

 

Recheck the words and grammar that you previously checked and chose to ignore 

 
1. Open the document that you want to recheck. 

2. On the top-left corner, click the Microsoft Office Button . 

3. At the bottom of the menu, click Word Options. 

4. In the Word Options dialog box that appears, click Proofing. 

5. Under Correcting spelling and grammar in Word, click Recheck Document. 

6. To recheck the spelling and grammar, click Yes when you see the following message: 

This operation resets the spelling checker and the grammar checker so that Word will 

recheck words and grammar you previously checked and chose to ignore. Do you 

want to continue? 

7. In the Word Options dialog box, click OK to go back to the document. 

8. On the Review tab, in the Proofing group, click Spelling & Grammar. 
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7.5 Printing the Document File 

It‗s really simple to configure printing options in Microsoft Word 2007. We can print an open 

document by going to office button –> Print. There are three options in Print Menu. 
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1- Print – If you select the first option, which is print, it will give you the print dialog where 

you can configure different options. We will see that in detail later. 

2- Quick Print – If you select quick print, it will just use the default settings and will print 

the document directly. It will not ask you of any configuration settings. So if you have 

configured your printing settings, then you can easily print using Quick Print option as it will 

be faster. 

3- Print Preview – Print preview will give you the view of how the document will look 

like after it has been printed on the paper. So by previewing your document, you can 

make sure everything is according to what you‗re expecting. 
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In print preview, you can change the margins and orientation of the page to be printed. And 

you can select the paper being used for printing i.e. whether you‗re using A4 size paper or a 

letter or an envelope etc. 

 
7.6 Mail Merge 

Mail merge is a software function describing the production of multiple (and potentially large 

numbers of) documents from a single template form and a structured data source. The letter 

may be sent out to many "recipients" with small changes, such as a change of address or a 

change in the greeting line. MS Word Mail Merge allows a user to send letters or documents 

to many people simultaneously; users simply create one document that contains the 

information that will be the same in each version, and then add placeholders for the 

information that will be unique to each version. The following steps are followed for sending 

multiple mails at a time. 

 
 Click Start Mail Merge on the Mailings ribbon and select the type of document you‗d 

like to create.

 Select document type

 
1. In the Mail Merge task pane, click Letters. This will allow you to send letters to 

a group of people and personalize the results of the letter that each person 

receives. 

2. Click Next: Starting document. 

 
Select the starting document 

 
1. Click one of the following options: 

o Use the current document: Use the currently open document as your main 

document. 

o Start from a template: Select one of the ready-to-use mail merge templates. 

o Start from existing document: Open an existing document to use as your mail 

merge main document. 

2. In the Mail Merge task pane, click Next: Select recipients. 

http://en.wikipedia.org/wiki/Software
http://en.wikipedia.org/wiki/Structured_data
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Select recipients 

When you open or create a data source by using the Mail Merge Wizard, you are telling 

Word to use a specific set of variable information for your merge. Use one of the following 

methods to attach the main document to the data source. 

A) Use an existing data source 

To use an existing data source, follow these steps: 

 
1. In the Mail Merge task pane, click Use an existing list. 

2. In the Use an existing list section, click Browse. 

3. In the Select Data Source dialog box, select the file that contains the variable 

information that you want to use, and then click Open. Word displays the Mail 

Merge Recipients dialog box. You can sort and edit your data if you want to. 

4. Click OK to return to the main document. 

5. Save the main document. When you save the main document at this point, you are 

also saving the data source and attaching the data source to the main document. 

6. Type the name that you want to give to your main document, and then click Save. 
 

 

 
 

 

 

 
 

B) Create a database of names and addresses 

To create a new database, follow these steps: 

 
1. In the Mail Merge task pane, click Next: Select Recipients. 
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2. Click Type a new list. 

3. Click Create. The New Address List dialog box appears. In this dialog box, enter the 

address information for each record. If there is no information for a particular field, 

leave the box blank. By default, Word skips blank fields. Therefore, the merge is not 

affected if blank entries are in the data form. The set of information in each form 

makes up one data record. 

4. After you type the information for a record, click New Entry to move to the next 

record. 

To delete a record, click Delete Entry. To search for a specific record, click Find 

Entry. To customize your list, click Customize. In the Customize Address List dialog 

box, you can add, delete, rename, and reorder the merge fields. 

5. In the New Address List dialog box, click OK. In the Save Address List dialog box, 

type the name that you want to give to your data source in the File name box, and then 

click Save. 

6. In the Mail Merge Recipients dialog box, make any changes that you want, and then 

click OK. 

7. Click Next: Write your letter to finish setting up your letter. 

8. Save the main document. When you save the main document at this point, you are 

also saving the data source and attaching the data source to the main document. 

9. Type the name that you want to give to your main document, and then click Save. 
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7.7 Macros 

In Microsoft Office Word, you can automate frequently used tasks by creating and running 

macros. A macro is a series of commands and instructions that you group together as a single 

command to accomplish a task automatically. The typical uses for macros are: 

 

 To speed up routine editing and formatting

 To combine multiple commands — for example, to insert a table with a specific size 

and borders, and with a specific number of rows and columns

 To make an option in a dialog box more accessible

 To automate a complex series of tasks

 
The following steps are followed to record or run the macros: 

1. Click the Microsoft Office Button , and then click Word Options. 

2. Click Popular. 
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3. Under Top options for working with Word, select the Show Developer tab in the 

Ribbon check box. 

 

Note The Ribbon is a component of the Microsoft Office Fluent user interface. 

 
7.7.1 Record a Macro 

 
On the Developer tab, in the Code group, click Record Macro. 

 
1. Do one of the following: 

 
 Begin recording: To begin recording the macro without assigning it to a button on 

the Quick Access Toolbar or to a shortcut key, click OK. 

 Create a button: To assign the macro to a button on the Quick Access Toolbar, do 

the following: 

1. Click Button. 

2. Under Customize Quick Access Toolbar, select the document (or all 

documents) for which you want to add the macro to the Quick Access Toolbar. 

 

Important: To make your macro available in all documents, be sure to click Normal.dotm. 

 
3. Under Choose commands from dialog box, click the macro that you are recording, 

and then click Add. 

4. To customize the button, click Modify. 

5. Under Symbol, click the symbol that you want to use for your button. 

6. In the Display name box, type the macro name that you want to display. 

7. Click OK twice to begin recording the macro. 

 
The symbol that you choose is displayed in the Quick Access Toolbar. The name that you 

type is displayed when you point to the symbol. 

 

1. Assign a keyboard shortcut To assign the macro to a keyboard shortcut, do the 

following: 

 

 Click Keyboard. 

 In the Commands box, click the macro that you are recording. 
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 In the Press new shortcut key box, type the key sequence that you want, and then 

click Assign. 

 
2. Click Close to begin recording the macro and perform the actions that you want to 

include in the macro. 

 

Note When you record a macro, you can use the mouse to click commands and options, but 

not to select text. You must use the keyboard to select text. 

 

3. To stop recording your actions, click Stop Recording in the Code group. 

 
Change the keyboard shortcut for a macro 

 

1. Click the Microsoft Office Button , and then click Word Options. 

 
2. Click Customize. 

3. Next to Keyboard shortcuts, click Customize. 

4. In the Categories list, click Macros. 

5. In the Macros list, click the macro that you want to change. 

6. In the Press new shortcut key box, type the key combination that you want to choose. 

7. Check the Current keys box to make sure that you aren't assigning a key combination 

that you already used to perform a different task. 

8. In the Save changes in list, click the option that matches where you want to run your 

macro. 

9. Click Close. 

 
7.7.2 Run a Macro 

 
1. On the Developer tab, in the Code group, click Macros. 

 
 

 
2. In the list under Macro name, click the macro that you want to run. 

3. Click Run. 
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Who will be responsible for taking care of macros? 

Write a macro from scratch 

 
1. On the Developer tab, in the Code group, click Macros. 

 
 

 
2. In the Macro name box, type a name for the macro. 

 
Note If you give a new macro the same name as a built-in macro in MS Word, the new 

macro actions will replace the built-in macro. To view a list of built-in macros, click Word 

Commands in the Macros in list. 

 

3. In the Macros in list, click the template or document in which you want to store the 

macro. 

Activity B 
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7.8 Summary 

 
MS-word is the processing of textual information that may include the typing, editing and 

formatting of information by using various ways and printing it after proofing it according to 

the requirement. A word processor is a software package that helps you create, edit, format 

and print a document. Most of Word processors available today allow more than just creating 

and editing of document. It is quite flexible and easy to use. It is one of the most popular 

word processors for the windows based platform on IBM and its compatible personal 

computer. 

 
7.9 Glossary 

Alignment: Alignment refers to the position of lines in a paragraph in relation to the 

documents left and right margins; i.e., whether they are left-aligned, centered, right-aligned, 

or justified (evenly spaced). 

Auto Correct: An automatic feature in software that corrects common spelling and 

capitalization errors, and can replace certain designated characters with special symbols 

Auto Format: AutoFormat is a feature that automatically changes text as you type. 

AutoFormat includes such formatting as numbered and bulleted lists, borders, 

capitalization, and common spelling errors. 
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Blank Document: A new blank document opens each time you start word. The word 

document has a temporary name, such as document 1. When you finish typing in the 

document, you can save it with a new name 

Blue Underline: Correctly spelled word used inappropriately 

Database and database field: A database is a collection of organized information. A field is 

a specific category of information in a database. Some examples of possible fields are Name, 

Telephone Number, and Address. 

Default Margins: 1" top and bottom, 1 1/4" left and Right, this refers to the amount of non- 

printable space on a page. 

Double Space: Pressing the enter key twice (2) leaving one blank line. This can also refer to 

line spacing using the word processing feature to leave one blank line between each line of 

text. 

Footer: A printed note placed below the text on a printed page 

Footnote: A printed note or definition placed below the text at the bottom of the page 

Hanging Indent: A paragraph format in which the first full line of text is not indented but 

the following lines are indented 

MS Clipboard: It allows you to copy up to 24 multiple text and graphical items from Office 

documents or other programs and paste them into another Office document. By using it, you 

can arrange the copied items the way that you want in the document. 

Normal View: Normal View is Word's default document view and is the most practical view 

for performing such routine functions as typing, editing, and formatting. 

Outline View: Outline View provides a structured view of the document, arranging its 

contents according to heading levels and opening the Outlining toolbar for modifying the 

document's organization. 

Styles: Sets of formatting specifications 

Wizard: A wizard is a feature of Microsoft applications that lets you work through a series of 

dialog boxes to help you complete a task. 

 

 

 

 
Check your progress 
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1. Selecting text means, selecting? 

1.8 a word b) an entire sentence c) whole document d) All of 

the above 

2. Using Find command in Word, we can search? 

2.8 Characters b) Format c) Symbols d) All of the above 

3. Which key should be pressed to start a new paragraph in MS-Word? 

3.8 Down Cursor Key b) Enter Key c) Shift + Enter d)Ctrl + 

Enter 

4. Which of these Tabs allows changing of Fonts and their sizes? 

4.8 Insert b) Review c) Home d) None of these 

5. Which option in File pull-down menu is used to close a file in MSWord? 

6. New b) Quit c) Close d)Exit 

7. Graphics for word processor is 

a) Peripheral b) Clip art c) Highlight d) Execute 

8. Minimum zoom percentage supported by MS Word is 

a) 10% b) 25% c) 15% d) 4%. 

9. The red wave underline in MS Word document indicates 

a) Spelling errors b) Grammar errors c) Address block d) None of 

these. 

10. The icon B in the tool bar stands for 

a) Underline b)Bold c) Italics d) None of the above 

11. Which of the following option is not in Page Layout Tab? 

11.8 Header and Footer b) Footnote c) Bookmark d) All of the above 

12. Which input device is most suitable to work with MS Word? 

a) Keyboard b)Mouse c) Both a & b d) Joystick. 

 
 

13. The insertion point in a table can be moved by using 

a) Tab key b) Shift + Tab key c) Arrow keys d) All of above 

14. Which page orientation you will select if you wish to print in wide format? 

a) Landscape b) Portrait c) Horizontal d) Vertical. 

15. By default, on which page the header or the footer is printed 

15.8 On first page b) on alternate page c) on every page d) none of the above 

16. Which of these tabs allows Mail Merge options? 
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7.10 Answers to check your progress 
 

 
1. D 6. B 11. C 16. A 

2. D 7. A 12. D 17. B 

3. B 8. A 13. A 18. B 

4. C 9. B 14. C 19. B 

5. C 10. D 15. B 20. B 

16.8 Home b) Mailings c) Page Layout d) None of these 

17. What is the maximum number of lines you can set for a drop cap? 

a) 10 b) 15 c)20 d) none of above 

18. How many columns can you insert in a word document in maximum? 

a) 50 b) 45 c) 30 d) 40 

19. Thesaurus tool in MS Word is used for... 

a) Spelling suggestions b) Synonyms and Antonyms 

c) Grammar options d) all of the above 

20. What do you mean by vertical separation between a single page? 

a) Orientation b) Column c) Margin d) index 

21. MS Word is an application software which is a 

a) Freeware 

above 

b) Paid software c) Both a & b d) None of the 
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4. V. Rajaraman , ―Fundamentals of Computers‖, Prentice Hall – India 
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7.12 Terminal and Model Questions: 

1. Whatdo you mean by Word processing? 

2. How can you edit the text in the table? 

3. What do you mean by Printing of the document file? 

4. Define Mail-Merge. Write Steps how to create Mail-Merge 

5. Explain Macros with Example. 

6. Expalin Template and Wizard 
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8.0 Objectives 

After reading this chapter, the students will be able to understand: 

 The basics of MS Excel 

 Features of MS Excel 

 Uses of Excel in Business 

 Creating formulas in the spread sheet 

 Preparing Charts 

 Advanced features in MS Excel 

8.1 Introduction to MS Excel 
 

A spreadsheet is a computer program in which data is arranged in the rows and columns of a grid 

which can be manipulated and used in calculations. It is an interactive computer application 

program for organizing and analyzing of data in tabular form. Spreadsheets have been 

developed as computerized simulations of paper accounting worksheets. The program operates 

on data represented as cells of a table organized in rows and columns. Each cell of the table is a 

model–view–controller element that can contain either numeric or text data, or the results of 

formulas that automatically calculate and display a value based on the contents of other cells. 

Microsoft Excel is an electronic spreadsheet which is used to organize the data into rows and 

columns. It is also used to perform mathematical calculations quickly. 

8.2 Uses of Spreadsheets in Business 
 

The business houses use spreadsheets for the following purposes: 
 

 Calculating tax 

 Making basic payrolls 

 Calculating revenues 

 Preparing charts, graphs etc 

 Financial analysis and business decisions 

 Expense statements or records 

 Sales and marketing 

 Engineering records 

 To show financial information in form of income statements 

 Cash flow statements, and balance sheets 

 Forecasting 

 Inventory tracking 

 Employee management 

 Customer management 

http://en.wikipedia.org/wiki/Computer_application
http://en.wikipedia.org/wiki/Data
http://en.wikipedia.org/wiki/Table_%28information%29
http://en.wikipedia.org/wiki/Worksheet
http://en.wikipedia.org/wiki/Model%E2%80%93view%E2%80%93controller
http://en.wikipedia.org/wiki/Formula
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Ramesh Ahuja wants to store data of his monthly expenditure over the last financial year. Which 

of the Office application is most suitable for this purpose? 

 
 

 
  - 

Activity A 

8.3 Basics of MS Excel 

 
8.3.1 Create a new workbook 

 

Excel documents are called workbooks. Each workbook has sheets, typically called spreadsheets. 

You can add as many sheets as you want to a workbook, or you can create new workbooks to 

keep your data separate. 
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1. Click File>New. 

2. Under New, click the Blank workbook. 

 

 
 

8.3.2 Enter your data 

 

1. Click an empty cell. For example, cell A1 on a new sheet. Cells are referenced by their 

location in the row and column on the sheet, so cell A1 is in the first row of column A. 

2. Type text or a number in the cell. 

3. Press Enter or Tab to move to the next cell. 

 

It is worth to mention that the spreadsheets have made the business life too simple. The 

following figures are a clear example of the traditional paperwork and modern spreadsheet. 
 

Traditional paper worksheet 

Quest Specialty Travel 

Trip Advisor Division Payroll Calculator 
 

 

Name 

 

Hours 
O/T 

Hrs 

Hrly 

Rate 
Reg 
Pay 

O/T 
Pay 

Gross 
Pay 

Brueghel, Pieter 40 4 16.50 660– 132– 792– 

Cortona, Livia 35 0 11– 385– 0– 385– 

Klimt, Gustave 40 2 13– 520– 52– 572– 

Le Pen, Jean-Marie 29 0 15– 435– 0– 435– 

Martinez, Juan 37 0 13– 481– 0– 461– 

Mioshi, Keiko 39 0 20.50 799.50 0– 799.50 

Sherwood, Burton 40 0 16.50 660– 0– 660– 

Strano, Riccardo 40 8 16– 640– 256– 896– 

Wadsworth, Alicia 40 5 13– 520– 130– 650– 

Yamamoto, Johji 38 0 15– 570– 0– 570– 
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Modern Spreadsheet 

 

8.3.3 Cut or Copy or Paste the data 

 

You can use the Cut, Copy and Paste commands to move or copy information in an Office Excel 

worksheet. These commands use the Office Clipboard as a kind of electronic halfway house 

where the information you cut or copy remains until you decide to paste it somewhere. Because 

of this Clipboard arrangement, you can use these commands to move or copy information to any 

other worksheet open in Excel or even to other programs running in Windows based programs. 

 
Moving a cell selection 

 

To move a cell selection with Cut and Paste follow these steps: 

 

1. Select the cell(s) you want to move. 

2. Click the Cut command button in the Clipboard group on the Home tab (the button with 

the scissors icon). 

 

As an alternative, press Ctrl+X. The program surrounds the cell selection with a marquee 

and displays the following message on the Status bar: Select destination and press 

ENTER or choose Paste 

 

3. Move the cell cursor to, or click the cell in the upper-left corner of, the destination range. 

 

When you indicate the destination range, you don‘t have to select a range of blank cells 

that matches the shape and size of the cell selection you‘re moving. Excel only needs to 

know the location of the cell in the upper-left corner of the destination range. 
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4. Press Enter or Ctrl+V to complete the move operation. 

 

Alternatively, you can click the Paste button in the Clipboard group on the Home tab. 

The cell contents disappear from where they began and reappear in their new location. 

 
Copying a cell selection 

 

Copying a cell selection with the Copy and Paste commands follows a nearly identical procedure 

to the one you use with the Cut and Paste commands. After selecting the range to copy, you click 

the Copy button on the Home tab or press Ctrl+C. 

 

An advantage to copying a selection with the Copy and Paste commands and the Clipboard is 

that you can paste the information multiple times. Just make sure that, instead of pressing Enter 

to complete the first copy operation, you click the Paste button on the Home tab in the Ribbon or 

press Ctrl+V. After you select the first cell of the next range where you want the selection 

copied, choose the Paste command again. When you make the last copy, press Enter. If you 

forget and choose Paste, you can remove the marquee around the original cell range by pressing 

the Esc key. 

 

Right after you click the Paste button on the Home tab of the Ribbon or press Ctrl+V to paste 

cell entries that you copy (not cut) to the Clipboard, Excel displays a Paste Options button with 

its own drop-down button at the end of the pasted range. Click the button to see options that you 

can select to modify the paste operation. For example, you can select Formatting Only to copy 

only the formatting, or select Keep Source Column Widths to also copy the column widths. 

 
8.3.4 Format Painter 

 

When the formatting is required in each sheet or workbook, the user need not do the settings 

repeatedly. The user can opt for ‗Format Painter‘ function in the program. Adding formatting to 

your spreadsheet not only makes it more attractive and easier to read, but it can make it easier for 

users to find the information they are after. To quickly copy formatting from one part of a sheet 

to another, or to another sheet in the same workbook, use the Format Painter. Format Painter is 

very useful when you are extending a spreadsheet to accommodate new data and need to format 

the new cells to match the original data area. 

 
To use Format Painter to copy formatting options to one cell 

 
1. Add all the formatting options you want to use to at least one cell. 

2. Click on that cell with the mouse pointer to make it the active cell. 
3. Click on the Format Painter icon on the formatting toolbar. 

4. Click on the cell that you want to copy the formatting to. 

 
To use Format Painter to copy formatting options to adjacent cells 

 
1. Add all the formatting options you want to use to at least one cell. 

2. Click on that cell with the mouse pointer to make it the active cell. 

http://spreadsheets.about.com/od/s/g/spreadsheet_def.htm
http://spreadsheets.about.com/od/uvw/g/workbook_def.htm
http://spreadsheets.about.com/od/a/g/active_cell.htm
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3. Click on the Format Painter icon on the formatting toolbar. 

4. Click on the first cell and then drag the mouse pointer to select additional cells. 

 
To use Format Painter to copy formatting options to non-adjacent cells 

 
1. Add all the formatting options you want to use to at least one cell. 

2. Click on that cell with the mouse pointer to make it the active cell. 

3. Double click on the Format Painter icon on the formatting toolbar. 

4. Click on the first cell you want to copy the formatting to and then continue clicking on 

additional cells to copy the formatting to these cells as well. 

5. Click on the Format Painter icon on the formatting toolbar to turn it off. 

 

 
 

8.4 Use AutoSum to add your data 

 

When you‘ve entered numbers in your sheet, you might want to add them up. A fast way to do 
that is by using AutoSum. 

 

1. Select the cell to the right or below the numbers you want to add. 

2. Click Home>AutoSum, or press Alt+=. 
 

AutoSum adds up the numbers and shows the result in the cell you selected. 

 
8.5 Create a simple formula 

 

Adding numbers is just one of the things you can do, but Excel can do other math too. Try some 

simple formulas to add, subtract, multiply or divide your numbers. 

 

1. Pick a cell and type an equal sign (=). That tells Excel that this cell will contain a 

formula. 

2. Type a combination of numbers and calculation operators, like the plus sign (+) for 

addition, the minus sign (-) for subtraction, the asterisk (*) for multiplication, or the 

forward slash (/) for division. 

 

For example, enter =2+4, =4-2, =2*4, or =4/2. 

 

3. Press Enter. That runs the calculation. 

4. Following are the main operators at a glance that work in MS Excel 2013 



Page 142 of 187  

 
 

You can also press Ctrl+Enter if you want the cursor to stay on the active cell. 

 
8.6 Adjusting Column Width and Row Height 

 

Modifying column width and row height can make a workbook‘s contents easier to work with, 

but you can also insert a row or column between cells that contain data to make your data easier 

to read. Adding space between the edge of a worksheet and cells that contain data, or perhaps 

between a label and the data to which it refers, makes the workbook‘s contents less crowded. 

You insert rows by clicking a cell and clicking the Home tab on the ribbon. Then, in the Cells 

group, in the Insert list, click Insert Sheet Rows. Excel inserts a row above the row that contains 

the active cell. You insert a column in much the same way, by choosing Insert Sheet Columns 

from the Insert list. When you do this, Excel inserts a column to the left of the active cell.When 

you insert a row, column, or cell in a worksheet that has had formatting applied, the Insert 

Options button appears. When you click the Insert Options button, Excel displays a list of 

choices you can make about how the inserted row or column should be formatted, as described in 

the following table. 
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8.7 Apply a number format 

 

To distinguish between different types of numbers, add a format, like currency, percentages, or 

dates. 

 

1. Select the cells that have numbers you want to format. 

2. Click Home> Arrow next to General. 
 

3. Pick a number format. 
 

8.8 Put your data in a table 

 

A simple way to access a lot of Excel‘s power is to put your data in a table. That lets you quickly 

filter or sort your data for starters. 

 

1. Select your data by clicking the first cell and dragging to the last cell in your data. To use 

the keyboard, hold down Shift while you press the arrow keys to select your data. 

2. Click the Quick Analysis button on the bottom-right corner of the selection. 
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3. Click Tables, move your cursor to the Table button so you can see how your data will 

look. If you like what you see, click the button. 
 

4. Now you can play with your data: Filter to see only the data you want, or sort it to go 

from, say, largest to smallest. Click the arrow  in the table header of a column. 
5. To filter data, uncheck the Select All box to clear all check marks, and then check the 

boxes of the data you want to show in your table. 

 

8.9 Sorting of Data 

 

The excel data can be sorted alphabetically or in ascending or descending order. The data can 
also be sorted according to the requirements by adding the value in the sort filters. 
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6. To sort the data, click Sort A to Z or Sort Z to A. 
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8.10 Show totals for your numbers 

 

Quick Analysis tools let you total your numbers quickly. Whether it‘s a sum, average, or count 

you want, Excel shows the calculation results right below or next to your numbers. 

 

1. Select the cells that contain numbers you want to add or count. 

2. Click the Quick Analysis button in the bottom-right corner of the selection. 

3. Click Totals, move your cursor across the buttons to see the calculation results for your 

data, and then click the button to apply the totals. 
 

8.11 Add meaning to your data 

 

Conditional formatting or spark lines can highlight your most important data or show data trends. 

Use the Quick Analysis tool for a live preview to try it out. 

 

1. Select the data you want to examine more closely. 

2. Click the Quick Analysis button that appears in the lower-right corner of your 
selection. 

3. Explore the options on the Formatting and Sparklines tabs to see how they affect your 
data. 

 

For example, pick a color scale in the Formatting gallery to differentiate high, medium, and low 

temperatures. 
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8.12 Show your data in a chart 

 

The Quick Analysis tool recommends the right chart for your data and gives you a visual 

presentation in just a few clicks. 

 

1. Select the cells that contain the data you want to show in a chart. 

2. Click the Quick Analysis button that appears in the lower-right corner of your 
selection. 

3. Click Charts, move across the recommended charts to see which one looks best for your 
data, and then click the one that you want. 

 

8.13 Conditional Formatting 

 

If you wish to change the color of the font based on the value in a cell, you will need to apply 

conditional formatting. To do this, select the cell that you wish to apply the formatting to. In this 

example, we've selected cell B8. 
 

Select the Home tab in the toolbar at the top of the screen. Then in the Styles group, click on 
the Conditional Formatting drop-down and select Manage Rules. 
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When the Conditional Formatting Rules Manager window appears, click on the "New Rule" 

button to enter the first condition. 

 

When the New Formatting Rule window appears, select Format only cells that contain as the 

rule type. 

 

Then select Cell Value in the first drop down, greater than in the second drop down, and enter 

10 in the final box. In our example, we've selected when the cell value is greater than 10. 
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Next, we need to select what formatting to apply when this condition is met. To do this, click on 

the Format button. 

 

When the Format Cells window appears, select the formatting conditions that you wish to apply. 

We've changed the Color to Red. Then click on the OK button. 
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When you return to the New Formatting Rule window, you should see the preview of the 

formatting in the Preview box. In this example, the preview box shows the text in red. Next click 

on the OK button. 
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This will return you to the Conditional Formatting Rules Manager window. 

 

If you wish to apply more than one condition, you will need to click on the New Rule button 

again. 

 

When the New Formatting Rule window appears, we need to set up the second condition. 

Select Format only cells that contain as the rule type. 

Then select Cell Value in the first drop down, less than in the second drop down, and enter 10 in 

the final box. In our example, we've selected when the cell value is less than 10. 

 

Next, we need to select what formatting to apply when this second condition is met. To do this, 

click on the Format button. 
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When the Format Cells window appears, select the formatting conditions that you wish to apply 

to the second condition. We've changed the Color to Blue. Then click on the OK button. 
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When you return to the New Formatting Rule window, you should see the preview of the 

formatting in the Preview box. In this example, the preview shows the text in blue. Next click on 

the OK button. 



Page 154 of 187  

 
 

We've added two different conditions. When you're done, click on the OK button. 
 

Now when you return to the spreadsheet, the conditional formatting will be applied. As you can 

see, the value in cell B8 appears in red. 
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Differentiate between relative and absolute cell referencing techniques with the help of sample 

data. 

 
 

 

 

Activity B 
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8.14 Working with Macros in Excel 

 

The macro recorder works by recording all keystrokes and clicks of the mouse. The macro 

created in this tutorial will apply a number of formatting options to a worksheet title. In Excel 

2007 and 2010, all macro - related commands are located on the Developer tab of the ribbon. 

Often, this tab needs to be added to the ribbon in order to access the macro commands. 

 
8.14.1 Adding a Worksheet Title 

 
Before we start recording our macro, we need to add the worksheet title we will be formatting. 

Since the title of each worksheet is usually unique to that worksheet, we don't want to include the 

title in the macro. Therefore we will add it to the worksheet, before starting the macro recorder. 

 

1. Click on cell A1 in the worksheet. 
 

2. Type the title: Cookie Shop Expenses for June 2008. 
 

3. Press the Enter key on the keyboard. 

 
8.14.2 Excel Macro Recorder 

 
The easiest way to create a macro in Excel is to use the macro recorder. To do so: 

http://spreadsheets.about.com/od/uvw/g/worksheet_def.htm
http://spreadsheets.about.com/od/r/g/Ribbon.htm
http://spreadsheets.about.com/od/uvw/g/worksheet_def.htm
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1. Click on the Developers tab. 
 

2. Click on Record Macro in the ribbon to open the Record Macro dialog box. 
 

8.14.2.1 Macro Recorder dialog box 

 
There are 4 options to complete in this dialog box: 

 

1. Macro name - give your macro a descriptive name. The name must begin with a letter 

and spaces are not allowed. Only letters, numbers and the underscore characters are 

permitted. 
 

2. Shortcut key - (optional) fill in a letter, number, or other character in the available space. 

This will allow you to run the macro by holding down the CTRL key and pressing the 

chosen letter on the keyboard. 
 

3. Store macro in: 

 This workbook: The macro is available only in this file. 

 New workbook: This option opens a new Excel file. The macro is available only 

in this new file. 

 Personal macro workbook: This option creates a hidden file Personal.xls which 

stores your macros and makes them available to you in all Excel files. 

4. Description –It is optional to enter a description of the macro. 

 

8.14.3 Recording the Macro 

 
1. Click the OK button in the Record Macro dialog box to start the macro recorder. 

 

2. Click on the Home tab of the ribbon. 

http://spreadsheets.about.com/od/r/g/Ribbon.htm
http://spreadsheets.about.com/od/uvw/g/workbook_def.htm
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3. Drag select cells A1 to F1 in the worksheet to highlight them. 

4. Click on the Merge and Center icon to center the title between cells A1 and F1. 
 

5. Click on the Fill Color icon (looks like a paint can) to open the fill color drop down list. 
 

6. Choose Blue, Accent 1 from the list to turn the background color of the selected cells to 

blue. 
 

7. Click on the Font Color icon (it is a large letter "A") to open the font color drop down 

list. 
 

8. Choose White from the list to turn the text in the selected cells to white. 
 

9. Click on the Font Size icon (above the paint can icon) to open the font size drop down 

list. 
 

10. Choose 16 from the list to change the size the text in the selected cells to 16 point. 
 

11. Click on the Developer tab of the ribbon. 
 

12. Click the Stop Recording button on the ribbon to stop the macro recording. 

 
8.15 Page setup function 

The page of spreadsheet in MS Excel can be setup using the Page Layout function in the 

program. The following steps are followed for setting margins of the spreadsheet. 

 

1. Choose the Page Layout tab. 

2. Click Margins in the Page Setup group. A menu appears. 

3. Click Wide. Word sets your margins to the Wide settings. 
 

http://spreadsheets.about.com/od/d/g/drag_select_def.htm
http://spreadsheets.about.com/od/uvw/g/worksheet_def.htm
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Set the Page Orientation 

 

1. Choose the Page Layout tab. 

2. Click Orientation in the Page Setup group. A menu appears. 

3. Click Landscape. Excel sets your page orientation to landscape. 

 
Set the Paper Size 
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1. Choose the Page Layout tab. 

2. Click Size in the Page Setup group. A menu appears. 

3. Click the paper size you are using. Excel sets your page size. 

 
8.16 Save your workbook 

 

1. Click the Save button on the Quick Access Toolbar, or press Ctrl+S. 
 

If you‘ve saved your work before, you‘re done. 

 

2. If this is the first time, go on to complete the next steps: 

1. Under Save As, pick where to save your workbook, and then browse to a folder. 

2. In the File name box, enter a name for your workbook. 

3. Click Save to finish. 

 
8.17 Print your workbook 

 
1. Click File>Print, or press Ctrl+P. 

2. Preview the pages by clicking the Next Page and Previous Page arrows. 
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The preview window displays the pages in print range. If you don‘t like your printer settings for 

printouts, you can change page margins or add page breaks. 
 

3. Click Print. 

 
8.18 Summary 

 

In short, Microsoft Excel is an electronic spreadsheet which is used to organize the data into 

rows and columns. It is also used to perform mathematical calculations quickly. The program 

operates on data represented as cells of a table, organized in rows and columns. The business 

houses use spreadsheets for calculating taxes and revenues, making basic payrolls etc. 

Customized as well as statistical formulas can also be designed in the excel spreadsheet package. 

http://office.microsoft.com/en-in/excel-help/redir/HA102748982.aspx?CTT=5&origin=HA102813812
http://office.microsoft.com/en-in/excel-help/redir/HA102748901.aspx?CTT=5&origin=HA102813812
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8.19 Glossary 

Active cell The selected cell in which data is entered when we begin typing. Only one cell is 
active at a time. The active cell is bounded by a heavy black border. 

Cell A box formed by the intersection of a row and column in a worksheet or a table, 
in which you enter information 

Chart area The entire chart and all its elements 

Column 

heading 

The lettered or numbered gray area at the top of each column. Click the column 

heading to select an entire column. To increase or decrease the width of a 

column, drag the line to the right of the column heading. 

Copy area The cells that you copy when you want to paste data into another location. After 

you copy cells, a moving border appears around them to indicate that they've 
been copied. 

Excel add-in Components that can be installed on your computer to add commands and 
functions to Excel. These add-in programs are specific to Excel. Other add-in 

programs that are available for Excel or Office are Component Object Model 
(COM) add-ins. 

Formula A sequence of values, cell references, names, functions, or operators in a cell that 
together produce a new value. A formula always begins with an equal sign (=). 

Formula 

bar 

A bar at the top of the Excel window that you use to enter or edit values or 

formulas in cells or charts. Displays the constant value or formula stored in the 

active cell. 

Input cell The cell in which each input value from a data table is substituted. Any cell on a 

worksheet can be the input cell. Although the input cell does not need to be part 

of the data table, the formulas in data tables must refer to the input cell. 

Insert row In an Excel table, a special row that facilitates data entry. The Insert row is 
indicated by an asterisk. 

 
Merged cell A single cell that is created by combining two or more selected cells. The cell 

reference for a merged cell is the upper-left cell in the original selected range. 

Print area One or more ranges of cells that you designate to print when you don't want to 
print the entire worksheet. If a worksheet includes a print area, only the print area 

is printed. 

Print titles Row or column labels that are printed at the top of or on the left side of every 
page on a printed worksheet 

Protect To make settings for a worksheet or workbook that prevent users from viewing 
or gaining access to the specified worksheet or workbook elements. 

 

Range Two or more cells on a sheet. The cells in a range can be adjacent or nonadjacent. 

Row 

heading 

The numbered gray area to the left of each row. Click the row heading to select 

an entire row. To increase or decrease the height of a row, drag the line below the 

row heading. 

Sort order A way to arrange data based on value or data type. You can sort data 

alphabetically, numerically, or by date. Sort orders use an ascending (1 to 9, A to 

Z) or descending (9 to 1, Z to A) order. 

Template A workbook that you create and use as the basis for other similar workbooks. 
You can create templates for workbooks and worksheets. The default template 
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1. Which of the following is the latest among these versions of Excel? 

C. Excel ME D. Excel 2010 

2. What is the default extension of Excel files in Excel 2013? 

A. XLSX B. XLW 

C. XLS D. 123 
 

3. Which of the following is a popular DOS based spreadsheet package? 

A. Word B. Smart Cell 

C. Excel D. Lotus 1-2-3 

 

4. Which of the following is the oldest spreadsheet package? 

A. VisiCalc B. Lotus 1-2-3 

C. Excel D. StarCalc 

 

5. Files created with Lotus 1-2-3 have an extension ….. 

A. DOC B. XLS 

C. 123 D. WKS 

A. Excel 2013 B. Excel 2002 

6. How many characters can be typed in a single cell in Excel? 

A. 256 B. 1024 

C. 32,000 D. 65,535 

 

7. A Worksheet can have a maximum of number of rows 

A. 256 B. 1048576 

C. 32,000 D. 65,536 

 

8. A typical worksheet has number of columns 

A. 16384  B. 256 

C. 512 D. 1024 

 

9. Comments put in cells are called ….. 

A. Smart Tip B. Cell Tip 

C. Web Tip D. Soft Tip 

for workbooks is called Book.xlt. The default template for worksheets is called 

Sheet.xlt. 

Workbook A spreadsheet program file that you create in Excel. A workbook contains 
worksheets of rows and columns in which you can enter and calculate data. 

Worksheet The primary document that you use in Excel to store and work with data. Also 
called a spreadsheet. A worksheet consists of cells that are organized into 
columns and rows; a worksheet is always stored in a workbook. 

 
 

Check your progress 
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10. Which Chart can be created in Excel? 

A. Area B. Line 

C. Pie D. All of the above 

 

11 The number of rows in a worksheet is 

A. 36500 B. 65536 

C. 256 D. 64536 

 
 

12. Getting data from a cell located in a different sheet is called…. 

A. Accessing B. Referencing 

C. Updating D. Functioning 

 

13. Which of the following is not a valid data type in Excel? 

A. Number B. Character 

C. Label D. Date/Time 

 

14. Which elements of a worksheet can be protected from accidental modification? 

A. Contents B. Objects 

C. Scenarios D. All of the above 

 

15. A numeric value can be treated as label value if ........ precedes it. 

A. Apostrophe (‗) B. Exclamation (!) 

C. Hash (#) D. Tilde (~) 

 

16. Concatenation of text can be done using 

A. Apostrophe (‗) B. Exclamation (!) 

C. Hash (#) D. Ampersand (&) 

 

17. Data can be arranged in a worksheet in an easy to understand manner by 

A. Auto Formatting B. Applying Styles 

C. Changing fonts D. All of these 

 

18. Which area in an Excel window allows entering values and formulas? 

A. Title Bar B. Menu Bar 

C. Formula Bar D. Standard Tool Bar 

 

19. Multiple calculations can be made in a single formula using….. 

A. Standard Formulas B. Array Formula 

C. Complex Formulas D. Smart Formula 
 

20. An Excel Workbook is a collection of ……. 

A. Workbooks B. Worksheets 

C. Charts D. Worksheets and Charts 
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8.20 Answers to check your progress 
 

 

 
 

1. A 6. B 11. B 16. D 

2. A 7. D 12. B 17. D 

3. D 8. B 13. C 18. C 

4. A 9. A 14. D 19. B 

5. D 10. D 15. A 20. B 
 

8.21 References/ Suggested Readings 

 

 Excel 2013 In Depth by Bill Jelen 

 Microsoft Excel 2013 Step By Step by Curtis Frye 

 www.bookboon.com/en/excel-ebooks 

 www.freecomputerbooks.com/Microsoft_Office_Excel.html 

 www.launchexcel.com 

 
8.22 Terminal and Model Questions 

 

1) Define a spreadsheet. What is its importance? 

2) How a spreadsheet can be used to optimize the business? 

3) Write down the syntax command of formulae that are commonly used in business? 

http://www.amazon.com/Curtis-Frye/e/B001IGLPPO/ref%3Dntt_athr_dp_pel_1
http://www.bookboon.com/en/excel-ebooks
http://www.freecomputerbooks.com/Microsoft_Office_Excel.html
http://www.launchexcel.com/
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4) Write a detailed note on MS Excel spreadsheet package. 



Page 167 of 187  

9. Microsoft PowerPoint 
 

Structure 

9.0 Objectives 

9.1 Introduction to Power Point 

9.2 Features of PowerPoint 

9.3 Starting with MS Power 

9.3.1 Create a new Slide 

9.3.2 Save the file first time 

9.3.3 Save the presentation file in other formats 

9.3.4 Printing the Power Point Presentation 

9.4 Using Home Tab 

9.4.1 Adding, Moving or Deleting a Slide 

9.5 Using Insert Tab 

9.6 Using Design Tab 

9.7 Using Animation Tab 

9.8 Using Slide Show Tab 

9.9 Using Review Tab 

9.10 Using View Tab 

9.11 Summary 

9.12 Glossary 

9.13 Answers to check your progress 

9.14 References / Suggested Readings 

9.15 Terminal and Model Questions 



Page 168 of 187  

9.0 Objectives 

After reading this chapter, the students will be able to understand: 

 The basics of MS PowerPoint 

 Features of MS PowerPoint 

 Designing the PowerPoint Presentation 

 Adding Multimedia to the PowerPoint Presentation 

 Advanced Features in MS PowerPoint 

9.1 Introduction to PowerPoint 

MS PowerPoint is a powerful tool which helps us to communicate our views and ideas 

effectively using diagrams, clips, arts, sounds, colors and animated effects. It is a software 

package designed to create electronic presentations consisting of a series of separate pages or 

slides. This slide-basedpresentation program developed by MicrosoftCompany and launched in 

1990, is a part of the Microsoft Office suite. PowerPoint presentations consist of a number of 

individual pages commonly called "slides". The "slide" here refers to a page which can be 

displayed on LCD projector. Earlier the term slides were used for transparencies/plastic sheets 

that were shown with an overhead projector, but now are less in use these days. Slides contain 

the contents like Text, Tables, Bulleted and numbered lists, Graphics, Audio, Video, Many other 

types of content. 

9.2 Features of PowerPoint 

 PowerPoint provides various features of flexibility and the ability to create a professional 

presentation. 

 It also provides the ability to create a presentation that includes music or sound effects 

which can be played throughout the entire presentation. 

 One can also add sound files, movies and graphics into slides 

 PowerPoint allows the user to record the slide show with narration and a laser pointer. 

 The slide shows can also be customized to show the slides in a different order than 

originally designed and to have slides appear multiple times. 

 It also offers the ability to broadcast the presentation to specific users via a link. 

http://en.wikipedia.org/wiki/Slide_show
http://en.wikipedia.org/wiki/Slide_show
http://en.wikipedia.org/wiki/Microsoft
http://en.wikipedia.org/wiki/Microsoft_Office
http://en.wikipedia.org/wiki/Overhead_projector


 

 
Explain importance of MS-Excel in business application? 

Activity A 

 

 

 

 

 

 
9.3 Starting with MS PowerPoint: 

On staring PowerPoint, a blank presentation named presentation1 appear on the screen as 

follows 

. 

Office Button Quick Access Toollbar Title Bar 
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Above said window (named Presentation1) consists with following components: 

Title Bar: It displays the name of the presentation on which you are currently working. 

Quick Access Toolbar: It contains commands that are used frequently 

MS Office Button: This button allows us to create a new presentation, open an existing 

presentation, save and save as, print, send or close the presentation. 

Ribbon: The Ribbon is located at the top of the PowerPoint window. It has seven tabs- Home, 

Insert, Design, Animations, Slide Show, Review and view. Each tab contains arranged group of 

commands. 

Slide Pane: In the slide pane, you can work directly on individual slides. 
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Status Bar: The status bar is located at the bottom of the MS PowerPoint window. It display the 

current slide (See No. 1 in the above figure). View the document in different ways using the hot 

buttons to the right of the status bar (See No. 2 in the above figure): Normal, Slide Sorter and 

Slide Show. A slider allows you to zoom in or out of your document (See No 3in the above 

figure) 

9.3.1 Create a new slide 

The MS PowerPoint interface brings out all the functionality of the software using tabs rather 

than drop-down menus. You should get acquainted with the different parts of the main window: 

 Slide: A content holder for text and images. To insert additional slides click New Slide under 

the Slides section of the Home tab. The slide below is called the Title slide where you should 

enter the title of your presentation and information related to you, your organization, and 

colleagues. 

 Text box: A box outlined by dotted lines is where you enter your textual content 
 

 

 

 

 
9.3.2 Save the file first time: 

To save your document for the first time, click the Microsoft Office icon  located on 

the upper left side and then select the Save command. The duplicate copy can also be created 
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of existing file using Save As command of Microsoft icon. Following popup box will be 

open when any one click on Save As command 

 
 

 

 Save in: Choose the location to place your file, i.e. to your desktop, a folder on the hard disk, 

Pen drive etc. 

 File name: Give any name to your file. Note, do not include a file extension. 

 Save as type: Make sure PowerPoint Presentation appears here. Otherwise, select it in the 

drop down menu. If not, choose, it may be stored in another format. 

After saving first time, you will only need to select the Save menu choice for subsequent saves. 

An even faster way to do this is to use the hot button provided on the Quick Access Toolbar. 

Remember to save your document frequently. The Presentation can also be saved in pdf or xps 

format or any other format mentioned in the figure. 
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9.3.3 Saving the presentation file in other formats 

A MS PowerPoint 2013 file can also be saved in MS PowerPoint 1997-2003 document format 

and vice versa using the Save As→ PowerPoint Presentation command (see next figure on the 

left). 
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Clipboard Slides Group FountGroup Paragraph Group Drawing Group Editing Group 

9.3.4 Printing the PowerPoint Presentation 

 To print the slides, click on MS Office button 

and then click print. 

 All the slides or the required slides can be 

printed using the print range. 

 Write the number of copies of slides required. 

 The handouts can be printed by selecting the 

option from ‗Print‘ 

 The handouts option will get active and asks for 

the number of slides to be printed on a sheet. 

 The slides can be printed in color or in 

grayscale. 

 
9.4. Using the Home Tab 

 

 

 
      

 
 

Clipboard Group: This group contains various commands for editing the text such as Cut, Copy 

and Paste. The Format Painter command copies formatting rather than actual text or data. This 

group also contains a Dialog Box Launcher arrow in the lower-right. 

Slides Group: The Slides group in the Home tab contains commands for inserting new slides 

into the presentation. In addition to this, the group contains commands for adjusting the slide 

layout and to delete the slides from the presentation. 

Font Group: The Font group contains all the commands for different type of formatting for the 

given text in the presentation like Bold, Italic, & Underline as    well as the font face and font 

size. You‘ll notice that things like Shadow, Font Color and Clear Formatting are also contained 
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What is the best way to design the layout for your slides? 

in this group. This group contains a Dialog Box Launcher arrow in the lower-right corner that 

opens the Font dialog box when clicked. 

Paragraph Group: Through this group one can set the formatting of text in the presentation. 

Data can be set in the Left, Right or Center of the slide. In addition to this, data can be justified 

or put into two or more columns. We can also use bullet numbering and increase or decrease the 

left and right indent levels. This group contains a Dialog Box Launcher arrow in the lower-right 

corner that opens the Paragraph dialog box when clicked. 

Drawing Group: The Drawing group on the Home tab contains commands for creating and 

editing drawing shapes. 

Editing Group: The Editing group is the last one on the Home tab and contains commands for 

finding and replacing data as well as to select the text. 

Activity A 
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9.4.1 Adding, Moving or deleting a slide 

A PowerPoint Presentation slide can be added at the beginning or in between the slides without 

any hassle. Right click mouse button and then left click on the new slide, the new slide appears 

 In case, a slide needs to be moved, just drag the slide with the mouse and release the mouse 

button where it needs to be placed. 

 If the user wants to delete the slide, he/she can click on the particular slide and then select the 

option delete. 

 Following window is to be used to create new slide. 
 

 

 

 

 

 
9.5 Using Insert Tab 



Page 177 of 187  

 

 
 

     

 

Insert tab can be used to insert various types of objects including tables, images, illustrations, 

links, text, symbols, and media clips 

Table group: 

 To create table on the slide, click on the Table icon 

from the Tables group and then select the number of 

cells for the table. Example to create 5 rows and 5 

columns is shown in the given clip. 

 If you need a table that is larger than 8 rows and 10 

columns, click Insert Table. The Insert Table window 

will open up and number of columns and rows can be 

specified. The table will be created with specified rows 

and columns in the slide. 

Illustrations Group: This group contains various type of commands for drawing pictures, 

ClipArt, Shapes and charts. Pictures, graphs, charts and shapes to make PowerPoint slides more 

impressive. 

 Click on Insert function and the ribbon with 

various functions appear. 

 Click on the table or picture, etc you want to 

insert in the slide. 

 To insert WordArt, to make titles or headings attractive, click on WordArt option. 

Links Group: This group contains two commands like hyperlink and action. Whenever we use 

the Web, we are using hyperlinks to navigate from one webpage to another. If we want to 

include a web address or email address in the PowerPoint presentation, we can choose to format 

them as hyperlinks. It's also possible to link to files and other slides within a presentation. 

 Through hyperlink one can give link to other files, websites and 

email etc. from the slide. 
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age Setup: The Pa 

and slide orientation 

 The action command will help you to build interactivity into the presentation 

Text Group: Through this group one can put various type of components on the slide like text 

box, header and footer, date and time, slide number, symbols and objects 

 A text box is an object that lets you put and type 

text anywhere in your file. 

 Header and footer can also be inserted if required 

so that it appears on every slide. 

 To insert slide numbers, click on ‗Slide Number‘ option to number the slides 

consecutively. 

 To insert WordArt, symbols and object on the slide, you just click on the respective icon. 

Media Clips Group: In PowerPoint slide, media clips (movie, sound) can also be inserted. 

Following procedure is to be used to insert media clips in the slide. 

 To insert an audio clip in the PowerPoint slide, click on ‗Sound‘ 

and browse for the audio file to be inserted 

 The program also has an option to record the audio 

 To insert a movie clip in the PowerPoint slide, click on ‗Movie‘ 

and browse for the movie file to be inserted in the slide 

9.6 Using Design Tab: 

The Design tab contains the basic slide formatting tools. This tab consists with various 

commands related to the appearance of the slides like slide size and orientation (i.e. Landscape 

versus Portrait), add a preformatted theme or set a background color. Note that Themes and 

Background Color employ Live Preview to see what the theme or color would look like on the 

slide before applying it. 

 

P 
Page setup 

ge Setup group contains the options to specify the slide size 

. 
Background Themes 
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Transition to this slide Animations Preview 

 Click Page Setup under the Page Setup group to make changes to your slide size and 

orientation. 

 To only change the page orientation of your presentation, click Slide Orientation under 

the Page Setup group and then select Portrait or Landscape. 

Themes: To set a theme for your presentation, select the theme you wish to use under the 

Themes group. For additional themes, select the more icons under the Themes group. More 

 
themes will be shown along with an option to download more themes from the Microsoft Office 

Online site. The theme colors, fonts, and effects can be changed by using the options to the right 

of the theme i.e. Color, font‘s, and effects. 

Background: The background styles of the PowerPoint slides 

can be designed using the design function of the program. The 

background graphics can also be hidden if the option of ‗hide 

background graphics‘ is checked. 

9.7 Using Animation Tab 

 

The Animation tab consists of three groups of controls like preview, animations and transition to 

this slide. It has ability to add various types of effects on individual slide in the presentation. An 

animation sets up the way you want text or an object to appear on the slide during a slide show 

presentation. In addition to this, it provides visual interest to the presentation and grab the 

audience‘s attention when you deliver presentation to others. The Transition to This Slide section 

allows you to define a variety of ways to transition between slides during the presentation. The 

Animations section allows you to animate text, illustrations, tables, etc. on a slide. The preview 

section is used to play the animation. 



Page 180 of 187  

tart Slide Show roup: This gr consists with thr 

Preview Group:- It display a preview of the animation effects you selected 

for current slide. It allows you to preview how an actual change will look on 

the slide before you decide to accept or decline that change. It is also used to 

play the presentation. 

Animation Group:- Through this group we can create animation 

effect on the slides. Predefined effects can be selected from the 

animate Drop Down list or can use custom animation for various 

types of effects on the slides. 

Custom Animation: We can create custom animations to specify exactly what we want 

to animate and how it should be done. 

 Select the slide which should be animated. 

 Click on the custom animation button. „Custom Animation‟ window appears on the 

right side of the screen. 

 Select any object on the slide and click on „Add Effects‟ button for animation. 

Transition Group:-This group sets the transition effects that is used when the slide is displayed. 
 

If we do not add transitions, your presentation will move from slide to slide with a click of the 

mouse button or by pressing Enter or the right arrow key. If we want the presentation to play on 

its own, you must set slide transition. 

9.8 Using Slide Show Tab 

MS PowerPoint program also provides for slide shows where we can put the slides for 

presentation show. The slide show can be programmed or customized. For automated slide show, 

rehearsed timings can be adjusted so that the slides automatically change from one to another 

after a fixed time interval. It consist with three groups like start slide show, setup, monitors. 

 

 

 

 

 

 

 

S 
Start Slide Show   

G 
Set Up 

follows. 

 
oup 

Monitor 
ee commands to play the presentation as 
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 From Beginning: To view your slide show from the 

beginning. 

 From Current Slide: To view your slide show from the 

current slide 

 Custom Slide Show: To create a slide show of a different order or including different 

slides 

Set Up Group: It consists with various commands 

like Set Up slide Show, Hide Slide, Record 

Narration, Rehearse Timings. 

 Set Up slide Show: Through this command 

we can perform function like 

 Whether the presentation is given in a 

full screen. 

 Whether to loop continuously until 

'Esc,' show with or without narration, 

or show with or without animation. 

 What the pen color will be. 

 Whether to show all slides or a 

selection. 

 Whether the slides are advanced manually or using timings. 

 In the instance that there is more than one monitor, whether or not to show the 

slide on the primary monitor. 

 Hide Slide: This command is used to hide the selected slide. 

 Record Narration: Once you click on Record a Narration, a window will pop up which 

will allow you to set your microphone level and record your sound. 

 Rehearse Timings: This option allows you to insert automatic timings. 

Monitors Group: Through this group one can 

change the resolution of the screen, click on the 

arrow next to Use Current Resolution and select the 

resolution you would like to use. 



Page 182 of 187  

Using Presenter View is a great way to view your presentation with speaker notes on one 

computer, while your audience views the notes‐free presentation on a second monitor (for 

example projected on a larger screen) in this way, you can spare your audience a text‐filled 

presentation and spare yourself the juggling between class notes and your PowerPoint 

9.9 Using Review Tab: 
 

Proofing Group: It consists with following commands. 

 Spelling: It perform a spell-check on your writing. 

 Research: Tolook up any word in a dictionary, thesaurus, or encyclopedia. 

 Thesaurus: Tolook up synonyms for any word. 

 Translate: Tolook up translations for any word, in several different languages. 

 Language: Tomark selected text as belonging to a certain language; this will allow for 

spell checking in that language. 

Comments Group: Through this group one can give small comments related to inserting, 

deleting and navigating comments to the slide. 

 Show Markup: If you don't want to view the comments that have been made, simply 

click on Show Markup. This willhide your comments from view. If you would like to 

view them, click this button again. 

 New Comment: To give new comment. 

 Edit Comment: To change existing contents of comment as desired by the user. 

 Delete: To delete existing comments. 

 Previous and Next command: To reviewing a presentation with someone else's 

comments, navigate through them by clicking on Previous or Next. 

Protect Group: It contains only one command which is used to set password security on the 

current presentation 

 
9.10 Using View Tab 
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Normal:This is the view that PowerPoint naturally begins with. It allows you to see the current 

slide in detail, outlines, slide thumbnails, and notes. 

Slide Sorter:Thisview displays all the slides of the presentation in horizontally sequenced, 

thumbnail sized slides. 

Notes Page:This view focuses on the Notes area. It allows to view, edit, or add notes to each of 

the slides, which can then be printed. 

Masters:It is a way to set the same appearance for all slides. There are three types of Master on 

the View tab i.e. Slide Master, Notes Master, and Handout  Master. On the Slide Master, 

anything you add or change will appear on all existing slides. 

Slide Show: This starts the slide show. 

Show/Hide: Tomake visible a ruler at the sides, or gridlines which help you align objects on a 

slide. 

Zoom: To make the view of the slide larger or smaller. 

Color/Grayscale: To view the slides in Color, Gray-Scale or Black & White 

New Window: This command is used to open more than one presentation (with same contents) 

at the same time. After opening a windows, it can arranged, cascade them, or split the screen. 

Macros: This is an advanced feature. A "Macro" is a kind of mini-program. You can tell your 

computer to remember a series of actions (menu commands, mouse clicks, etc.) and perform 

them automatically. 

 
9.11 Summary 

MS PowerPoint is a part of MS Office suite which has been developed primarily for preparing 

electronic presentation consisting of slides. The slides can be viewed on computer or projector 

and is used in meetings, academics, business or other purposes. MS PowerPoint provides 

flexibility to prepare the slide shows and audio/video can also be inserted in the presentation. 

 

 
 

9.12 Glossary 
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 Animation: Any type of motion or movement that occurs. 

 Bold: Text emphasis in which the text is darker than the surrounding text; used to emphasize 

key words. 

 Clip art: A collection of predefined graphic images included with Microsoft Office or 

downloaded from the Web. Clip art is also available from several vendors and can be 

purchased as a CD-ROM collection or used on a royalty paid basis. 

 Crop: The process of removing unwanted areas of a picture. 

 Font: A set of letters, numbers, and punctuation marks with the same design, shape, and 

appearance. 

 Hyperlink: A navigational element used in a document, presentation, or Web page that, 

when clicked, will link to, or take you to, another location. In a PowerPoint presentation, 

hyperlinks can also be used to link to a slide in the presentation, to a slide in a different 

presentation, or to a custom slide show. 

 Layout: The placement of objects on a slide by using placeholders in a specific arrangement 

that can be customized. 

 Normal view: The window is divided into three panes: the Slides/Outline pane, the Slide 

pane, and the Notes pane. 

 Notes pane: Displays below the Slide pane and allows you to type notes regarding the active 

slide. 

 Print Preview: Enables you to see how a presentation will look when printed using the print 

options that you select. 

 Quick Access: Toolbar-Displays buttons to perform frequently used commands with a single 

click. Frequently used commands in PowerPoint include Save, Undo, Repeat, and Print. For 

commands that you use frequently, you can customize the Quick Access Toolbar by adding 

additional buttons. 

 Ribbon: Organizes commands on tabs, and then groups the commands by topic for 

performing related presentation tasks. 

 Slide: The individual page that includes any combination of text, graphics, images, video, or 

sound. 

 Slide pane: Displays a large image of the active slide. 
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1.Which of the following pane is not available in Task Pane? 

a) Getting Started b) Clip Art 

c) Word Art d) Search Results 

2.Special effects used to introduce slides in a presentation are called 

a) Effects b) Custom animations 

c) Transitions d) Present animations 

3. You can edit an embedded organization chart object by 

a) Clicking edit object b) Double clicking the organization chart object 

c) Right clicking the chart object, then clicking edit MS-Organization Chart object 

d) b and c both 

4. Which of the following is the default page setup orientation of slide in PowerPoint 

a) Vertical b) Landscape 

c) Portrait d) None of above 

5. Objects on the slide that hold text are called 

a) Placeholders b. Object holders 

c) Auto layouts d) Text holders 

6. Which of the following is/are true about rulers and guides? 

a) Rulers and guides can be turned on or off 

b) Rulers and guides print on the slide 

c) Rulers and guides help place objects on the slide 

d) a and c 

 Slide show: Slides display one at time and at the full height and width of the computer 

screen. 

 Template: A predefined document that contains formatting information. 

 Theme: A set of coordinated design elements, such as fonts, graphics, and colors, that 

provide a consistent look for your presentation. 

 Transition sound: A prerecorded sound that can be applied and will play as a transition 

occurs. 

 Transition speed: The timing of the transition-Slow, Medium, or Fast-between all slides or 

between the previous slide and the current slide. 

Check your progress 
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7. A cell is defined as 

a) Intersection of a column and a row 

c) A rectangular marker 

 

b) An input box 

d) All of the above 
 

8. Which menu provides you options   like Animation Scheme,   custom Animation, 

SlideTransition?    

a) Insert Menu   b) Format Menu 

c) Tools Menu   d) Slide Show Menu 
 

9. Which of the following statement is true? 

a) You can insert text boxes from drawing toolbar in PowerPoint 

b) You cannot insert text boxes from drawing toolbar in PowerPoint 

c) Text boxes are provides when you choose a layout and can‘t be inserted afterwards 

d) None of above 

10. The selected design template can be applied 

a) To current slide only b) To all the slides 

c) To all the new presentation you create d) All of above 

 

 

 
9.13 Answers to check your progress 

Answers: 1 c. 2.c 3. d 4.b 5.a 6.d 7.a 8.d 9.a 10.d 

 
 

9.14References / Suggested Readings 

 Microsoft PowerPoint 2013 by Joan Lambert 

 Microsoft PowerPoint 2013 Bible by FaitheWempen 

 www.wpi.edu 

 http://poza.net/fa07/powerpoint/ppt9.html 

9.15 Terminal and Model Questions 

1) Define PowerPoint Presentation and its features. 

2) What is the importance of PowerPoint Presentation in the modern business society? 

3) How the PowerPoint slides are helpful to the students in their studies? 

http://www.wpi.edu/
http://poza.net/fa07/powerpoint/ppt9.html
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